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I’D LIKE TO share an incident that set me thinking a
little differently about the Digital Divide, especially in
reference to our country. A few days ago, close to mid-
night, I was just about to leave my home and head to
office for some late—night finishing—up work. The
watchman—a 20-year-old boy!—asked me what time I
would return. Concerned about him having to stay
awake until I returned, I told him to go to bed. “I
might return only at four in the morning, and I’ll
wake you up by calling out loud.” To this he shot back,
“Don’t bother shouting at that early hour—just give
me a missed call.”

“Slightly taken aback” is how I would describe my
reaction. It’s not surprising that my watchman owns
a cell phone, really—there are plenty of stories about
hawkers, auto drivers, and even beggars owning one.
But what is unforeseen is that though he earns barely
2,000 rupees a month, he feels the need to spend Rs
1,800 on a second-hand phone, and also Rs 350 for a
pre-paid card with a subscription to caller tunes. I
later found out that his next plan is to save up a thou-
sand rupees for a “lifetime incoming free” card.

The incident left me with two things to mull over:
first, the spending habits of not just the middle-
income group, but also of those belonging to the
lowest of the income groups, are being redefined.
Second, if increasing PC penetration can further the
digital divide amongst the different income groups,
increasing mobile use will, in contrast, bring them
together.

The mobile phone, for me, is therefore a thing of
wonder. It has the power to bridge a gap—a dangerous
and ever-increasing gap so often called the Digital
Divide: a gap between those with regular, effective
access to digital technologies and those without. For
example, there is a tremendous degree of disparity in
the opportunity to access the Internet, and educa-
tional and business opportunities are tied to this
access. People in countries where access to digital
technologies is cheap and more pervasive, naturally
gain the competitive edge. 

Enter the mobile: a decade ago, India leapfrogged
into the computer revolution, and a similar thing will
happen now with the mass adoption of mobile
telephony. It’s going to be faster this time round: back
in the 1990, computers were expensive. It’s still not
entirely rosy with mobile phones—like I said, con-

nectivity has been a significant investment for my
watchman—but we’re getting there. And it’s not lim-
ited to the cities—mobiles are entering even the most
far-flung rural areas of India.

Change happens slowly in India. People in this
country really do find it harder to adapt to change.
But technology here has gone against the grain. We’re
now adapting as fast as anyone else. We can’t say what
will happen if what the much-in-the-news Bill Gates
said comes true: that hardware will one day be free.

editor@thinkdigit.com
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FEATURED TUTORIAL FROM DIGIT FORUM ((wwwwww..tthhiinnkkddiiggiitt..ccoomm//ffoorruumm))
Starting this month, we will feature one member tutorial from the forum

Chapter 1: The grounds of our app
Let's first start with a generic xHTML page:
Code:
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"

"http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml" lang="en"

xml:lang="en">

<head>

<meta http-equiv="content-type" content="text/html" />

<title>My first AJAX page</title>

</head>

<body>

<p>Hello world</p>

</body>

</html>

Now, let's create a script object for inserting the AJAX code. Here is the mod-
ified <head> section of our HMTL page:
Code:
<head>

<script type="text/javascript">

<!--

//Our code comes here

//-->

</script>

</head>

Now, we come to the server-side. Here is the generic php code for outputting
a simple string "AJAX was here":

Code:
<?php

printf("AJAX was here");

?>

Now things are setup, we can go into AJAX.

Chapter 2: The XMLHttpRequest() object
The XMLHttpRequest() is a JavaScript object. It has the following methods:

Code:
XMLHttpRequest.abort() -> Abort the XMLHttpRequest request

XMLHttpRequest.getAllResponseHeaders() -> Get all the headers from

XMLHttpRequest request to the server

XMLHttpRequest.getResponseHeader() -> Get only the 'status' and

'readyState' headers from XMLHttpRequest request to the server

XMLHttpRequest.open() -> Open(Initialize) a XMLHttpRequest()

XMLHttpRequest.send() -> Execute the XMLHttpRequest()

It has the following event(s):
Code:
XMLHttpRequest.onReadyStateChange -> Event executes whenever the

request is available.

P.S: Actually, onReadyStateChange is a property of the object which has the
value of the function which is to be executed when the request is available.

For the full tutorial (and many more) visit:
http://www.thinkdigit.com/forum/showthread.php?t=29134

29-05-2006,
11:55 PM 

rohan
Broken In

Join Date:
Mar 2004
Location:
Baroda
Posts: 133

AJAX Tutorial

Internet

Links from Friends/Collegues

e-mail

Online Chat
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Konkona Sen Sharma
Actress

Although she was
introduced as the

daughter of actor/director
Aparna Sen, Konkona made
a niche for herself with her

very first feature film
Mr and Mrs Iyer.

She went on to
wow audiences in
films such as
Page 3 and 15
Park Avenue.

Technology to you
is….

… what makes us sit up and
take notice of our
surroundings everyday. I
mean, with every new
innovation, we actually wonder
“Wow! What next?”  

What are your favourite
gadgets?
I don’t have any particular
favourites especially since
technology is such a double-
edged sword. For example, my
cell phone, a Nokia 6100, is
undeniably an instrument I
cannot make do without. But it
can sometimes be intrusive.
However, I’m curious about
new innovations and do keep
myself informed. 

What do your online
activities entail?
As an actress, work takes up
much of my time, and I don’t
find the time for more than
surfing and e-mail. But e-mailing
is a key activity; I handle a lot of
my work through it.  

Any particular incident
where technology came to
your rescue?
No major life-saving incident,
but technology brings small
mercies to everyday living. Even
with my cell phone, for example:
I can actually recognise an alien
number and not take the call if I
don’t wish to—and call back
later. Isn’t that a boon?

E-mail: The Good And The Bad
The proportion of e-mails that contain malware has
fallen for the first six months this year compared to
the same period last year. About one in 91 e-mails
contained a virus or other types of malware, far less
than the 1-in-35 figure of a year ago.

Designed In California, Made In China
British newspaper The Mail has claimed that iPods are made
in Chinese factories under “slave” conditions. The paper
alleged that one particular factory employed 2 lakh workers,
working 15 hours a day for a monthly pay of $50 (Rs 2,300).
Foxconn Electronics has sternly denied the allegations.

Aresearch director at
Gartner has recently
said that the move

from single- to dual-core
processors has broken a
certain barrier: “We’re now
in a multi-core world—
there’s no looking back.”
The core wars have begun. If
you were only just
getting used to the
idea of dual-core,
prepare to expand
your imagination.

Intel officials have
indicated that chips
with dozens of cores
might be possible by the
end of the current
decade. In 10 years,
chips with hundreds of
cores might emerge,
they say. And as a
natural progression,
we might use the
words “kilo,” “mega,”
and “giga” to refer to
the ~number of cores~
in a processor!

Intel is planning to ship
quad-core chips later this
year to computer
manufacturers. Not to be
left behind, AMD, of course,
will possibly ship quad-core
chips in early 2007.

It seems Intel will have
the lead, in terms of both
performance and energy
efficiency. Speaking at a
conference in mid-June in
New York, Dileep
Bhandarkar, architect at
large for Intel in Santa
Clara, said that when Intel’s
quad-core “Clovertown” is
released in the first half of
2007, it will be a single
package of two dual-core
chips, and that the chips

will not have the memory
controller integrated into
the chip. Bhandarkar did
admit that integrating the
memory controller directly
into the chip would improve
performance with some
workloads. Intel
officials,

however, think it is more
important to bring a quad-
core processor to the
market before AMD does.
Intel expects to beat AMD
by a quarter or two.

According to
Bhandarkar, Intel doesn’t
stand to lose much in the
way of performance by
having a multi-chip package
for the quad-core
processors, as opposed to
AMD’s design—a single piece
of silicon with four cores.
The Clovertown chip’s
performance will be helped
by having independent
front-side buses dedicated
to each processor.

Naturally, applications
that take advantage of

multiple cores will need to
be built, and they will. It’s
not clear how the chip
giants are surging ahead
with their plans for multi-
core desktop computing in
the absence of software that
can use them, but that’s
always been the story:

software follows hardware
follows software.
Something like Windows
Vista’s hardware
requirements!

But Clovertown aside,
is a giga-core processor

conceivable? No-one knows,
of course, but you can
never tell with
nanotechnology. What’s
confusing is the variety
of approaches to
increasing performance.
What exactly will the
computer of 2020 look

like? Will it be based on
multi-core silicon chips?

Will something replace
silicon? Will it be
alternative computing
paradigms, such as
quantum and DNA
computing? Will it be
something exotic, like
reversible computing? We
live in an exponential age.

PARANOIA

Error 417:
End Of World

Experts are warning that
IT disasters could be a

threat to the human race.
The Bulletin of the Atomic
Scientists (BAS)—known for
its Doomsday Clock, which

Enter
THE CORE WARS

A Giga-Core Processor By 2020?

Illustrations Harsho Mohan Chattoraj



is now at seven minutes to
midnight—is holding a
series of “doomsday
reconsidered” meetings to
look at future threats to
civilisation. Executive
director Kennette Benedict
told a radio station that
they would be taking stock
of the threats that might be
catastrophic to humans.

New threats will be
investigated at the meeting
in addition to those of

atomic weapons and such.
Benedict said, “We’ll also be
looking at new developments
in life sciences, in synthetic
biology, for instance, and
some of the emerging
technologies,
nanotechnologies, and how
these may converge with life
and developments in
biotechnologies, and we’ll
also look at information
technology and the
vulnerabilities of civilian
infrastructure.”

The BAS has a Web page:
www.thebulletin.org.

Scott Borg, the director
and chief economist of the
US Cyber Consequences
Unit—which gives the US

government risk
assessments of possible
cyber attacks—also recently
warned that criminals or
terrorists could target IT
systems. A key target could
be supervisory control and
data acquisition systems in
power plants and such. Borg
told the newspaper The
Independent, “Think of the
control systems for chemical
plants, railway lines or
manufacturing facilities.

Shutting these systems
down is a nuisance.
Causing them to do
the wrong thing at the
wrong time is much
worse.”

So could IT bring
about the end of the
world? That might be
fatalistic thinking, but
GNR (Genetics,
Nanotechnology,
Robotics) technologies
are something to
reckon with when
thinking along these
lines. Experiments are

currently on that merge
human genes with those of
goats and other such
animals, recalling images of
Greek mythical creatures.
Nanotechnology conjures
up the image of “grey
goo”—swarms of nano-
robots spread all over the
atmosphere. And as for
robotics, we’ve mentioned
elsewhere in this issue that
experts are already warning
of safety concerns as robots
increasingly enter homes
and offices.

Technology enables—but
it just might destroy. But all
this could, of course, be just
plain, uninformed, old-
fashioned paranoia.

PATENT, WAIT, SUE… AGAIN

Net2Phone
And Skype In
Silly Legal
Spat

Internet phone company
Net2Phone, which was a

popular paid service in the
old days (read 2000) has
filed a patent infringement
lawsuit against Skype
Technologies and its parent
company eBay. Net2Phone
alleges that Skype has
infringed on its VoIP patent,
which it applied for in 1995
and which was issued in
August 2000.

Skype uses P2P
technology for its VoIP
service, whereas companies
such as AT&T use a system

Deepal
Poojan

YouTube
The interface
here is neat,
and videos can

be rated. You can save videos
to your favourites, add them
to groups, and share and blog
them. Along with a thumbnail
of the video, you also see
when the video was posted, its
rating, category, and more.  

Google Video
Here you can’t
comment on
videos, and you
can’t mark a
video as a
favourite. The interface is
clumsy compared to that of
YouTube… and there are
other little niggles: no view
count, and no ratings.

“An ostrich!”“Abdul Kalam” 
Avit  

“The Space Shuttle…”

Pranav
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Security Watch

Internet Explorer
Vulnerabilities

The Problem
Mid-June, Microsoft released 12
security updates to fix at least
21 vulnerabilities in Windows
and other software, including
12 flaws labelled “critical.” At
least eight different flaws—four
of them critical—have been
found in IE. A problem has also
been found with Microsoft’s
implementation of JavaScript:
the baddies have been known
to use JavaScript flaws to
install bad programs. Then
there’s a flaw in almost every
version of Windows Media
Player, and a host of other
problems have been found as
well—including a security hole
in Word 2000, XP, and 2003;
a critical flaw in PowerPoint—
and more! 

The Damages
Microsoft calls a vulnerability
“critical” if attackers could
exploit it without any action on
the part of the victim. Critical
flaws in IE are especially
dangerous because they
expose users to the risk of
having their computer
completely hijacked by visiting
a malicious site.

The Solution
You need to immediately install
the patches. All the required
patches are available via the
Microsoft Update Web site
(windowsupdate.microsoft.
com), or you can activate
Automatic Updates on your
computer. Office 2000 users
will need to also visit
Microsoft’s Office Update
site to download the Office
patches separately.

“Laloo Prasad Yadav”
“Bill Gates!”
Basuri

“Whom would you compare your computer's IQ to?”One Silly Question

17
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A Library, Straight Dope and 

TThhee  IInntteerrnneett  PPuubblliicc  LLiibbrraarryy
Visit this site to get an idea of how much
information you can access! The pane at
the left is infinitely expandable—hover
your mouse over a heading and you get 10
categories, with sub-headings. With
categories such as Almanacs, Dictionaries,
Science & Tech, the site links to hundreds
of sites, and is comparable to the old
directory-style Yahoo!.

TThhee  SSttrraaiigghhtt  DDooppee
“Fighting ignorance since 1973.” The
Straight Dope answers such questions as
“How do you donate your body to
science?” and “How do they get beer into
cans?” OK, these might seem silly, but
imagine that you can get answers to
almost any weird question, and you have
the ultimate trivia site at your fingertips.
What does “OK” stand for? What is a mojo?
Go ahead, it’s all searchable!

LLiiffeehhaacckkeerr
The site calls itself the “Productivity and
Software Guide.” A humongous
homepage boasts of an eclectic collection
of, well, links and articles. Back up your
mac the smart way. Download of the Day:
Gmail Remote Command. The Daily news
roundup. Save your aching wrists; switch
your mousing hand. Eclectic, like we said.
You need to take a look. We loved it.

www.straightdope.com

www.lifehacker.com

www.ipl.org

that is centrally managed to
transfer calls to a
traditional phone network.

The case is interesting
because it seems so
frivolous. The patent in
question is the “point-to-
point IP” patent, which
details the “exchange of IP
addresses between
processing units in order to
establish a direct
communications link
between the devices via the
Internet.”

First thoughts: the
above seems so ambiguous,
it describes almost every
data transaction on the
Internet! How could
Net2Phone have been
granted this patent? They
could sue anyone on this
basis! The Internet is all
about two IPs
communicating with each
other, and at first sight,
Net2Phone seems to have
copyrighted the Internet!

Now, when one reads
the patent abstract, it
doesn’t seem as general as
all that, but it still seems to
describe all P2P and IM
systems. We haven’t read
the entire patent, but in all
probability (American
lawyers certainly aren’t

stupid), the patent is
probably much more
complex.

The question, however,
raises its head: why wait so
long? Why not sue when
Skype started off? This is
almost identical to the
situation we reported last
month in this space, with
Creative suing Apple for a
patent on a user interface.
Net2Phone seems to have
waited for Skype to be
acquired by a large
company before making
their move.

Perhaps we’ll see a new
law that bans suing so late
in the day! But the question
we’re asking now is, will
Skype sue back? Will Skype
win? Or will the case be
dismissed on grounds of
frivolity?

IN THE UK AND SOUTH KOREA

Mobile TV
Trials

Is the time ripe for
mobile TV, and will DAB

work? That’s what
providers in the UK and
South Korea are going to

A Round-up Of Technology News From Across The GlobeThe Digital World

Three Incredibly Useful Sites

UNITED STATES

EUROPEAN UNION

CHINA

UNITED KINGDOM

JAPAN

Disney has launched a
cellphone service tailored
to families with children.
The Disney Mobile family
plan features include
letting parents set
allowances of minutes for
talking, and tracking kids
via satellite.

The 25 EC member states and nine
accession countries have signed an
agreement committing themselves
to an “Internet for all” action plan to
ensure that even the most Web-
disadvantaged groups can get online:
Web accessibility could soon be
“mandatory” in Europe!

Shanghai will launch
city-wide IPTV services
as Net access speeds
improve. IPTV will be
officially launched after
Shanghai Telecom
upgrades the local
network from to 2 or 3
Mbps. But what about
content being ensored?

BBC director-general
Mark Thompson wants
to turn the BBC into a
truly global media
brand. He avers that
the Internet is the
future for the 84-year-
old BBC, one of the
world’s foremost
broadcasters.

NTT DoCoMo Inc has said that
the number of subscribers to
its FOMA 3G mobile phone
service has topped the
corresponding number for 2G.
DoCoMo is moving to migrate
even more subscribers to 3G.



Pulse

Photograph Kawaldeep Singh

Last Month’s Winner!
Manushree Gangwar 
176 Ravindra Garden, Sector-E,
Aliganj, Lucknow-226024, UP
“MulTEAprocessing”

E-mail your caption with the
subject ‘Beat That’, and your
postal address, to
beatthat@thinkdigit.com
and win 
C# Programming
by Burton Harvey, 
Simon Robinson
Published by Each month, Digit will carry a caption for a photo. Come up with something funnier, 

and beat the Digit team at their own game! Entries accepted by the 15th of this month.

Digit Caption

“Research shows CEOs
getting younger every day”
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try and find out. A
forthcoming six-month
trial will cover the London
area in the UK, and will see
broadcasts from the BBC,
the Cartoon Network, and
ITV, amongst others.

DAB stands for Digital
Audio Broadcast. Two
variants of DAB, which is a
broadcast standard that
can be used for mobile TV,
will be tested in the trial.

There are two ways of
delivering video and
multimedia services to
mobile devices via DAB.
The first is DMB (Digital
Multimedia Broadcasting),
which uses the MPEG-4
coding system via “stream
mode” over DAB. The other
is via an IP application,
called DAB-IP.

Having a choice of
methods is a key advantage
for DAB, since it offers
flexibility and options for
network operators.

DAB multimedia
services work with both
GSM and CDMA networks.
Korea has had DMB
broadcasts since 2005,
with 2 million TV phones
to be sold by the end of
this year.

Amongst the issues the
project will investigate are
content protection,
coverage, how the receivers
perform, and chipsets.
Many biggies have already
expressed their interest in
mobile TV, but barriers
stand in the way of mobile
TV becoming mainstream—
including regulations and
rights questions.

However, John
Whittingdale MP,
chairman of the culture,
media and sport select
committee, said the
industry should not be
overly threatened by them:
“These are all relatively
minor matters. I hope
these minor difficulties
can be resolved soon.”

Minor difficulties these
may be, but who exactly
wants to watch mobile TV?
Several analyst reports
have already questioned
the viability of this new
medium.

There still isn’t much
evidence that people
actually want TV on their
mobile phones. Those
involved with this project,
however, seem to simply
assume that it’s obvious

that everyone wants TV on
their phones.

Some aver that most
people on the go won’t be
watching television—for the
obvious reason: they’re on
the go, doing something—
not just sitting around
where they can watch TV.
(If they’re at home, they
have a much better way to
watch it.) Until holographic
projection phones come in,
we’re talking about tiny
screens. Then there’s the
question of interruptions
from phone calls.

However, Anders Jensen
of Vodafone and Thomas
Ekman of Tele2 believe
that giving people news
and other content
whenever and wherever
they want is the big
benefit of mobile TV.
“Mobile TV lets you kill
five minutes whenever you
have them,” Jensen says.
“There is a convenience
factor to watching mobile
TV and, in our society, a
convenient service has
great potential to become a
good business opportunity.

“What people see on
regular TV, they’ll want to
watch on their mobiles.” 

LOTS OF MONEY TO BE MADE

3G For The
Developing
World

Will we actually soon
see widespread 3G in

India? Members of  the GSM
Association (GSMA)
approved, on June 13, a
programme called “3G for
all”—sponsored by the
Hutchison Group— that
could help bring mobile
Internet access and third-
generation multimedia
services to more people in
poor nations, including
India. More than 72 million
people worldwide use 3G
GSM technology, mostly in
the developed world. The
GSMA said they want to see
this number grow to
include folks in
underprivileged nations.

Through the “3G for all”
programme, the GSMA
plans to establish a set of
common requirements for
3G handsets, in an effort to
help mobile phone
suppliers quickly bring
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down the cost of
manufacture. “Our 3G
handset initiative will
allow… people to take
advantage of the video clips,
mobile music, Internet
access… now enjoyed by…
users in the developed
world,” said Rob Conway,
chief executive of the GSMA.

The programme will
encourage phone suppliers
to compete to design 3G

handsets that meet the
mobile operators’ common
requirements. The GSMA
will endorse the winning
handset, which will then be
widely deployed by mobile
operators participating in
the programme.

This latest initiative
builds on the success of the
GSMA’s earlier Emerging
Market Handset (EMH)
programme, which created

a new segment of ultra-low-
cost phones with wholesale
prices of less than Rs 1,400
for entry-level handsets. The
GSMA has said that the
availability of such handsets
has telecom-enabled
millions of people. In India,
the EMH programme has
helped bring the wholesale
cost of GSM handsets down
by more than 25 per cent
since last year.

Despite such a fall in
prices, the GSMA estimates
that there are about a
billion people worldwide
who won’t be able to afford
a handset for the
foreseeable future. The
GSMA, through its
Development Fund, is
looking at how to extend
the benefits of mobile
communications to this
segment. To this end, the
Fund is financing a series
of pilot projects in Africa
and Asia that enable locals
to set up payphone
businesses or Internet
cafes; it has helped Airtel
launch a pilot project in UP
that equips entrepreneurs
with handsets specially
adapted to function as
payphones.

In regards to 3G, the
Press Trust of India quoted
telecom minister
Dayanidhi Maran as
saying, “The Government
has to make some money
out of it (the 3G
spectrum)... (and) make it
very competitive and does
not want people to sit over
spectrum.” He did not
mention how 3G should be
priced, leaving it to the
TRAI. “Government will
take a decision after TRAI
comes out with its
recommendations.” Let’s
see how soon that
happens.

MICROSOFT TO END SUPPORT

Death Knell
Sounds For
Windows 98

Come July 11 and
Microsoft Corporation

will be formally ending
support for the Windows 98
line of operating systems—
Windows 98, Windows 98 SE
and Windows ME. You
probably sit at a much faster
machine, but PCs on the
lower side of 128 MB RAM
and a 400 MHz CPU still
work best with this dated OS.

After the termination of
support, no new security
patches, bug fixes or updates
will be available. This does
not mean the end of the
world—one just needs to be
extra careful when surfing
high-risk sites, opening
unknown .exe files, and so
on. A firewall is a good idea.

Extensive help can be
found on forums. If you get
a Win98 error message, you
can type in the error into a
search engine and follow
the links to forum threads.
Two particularly helpful
forums are
www.computing.net and
www.annoyances.org.

Microsoft had
announced the end of
support for Win98 and ME
earlier, and had pulled back
that decision; this, according
to research analyst firm
Gartner, was due to fears of
users migrating to Linux.
Win98 therefore got a new
lease of life, but this time it
seems to be for real. The real
concern is for small
corporates who cannot be
lax about security, and who
will be forced to upgrade. 

Encroaching further on Microsoft’s territory,
Google has a new online spreadsheet offering—

cleverly named Google Spreadsheets—and
everyone’s talking about it. The interface is intuitive,
and you can work on a spreadsheet as soon as you
log in to spreadsheets.google.com. About the unique
features: you can choose who can edit or view a
spreadsheet you created just by typing in their e-

mail address. Multiple people can view and edit a
spreadsheet online simultaneously. You can view
who’s accessing your spreadsheet, who’s editing it,
and chat with them right there! Google auto-saves
your spreadsheet, freeing you from the worry of
power failures and system crashes. You can also
save spreadsheets on your system in formats such as
XLS, CSV, and HTML.

Google Spreadsheets

GENDER 

BENDERS

Anuradha’s cerebral cogs and wheels got into action when we told her about
the task. She headed to Google.com and typed in “English +Web Pages”. The
count? 63 million. Not figuring where to find the answer, she opened each
result successively, without realising that the result count is displayed just
below the search tab. We gave her a hint. With renewed energy, she
rephrased her search term to “English” and then “number +English” to get
4.5 billion. And that was the end of that.

Anuradha  vs. Bhuvan

How Many English Pages Can You
Access On The Web? 

When we told Bhuvan what he needed to do, he seemed very confident indeed. All
smiles, he Googled “Web Pages +English”. He rephrased his terms a couple of
times but didn’t get a decent answer. Then thought a different search engine
would give better results. Alltheweb.com didn’t help either. We gave him the same
clue we gave Anuradha. Bhuvan used his first phrase to see the count he had
missed—872 million—a far cry from 26 billion, which is what you get when you
Google “+the”. Anuradha wins—for time and for getting closer to what we wanted!

00:07:20:00

00:06:15:43
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MADE IN INDIA

IIT IDC DDS?

The Industrial Design
Center (IDC) at IIT

Bombay showcased the
design talents of their
graduating batch at the
Design Degree Show (DDS)
2006 on June 10 and 11. 

Technology was clearly a
key point at the show, with
students’ designs going
from the wild and
improbable to ideas that we
might end up seeing in our
daily lives before we know
it. Among such intriguing
works was Susheel
Kewalay’s interactive device
for traffic policemen,
allowing them to effectively
“wear” traffic signals on
their hands—no more
frantic waving!

We were also drawn by
Abhishek Chitranshi’s
mobile phone for the
elderly—complete with big
buttons and an emergency
button should ol’ gramps
need some immediate
assistance finding his
dentures (or just want to
annoy you). Of course, the
idea isn’t new—a similar
idea debuted at CeBIT this
year, but Abhishek points
out the brilliance of the
phone’s camera: since the
elderly have trouble holding
their hands up for very
long, which results in shaky
photos, the camera is
designed at an angle, so one
can take a photo without
raising one’s arm much. 

#1 DAYTIME MEDIUM

Web High Up
In Media
Rankings

Now, in a first-of-its-kind
study, it has been found

that the Web is the
predominant information
medium in the workplace,
is the #1 daytime medium,
and is #2 in the home. This
was documented in a report
from the Online Publishers
Association (OPA).

Further, the study says
17 per cent of all media is
consumed via the Web. This
is a conservative estimate,
and other researchers have
placed the 17 per cent
figure even higher.

These figures were
reached via a research
project by Ball State
University’s Center for
Media Design. It tracked,
every 15 seconds, how 350
people in the US used the
media. The genders were
represented about equally,
and each person was
monitored by another
person for 80 per cent of
the waking day.

“Someone actually came
into their homes and
workplaces and had a
handheld computer, every
15 seconds registering their
media consumption and life
activities,” Pam Horan,
president of the OPA, told
CNET News.com. This is a
first-of-its-kind study
because in all earlier
studies of this sort, people
were simply questioned
about media usage via
phone surveys and such.

The study used census
data to determine the
spending habits of the 350
monitored subjects. Web-
dominant consumers’
annual retail spending
averaged $26,450 (Rs 12
lakh), while TV-dominant
consumers’ spending
averaged considerably lower,
at $21,401 (Rs 9.8 lakh).
Despite this, only about 8
per cent of all advertising is
done on the Web, according
to other studies.

“I hear more and more
from marketers that they
have shifted their business
to be more responsive and
realign. There is an active
movement by traditional
advertisers to be able to
explore platform
strategies,” said Horan, who
believes research studies
are attracting the attention
of advertisers, and may
result in a faster shift in ad
spending to match the
actual statistics of
consumer media usage.

Interestingly, the
researchers conducting
the OPA study found a
direct correlation between
Web traffic and offline
referrals to Web sites. For
example, when PBS—the
US public broadcasting
network—told people they
could find more
information on PBS.org
about the topic being
discussed, people do go to
that Web site; the same
was found for print
referrals to publications
such as The New York
Times (NYTimes.com).

Most of this comes as
no surprise: Internet
penetration is ever-
increasing, and the growth
and popularity of
broadband is driving more
people to the Web.
However, it remains to be
seen whether advertising
on the Web can be made
more effective, since it is
so easy to click away from
ads on the Net. Perhaps
we’ll soon be seeing more
intrusive methods of
online advertising, such as
having to view an ad
before moving on to a
news article.

The 17 per cent figure—
which we can conceivably
augment to 20 or 25 per
cent, since that’s a
conservative estimate—is
significant. The finding also
corroborates with the fact
that in countries with high
Internet penetration, print
is going out of fashion.
Online ad spending can
only increase, partly
because as this and other
studies have found, Web
surfers are richer and spend
more on the average. 
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Network Neutrality
What is Network Neutrality?
Network Neutrality is a policy
that aims to equalise the
Internet, basically stating that
network providers should treat
all Web sites equally and serve
them to users the best they can.
The aim is to enable users to
choose sites based on content
rather than how fast they receive
them from servers.

Who is fighting for it?
In his paper Network Neutrality,
Broadband Discrimination,
Columbia University Professor
Tim Wu talks about the eerie
idea that network operators
could decide which sites open
faster for you based on how
much they pay the operators.
There is also the “Save the
Internet” Coalition that aims to
unite the world in an effort to
protect Network Neutrality.

Why are they fighting?
The US Congress seems all set to
pass a law that will send Network
Neutrality packing. Operators
will then be able to sell their best
services to the highest bidder—
pay more, and your site will open
faster. Web hosts will become
like your local cablewallah—
deciding what you should see
based on what’s profitable.

How does it affect me? 
Imagine a situation where your
competitor pays a network
provider like Sify to optimise
performance for their site, and
not for yours. Corporate
sabotage will go through the
roof, and you, the user, will suffer
the worst. Your very freedom to
surf whatever you want will be
threatened: eventually you’ll end
up patronising the sites your
operator wants you to.

When did this madness start?
On June 8, 2006, the US House
of Representatives passed the
“Communications Opportunity,
Promotion and Enhancement Act
of 2006” (COPE)—an act that has
no protection for Network
Neutrality.

Where can I find more info?
To read Tim Wu’s paper, visit
http://papers.ssrn.com/sol3/pap
ers.cfm?abstract_id=388863 To
find out more about the Save the
Internet Coalition, visit
www.savetheinternet.com.
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Special Report | Computex

O
ur quest to be your technology nav-
igator saw us at Computex ‘06,
between the 6th and 9th of June in

Taipei, Taiwan. This was Digit’s first ever
trip to Computex, and a memorable one
too—we were also one of the exhibitors,
peddling our wares to the world. 

For those living under the rock, Com-
putex is an annual IT exhibition held in the
capital city of Taiwan—Taipei (why not
Venice?). Well, most IT hardware prod-
ucts—Motherboards, VGA cards, memory
modules, routers, etc. are manufactured
by Taiwanese companies, hence Taiwan. 

After CeBIT, Computex is the second
largest technology exhibition in the world
and its popularity is growing year after year,
attracting more exhibitors not only from
Taiwan but also from other nations. While
CeBIT is the place for showcasing of new
technology, Computex is more an exhibition
of products set to hit the market in coming
months from all major Taiwanese compa-
nies—ASUS, MSI, ECS, Foxconn and more.
Though the event is more for hardware
resellers, it’s the place to take a sneak peek
at the products of tomorrow.

The Colours of Computex! (Clockwise from left) Reception ceremony in traditional Taiwanese fashion, The mascot pays a visit to our booth, Beauties
running on Segways distributing flyers and last our decorated booth in the Media area of Computex. 
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▲Flash On Steroids
Flash memory seems to have caught
everyone’s fancy. Hard drives based on
flash memory aren’t light years away—
they were right there at the Computex.
The first one is a Transcend 8 GB IDE
flash drive. The Second packs 32 GB,
and the Third is a 1 GB DiskOnModule
(DOM) with standard USB interface.
With these drives, you will see lower
power consumptions, and better yet—
instant start-ups!

▲Personal storage
If you thought personal storage was boring, here are glimpses of things
to come! 1. great looking USB drives from Transcend available upto 2GB,
just beside is the stylish incarnation from Apacer. 2. The elegant MP3
player from Apacer with OTG funtionality. 3. That dinky MMC card has an
astounding 4GB— enough to transform your phone into an MP3 player.
4.A sleek 3mm Aluminium case harbouring 8GB of storage space and 5.
A USB flash drive from PQI with an integrated memory card reader.

▲Motherboards
The biggest show-stopper at Computex 06 was the launch of Intel’s P965 chipset—one that will support the much-hyped Intel Conroe
processor. As always, the 965 Express chipset has two other variants, the G965 and the Q965. While the G965 with integrated graph-
ics is targeted towards home users, the Q965 is targeted at businesses. Shown above are motherboards from Foxconn, ASUS, MSI and
Gigabyte. What’s notable is the use of heat pipes to cool the Northbridge and Southbridges—on high end boards, of course. Also
expect to see lot of bundled accessories in the final box pack.

1
2

3

4
5



▲Small Form Factor And Home Theatre PCs 
If you thought Windows Media Centre Edition has gone the dodo’s way, surprise! Every Taiwanese company worth its salt were out there with an
HTPC. Aopen was first to the market with the mini PC to rival Apple’s Mac mini. Based on 945 chipset the new mini PC looks stupendous in the black
brushed aluminium casing (Extreme Right). 

Shuttle had a rather smaller design up its sleeves, not confirmed yet for producting it is damn small and beats Aopen’s mini PC to its game. Shuttle
was also displaying its top of the line home theatre PC M1000 (Top Centre), an elegant living room PC with low decible design. Its unfortunate we won’t
be able to get out hands on the Shuttle, due to lack of distributors.

ESC, a major player in motherboard and VGA also had some great HTPCs on display. The P60 (Extreme left) was the slimmest that we came
across. Running on Intel Pentium M low voltage 

Chassis
Coolermaster, Thermaltake, Foxconn, Asus etc had various chassis designs targeted at enthusiasts and gamers. While some designs were ele-
gant, others were simply wacky.  All were expensive, but undeniably desirable. Shown below (From left) The new Coolermaster Mystique,
Foxconn Red riding hood and the Coolmaster Stacker

Special Report | Computex
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Content is
becoming more
and more
mature,
especially so on
the Net. Are
parents and kids
prepared?

talking about—some of you might be even
saying, “Yeah, so? What’s the big deal?”

Let’s all get off our moral high horses, forget
our so-called conservative Indian culture, and
leave the sex-is-taboo attitude at the door for the
short duration it will take to read the following.
Talking about it (or not talking about it, for that
matter) isn’t going to change the harsh reality
that will hit you in the face every time you or
your kids go online! The Internet has no morals,
it has no culture, no age limit, and no gover-
nance—there is no moral high ground for it to
take. Pornography is everywhere, and anyone
who’s been online has encountered it.

Sex Does Sell
Let’s not judge whether it’s right or wrong, but
I’m sure we’ll all agree that this
is true! I’m willing to bet that
quite a few of you picked up

Agent 001

y day begins with checking my mail
along with my morning cup of coffee.
Despite the spam filters, my Gmail

account always seems to contain spam:
strangers commenting about the size of my
unmentionables, or claiming the power to make
me a sexual god—provided I click on that link of
course! Then there’s the whole slew of mails I
receive every now and then about the sexual
escapades of women who are actually men (or is
it the other way round?)!

Some of you reading this might be mutter-
ing, “Chee chee, what rubbish he’s talking about!”
Others might just be saying “How can you say
such things—my kids/little brother/sister/parents
also read this magazine.” However, I’m willing
to bet the majority of you know exactly what I’m

M

Illustration Pravin Warhokar

A Sleazy
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this magazine because of what was on the
cover, flipped past the initial pages, and came
directly to this story. Whether you’d like to
admit it or not, sex really does sell; it rouses our
curiosity and plays to the voyeur in us all. It’s
like reading the sex advice columns in
tabloids—you may not have any of those prob-
lems, but the curiosity that killed the prover-
bial cat gets the better of you.

Take a look at the content on most TV chan-
nels today, from the ads to the soaps—everything
is laced with sex and double-meanings. We’re
not here to debate whether that’s bad or good,
and we’ll leave it to the public, the moral police
and campaigning politicians to sort it all out
amongst themselves, but what we see on TV is
quite sanitary compared to what’s online.

With Internet penetration increasing by the
day, and people moving from dial-up to “broad-
band” across the country, the demographics of
the Indian Internet populace is changing by the
minute. Kids and grandparents alike now get
online, and almost every urban Indian has
access to the big bad Net from either home or
office, or both.

Back to the point: Sex sells! Sexy ads all try
to appeal to our sexual personas. Being sexy is
a requirement today, and ads make you “want
to be” even more. At least there’s a governing
body for television, and this prevents the
content from getting too wild. The Internet,
however, is another story altogether, and it’s
not so much about sex here as it is about
pornography. Because of the freedom the Net
affords, there’s no need to be subtle: content
there ranges from the mildly titillating to the
horrendously explicit.

Who Am I?
On the Internet, no one except you knows that
for sure—and sometimes even you will not.
Anonymity is the ultimate aphrodisiac, the

battering ram for our moral barriers, and the
stripper of our inhibitions. Perhaps that’s why
there is so much of a market for pornography—
child pornography included. It’s because most of
the people who buy or trade illegal pictures and
videos do so knowing that it will be hard, if not
impossible, to track them down.

It’s not just to pornography that anonymity
lends a helping hand, but also to hacking, warez
trading and more. Most of us have done some-
thing illegal online—but what’s more important
is that none of us care, or need to worry about
getting caught.

The Truth About Your Kids
We’re raising a generation of tech-savvy kids who
know how easy it is to get absolutely any type of
content online. Kids today don’t need to hide
dirty magazines under their beds like earlier
generations did. I remember a friend in school
who had a lingerie catalogue smuggled in from
the US—that’s what we considered pornography
in the late ’80s. Today, almost every teenager who
goes online has a folder on his hard drive that’s
full of hardcore (very explicit) pornographic
images and videos. Depending on his parents’
knowledge of computers, this folder might be in
plain sight, hidden, or even encrypted.

Most porn is targeted at men—or boys! If you
have a son who goes online, he has in all prob-
ability been exposed to pornography. If not
through e-mail, then through friends, chat
buddies, while surfing, and from Web searches.
Look at the bright side though: you don’t have
to have that talk with him about the birds and
the bees—the Internet gave him a full audio-
visual presentation!

The Talk
Most surveys show that parents are too uncom-
fortable to talk to their kids about sex. Schools
and colleges have started sex education (or what-
ever is the politically correct name for it), but
those classes are more like biology lessons than
anything else. Kids don’t need biology lessons!
Do they really need to see poor cross-sections of
the human anatomy? Especially when you
consider that they can get more practical, close-
up pictures of said anatomy being used in 15
seconds flat if you give them a computer and
an Internet connection—which you already
have, incidentally!

“Women = Meat.” That’s what many experts
say is the popular perception boys and men have,
thanks to pornography. Interestingly, this is less
true in sexually liberated cultures, like in West-
ern countries. In India, where saying the word
“sex” is likely to get you slapped, most men have
nothing but pornography to help form their
opinions and aid in the sexual growth from
teenager to man. This is where your “talk” comes
in. You don’t need to explain sex to your
teenager—they already know that! What experts
are pleading for is that parents teach their kids
the value of love and the methods to prevent
against diseases like AIDS. With India having
recently overtaken South Africa to become the
country with the most HIV+ people, you’d better
start talking soon!

Pornographic sites are dominating the Net, but they’re being a little more careful
about how they distribute their content. The credit card age verification process

that a lot of them have adopted is proof of that. Though this tactic is being used by
a few to charge your cards surreptitiously, a lot of them actually use this method to
verify age. Some sites also put up large warnings that say “You must be 18 or older
to enter.” All of them proclaim that all their “models” are 18 or older, and direct
you away from their sites if you say you’re not 18.

However, like everything else, this is a business, and ethics are a pipe dream.
You will still get spam in your e-mail from such sites, and often, opening one of
them pops up more and more of their sister sites. 

There was this whole ado about .xxx domains: pornographers didn’t want to be
limited to one domain suffix, even though that would make them easier to address
their target audience. It would reduce their business, because content would be so
easy to control—all you would have to do is block .xxx sites and you could be sure
that your children are safe. For the pornographer, this would mean that most
search engines would just block .xxx sites from being displayed in results, unless
the searcher specifically asked for them. This would cut back on the amount of
people who stumble across sites while surfing—a fairly large number.

A site is global, and access to it has absolutely nothing to do with where in the
world it’s hosted—while laws have everything to do with where it’s being hosted—
that’s the ambiguity of Internet law! Since the Internet belongs to no country, there
are no laws that can govern it. Even when countries do make laws, the people who
want to do so find loopholes or just move shop to a more sympathetic country. 

The Pornographers

Because of the
freedom the Net
affords, there’s
no need to be
subtle: content
there ranges
from the mildly
titillating to the
horrendously
explicit   
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Back To The Net
I apologise for that little diversion, but it was
necessary. For all of you parents out there who
are reading this article in disbelief, and those of
you who are saying “My son/daughter would
never do/talk about that!”, I have a simple path
towards the light.

Many of you have kids who use instant
messengers such as Yahoo! Messenger, MSN
Messenger, and others. Here’s what to do:

1. Get access to a computer away from home,
or in your own room.

2. Sign-up for a Yahoo! account—only, don’t do
it with your real name. Fill in a girl’s name, and
put your age at 15.

3. Make sure your login name reflects that
you’re a girl.

4. Get Yahoo! Messenger—a very popular
instant messenger.

5. At the time of day when your son/daughter
usually uses the Net, go to one of the chat rooms
in the regional group “India.”

6. Announce that you are a 15-year-old girl
from <your city> looking to make friends.

7. If you have a Webcam, turn it on and wait
for the solicitations for cybersex (sexually-
oriented, titillating chat) to come pouring in.

Do the above. You’ll get a first-hand experi-
ence of what your son and/or daughter might be
exposed to online every day!

No More Internet For You!
I know that’s the strong reaction many of you
would likely have, but that would be wrong on
just so many levels! First off, the Internet is a lot
more help than it is destructive—think of all the
useful information your kids have access to.
Secondly, you can’t cage your kids up forever,
and they’re going to start working soon enough;
knowing how to use the Internet productively is
almost a job requisite now—so let them learn!
Finally, kids are almost immune to this sort of
stuff. You wouldn’t believe the kind of stuff that
your kids don’t get shocked or scandalised by! You
may be appalled at what you see, especially if you
did the little exercise I mentioned above. But
your kids will just take it in their stride. Thay are
a lot less susceptible to being fooled, duped,
conned, lured, etc., than you are online!

The Tables Have Turned
Parents are no longer the all-knowing keepers of
secrets. Today, the younger generation knows a
lot more about computers than anyone else,
especially those who are growing up with it. Take
my parents for example: I write for the country’s
premier technology magazine, but my parents
know nothing about computers, and quite
honestly, they couldn’t care less. Had I been 10
years younger, and up to the mischief that is part
and parcel with teenagers, I’d be doing a lot of
things my parents would tch-tch at!

It’s the older generations that need to take
on the responsibility of learning enough about
the technology that is ruling the lives of the
younger ones. Some would go so far as to say
that it’s not the sex education of the young
ones we need to worry about, but the tech educa-
tion of the elders.

The Tech Education
On the Internet, as we’ve mentioned earlier,
we’re exposed to adult content through several
avenues. The most common is e-mail spam.
Since we have an unwritten “free” software
policy in India—not the freeware type, the free-
warez type—almost all of us go searching for
cracks, serials, key generators and the like.
Unfortunately, almost all warez sites have ads
from pornographic Web sites. Teenagers often
end up clicking these links, and are promptly
exposed to the most explicit of adult content.

Chat rooms are another source of exposure
to adult behaviour—even from 15-year-olds. In
the exercise I mentioned earlier, I asked you to
pretend to be a 15-year-old girl; that was to
show you that although trying to solicit a 15-
year-old for sex is a crime in almost every coun-
try in the world, it will still not stop people
from trying to find out your address and your
phone number, and convince you to have cyber-
sex with them. 

Doing that in real life with a 15-year-old
would most definitely land them in jail, but on
the Internet, who cares? Besides the sexual
predators, there are bots—automated
programs—spread across almost every chat
room online, which display URLs to adult sites,
a form of advertising almost all porn sites
indulge in.

Another area where you will come across
pornography is when using a search engine—
your son or daughter might just do a search on
the word “sex” or something similar, out of
curiosity—and will be bombarded by links to
pornographic sites. And apart from this, even
casual surfing will land you at an adult site
sooner or later—such is today’s Internet.

The Sex Education
There are a lot of evils that teens and pre-teens
need to be wary of when online. Whether or not
you visit porn sites is purely your business. It is
only for you, your parents, relatives, and society
to decide whether this is wrong or not. However,
be warned that a lot of adult sites will dupe you
into spending money or compromising your
security. Let’s take a look at the most common
traps set out for you.

Diallers: You will find thousands of sites
that advertise free porn provided you use their

dialler to connect to
them. They charge you
per minute in dollars
for any calls you make,
and this is not counting
the ISD charges of
connecting to the US.
Make sure you never
install diallers from
porn sites: they might
even contain Trojans or
worms. 

E-mail: A lot of sites
offer free hardcore
pictures in the form of
e-mail newsletters.
Almost all the time, this
is just a ruse to get you

It’s the older
generations that
need to take on
the responsibility
of learning
enough about the
technology that
is ruling the lives
of the younger
ones   

An example: a site that claims to teach people how to get
porn for free! We got this link via spam e-mail, but it’s
also popular on warez sites
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to give them a valid e-mail ID so they can sell
your information—usually to a spammer. So you
should either never give out your e-mail address
to porn sites, or be prepared for thousands of
spam mails a day. You could always create an
e-mail ID meant only for spam, and use that to
sign up, if you must.

Credit cards: “Free” content is offered by
several porn sites, which urge you to enter your
credit card information to “verify your age.” You
need to stay away from doing this, and go look-
ing for free sites with the content you want
instead. Your credit card information could be
leaked, and you could get some strange bills.
Even at “trusted” (read notorious) porn sites, you
have to read the fine print before you go about
entering your credit card number. Very often,
the word “free” is misrepresented: if you read the
fine print, you’ll see that the content is only free
for the first three days or so, after which your
card is automatically charged for a month’s
worth of access. This could be for a shorter or
longer duration, but you will be charged. If you’re
using daddy’s credit card, you’re going to have a
lot of explaining to do.

Chat rooms: People are almost never really
who they claim to be in chat rooms. That 16-
year-old girl you think you’re falling for could
well be a 61-year-old male. Don’t give out any
personal information online, such as your tele-
phone number or address. Girls and women
need to be especially careful about who they
fraternise with online!

Web cameras: This is the age of broadband,
and everyone now seems to have a Webcam.
Yahoo! Messenger is especially popular for its
chat rooms and liberally-used Webcams. A lot
of people use pre-recorded feeds from some
pornographic Web cam site to pretend to be
women, and in turn will ask young males to
turn on their Webcams and indulge in “cam
sex.” Either they’re trying to get you to pay to
see more, to cam with a real woman, or they’re
recording you and selling your video to homo-
sexually-oriented porn sites. The bottomline is
that if you think you’re getting digital sex and
get naked on camera, you’re probably getting
digitally exploited!

Sites: Many pornographic sites are fronts for
hackers, who use malicious Web-based code to
try and extract personal information. Just by
visiting a site, you are exposing yourself to
spyware and Trojans.

P2P: Another very common way of getting
porn as well as viruses. Many people share virus
or Trojan-infected files renamed to look like
pornographic pictures or videos.

What Can We Do?
This is the question most parents are asking. The
answer is simple: you need to first educate your-
selves. Only then you can go about protecting
your children. The simplest solution is to use
content blockers, popularly referred to as porn
blockers or parental control software. These
content blockers will restrict your children to the
“clean Web” and block all pornographic sites,
images and videos from being viewed on your
home computer.

The settings for such software are protected
by passwords, so children cannot bypass the
rules you set. Of course, there are chances
that some safe content will also be blocked,
but I think this is a risk most of us would
willingly take.

Some software, which we’ll get to shortly,
also let you set various levels of filtering,
depending on the age of your kids. So use a
“paranoid” setting for your 10-year-old, and a
“low” setting for your 17-year-old.

In Conclusion
It’s scary! A majority of the parents we spoke to
for this piece had no real knowledge about adult
content and how it can be controlled or blocked.
A lot of these people, not named here for reasons
of privacy, have no real clue about how to use
computers, or, more importantly, how their kids
use computers. Perhaps we really are to blame
for all those MMS scandals, simply because most
of us don’t know enough about the technology!

The analogue generation of yesterday seems
shocked by technology and the way it is—or can
be—used by the digital generation of today. The
rapid growth of technology and the way it’s
woven itself into our lives seems to have caused
more of a continental drift than just a genera-
tion gap.

Thankfully, the kids of today will not be as
shell-shocked by whatever technology comes in
tomorrow, so right now seems to be the worst. The
only plausible solution to the porn problem is to
get yourself a content blocker, and make sure
your kids or younger siblings are not exposed to
content online that may adversely affect their
outlook in the most defining years of their lives.

Don’t worry—we will all weather the storm.
All we need to do is be positive, be open to
conversation about the subject, and be strict! I
just hope this article opens more eyes than
it closes!

Enough theory; let’s take a look at some of
the software that’s available and how they
performed when I actually used them. I stress-
tested the software by trying to find porn with
them running. I will talk about each software
individually, in alphabetical order.

The analogue
generation of
yesterday seems
shocked by
technology and
the way it is—or
can be—used by
the digital
generation of
today   

Yahoo! Messenger Chat lets you choose a room by
interest. However, as you can see in the image, if you’re
looking for “Romance”, you will more sex than love!
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Child Control 2006

You can get this software at www.salfeld.com.
It’s just a 5.3 MB download. Installation and

configuration are a breeze, as is the case with
almost all the software in this test. I used the
30-day trial, which is not limited in any way in
terms of functionality.

As soon as I was done installing, I got a very
useful configuration screen. I found that I
could disable the Command Prompt, Registry
Editor, Task Manager, Control Panel, Display
Properties, and many more controls by which
a really geeky teen could attempt to disable the
program. The software allows you to
control/filter Internet content that deals with
a variety of subjects, such as pornography (obvi-
ously), violence, alcohol, gambling, weapons,
and drugs. It can even block chat!

I started with a Google search for some “bad”
words, and was immediately shown a page that
told me such content was banned. I then navigated
to a well-known porn site, and I was blocked again.

Next, I went to a
not-so-famous porn
site and found that,
despite all the dirty
words on the page, it
loaded. Child Control
2006 (CC06) was defi-
nitely not doing a
smart job here, and
was just reading from
a database.

I then raised the
protection level and
found that the soft-
ware was doing a
much better job.

However, there was still no image blocking, and
our “Innocuous Site” test (see box How I Tested)
seemed to easily thwart it.

Overall, Child Control 2006 did about as
well as anyone would expect it to, and the cool
features of disabling all backdoor ways of
bypassing it make it a good choice. Another
very handy feature, which has nothing to do
with content filtering, is the software’s ability
to enforce your rules in the house regarding PC
usage. You can specify how many hours a day
your children can use the computer, and until
what time. So there’s no need to keep looking
in on them and telling them to “turn
off that computer at once”; just configure
the software and then rest easy knowing
that your kids will have to go to bed early on
school nights!

Child Control 2006 costs $29.90 (Rs 1,350).
It happens to be the cheapest paid software in
this test.

Ichose nine content filtering software based on popularity.
Seven of these were the most popular choices, and two were

freeware tools that I felt people would want as options to the
paid software. The test procedure was simple: install the
software, configure it, and then try and find ways around it.
I didn’t attempt any Registry hacking or ultra-geeky ways of
bypassing the software’s protection because I wanted to keep
the test real. If you have an über-geek for a child, no software is
going to stop him or her from finding what they want online. 

My test system was an AMD 64 3000+ with 1 GB of RAM and
an 80 GB SATA hard drive, running Windows XP Professional
with Service Pack 2 installed. All the latest drivers for the
hardware were installed, and apart from Internet Explorer,
I installed Mozilla FireFox 1.5.0.4, and already had Opera 9.00
beta (build 8367) installed.

After installing the content blocking software, I first
navigated to Google, and used its Web and Image searches to try
and find keywords that would bring up adult content without
being blocked. I then had a few sites that had very innocuous-
sounding URLs, but contained a lot of nudity. This was to test if
the software was actually scanning images, looking for a lot of
flesh, based on colour. Sadly, I can report right now that none of

the software I tested here actually do this—all of them failed this
test miserably!

Apart from this, I also navigated to sites that I know contain
a lot of text about sex and violence, and checked if the software
would block that. Right at the outset, it seemed that most of the
software were only blocking based on their databases rather
than actually looking at the text or images on the pages. I tested
each software with the normal and a higher protection level (if it
was available). The results of the highest protection setting are
noted in the table, but are not deciding factors for me. I chose to
only pit each software’s default setting against the other.

I obviously cannot provide you with the links to the sites that
I tested the software on, but I mainly tried to fool each software
using Google’s search results to find adult content. 

Since it’s obvious that the most important thing for parents
would be how the software performed, Performance scores got
a 50 per cent weightage in my decision. I gave Ease of Use and
Configuration a generous 10 per cent weightage: not too many
parents would be able to configure the advanced settings on
their own! We in India love our “free” software, so I decided that
price would be 20 per cent of the deciding factor. Finally, the
Features of a software merited 20 per cent of their overall tally.

How I Tested

Child Control 2006 blocks the Task Manager so that your
kids cannot just End Task the application

Child Control 2006 gives you a list of security options

Content Blocking Software
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ContentProtect

This is the most expensive of all the software
I tested, and will set you back by $39.99

(Rs 1,800). The first thing I found was that it took
me a while to track down the download on
www.contentwatch.com, and I was given a serial
key even for the trial version. At 5.15 MB, this was
another decently-sized download.

Installation and configuration took just 45
seconds. This was the first software I came across
that had two passwords—one to uninstall it and
one to override the settings. I then found that
you could force users to log in to connect to the
Net—a very good thing!

This software has additional features such as
e-mail notification and the option to disable IMs
and chatting tools. One terrible thing is that it
doesn’t disable the Task Manager, so closing down
the application without the administrator pass-
word is literally child’s play!

ContentProtect did an excellent job of block-
ing sites, and even stopped me from navigating
any further from my innocuous test sites. Google
images seemed to be blocked on the basis of the
ALT text or filename rather than the image itself,
which resulted in quite a bit of flesh peeping
through my Web page.

The software logs IM
chats though, which is
good for the paranoid
parent. Here again, “Time
Control” was a feature,
and lets a user decide how
much time on what day of
the week his kids should
be allowed to use the Net.

Overall, ContentPro-
tect loses badly because it
has no way of stopping a
kid with basic Windows knowledge from End
Tasking it! For really little kids, however, this is a
decent investment to consider.

Cyber Patrol

Cyber Patrol (www.cyberpatrol.com) is quite
a big download at 12 MB. At $39.95 (Rs

1,800), it’s not exactly the cheapest solution to
figure in this test. Add to that the fact that this
is a recurring annual subscription cost, and
you have one of the most expensive content
filters out there. 

Installation and configuration was easy,
and one good thing about the installer is that

you configure as you
install. While setting
it up, I got an option
to select whether I
was a home or office
user, and to select the
age demographic of
the users of the
computer. I chose
“young teen” and then
went through the
installation.

I had to reboot to
finish the setup. I use
Opera as my default

browser, and immediately browsed to a very
obvious porn site. To my surprise, it just
opened up! I then tried Firefox and IE, and the
same thing happened. This program just
refused to work. I then uninstalled it, re-
installed it, rebooted again, and this time it got
it right.

It blocked every obvious adult site easily,
bringing up a default page. It could not block
the Innocuous Sites I threw at it.

Without a Task Manager blocker, this
program is easy to bypass for anyone who
knows a little about Windows XP. I found three
processes, each easily identifiable by their
names, and ended them. What shocked me was
that when I tried to restart the program, it just
brought up an error, telling me to reboot in
order to get it working again. I persisted, and
on the third attempt to launch the program, it
started up again!

Overall, this is a decent software, and
blocks dirty stuff pretty well, but there’s noth-
ing special about the way it blocks it. The bugs
in the way it works are unforgivable. Being one
of the most expensive, it certainly didn’t live
up to my expectations. Personally, I would
never spend $40 a year on this software!

Cyber Patrol is
not exactly

secure, and the
bugs I faced

when using it
soured my

opinion of it

ContentProtect is a good blocker,
but without any Task Manager

disbling feature, bypassing it is a
little too easy for my liking! It
blocked some innocuous URLs

based on the content
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CYBERsitter 9.0

This is a very popular software today, and at
2.36 MB, it’s the smallest download of them

all. At $39.95 (Rs 1,800), it’s not the cheapest
though!

Installation and configuration were a snap,
as we’ve come to expect from all these soft-
ware—all Windows software actually! A nifty
feature was that when installing, CYBERsitter
offers to search your hard drive for “objection-
able material.” I don’t have any, so I didn’t scan,
but it’s nice to see something a little different
amongst such software. I have also read that
this “scan” finds spyware and porn diallers as
well, though I had none on my fresh install of
Windows XP Pro.

While installing, I left the default values for
all the various checkboxes I saw, but noticed
that you can choose to filter e-mail content as
well! It cannot filter chat programs, but can
block them outright—good if you have pre-teens
around the house.

In this 10-day trial version, password protec-
tion is disabled, and you’ll have to buy the soft-
ware to get that very important feature.
However, since this is not brain surgery, I don’t
foresee any problems with password protection
in the full version!

While installing, you can select the type of
content you want blocked, and then “Update
Filters”—which basically means you update the
program’s database of blocked sites. The soft-
ware lets you disable access to the Registry
Editor, Task Manager, and either the entire
Control Panel or just the Network/Internet
icons in the Control Panel.

CYBERsitter offers the time management
feature that many of the others did as well, so
you can control not just how but also when
your kids use the PC. In order to make sure no-
one can change the system time and fool the
application, it also lets you disable the
Windows Time application and the command
prompt. 

The software offers scheduled e-mail report-
ing for parents who want to keep an eye on
what’s happening at home, and also has
logging that you can come home and check.

The software blocked everything very well,
and was the only software in this test to not
allow us to search Google Images with Safe

Search off. It forced Strict Safe Search in popu-
lar search engines, and ignored all my attempts
to change this—and this, with all browsers!
Although it did not filter images for content—
it read the associated tags and forced safe
searches in image search engines—I gave it a 4/5
for image filtering.

CYBERsitter blocks silently, just bringing up a
“page not found” or some such error message,
making the surfer believe that the page doesn’t
work, rather than knowing that he/she is being
blocked. I think this is a good thing, as it might
stop the natural curiosity that kids have. It’s easier
for kids to accept “the site doesn’t work” than
“Mommy/ daddy doesn’t want me to see this site!”

This was by far the most secure software I
tested, and it would require a really gifted and
geeky teen hacker to bypass its security. Overall
a very good software, which blocks exception-
ally well. It even blocked our “innocuous sites,”
and made life miserable for me while I was
trying to fool it. If you’re willing to spend the
money, this is a really good option!

CYBERsitter can scan your hard drive for pornography

Not only does CYBERsitter force strict safe searches, it also forwards
you to a page that contains clean, free stuff online

CYBERsitter can disable the Task Manager and the Control Panel,
making it a secure program that also blocks well—a true winner here!
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iProtectYou Web Filter

This software from www.softforyou.com is
another small download—just 2.57 MB—and

costs $34.95 (Rs 1,600). I used the 14-day free trial
to test it, and found that, as usual, installation
and configuration was easy.

Like CYBERsitter, it does offer e-mail filter-
ing, but defaults to not filtering incoming mails,
because with the amount of spam we all receive,
it will have to keep blocking your mail client.
These software can filter your mail, but you’d
be a lot better off installing a good, free spam
filter that is made to do that job.

You can set the program to auto-update
itself, and also have the option of e-mailing
scheduled reports to yourself. You can even play
the role of a paranoid parent and have the soft-
ware e-mail you every time it blocks some-
thing—along with a screenshot!

Instead of time management, this software
lets you set traffic limitations—so you can decide
that your 10-year-old gets 10 MB of surfing time
a day, while your 15-year-old might get 20 MB—
provided they have their own user accounts on
the PC. You can also set the usage allowance per
user, per day of the week!

The software blocks all negative content
well, and popped up a little “Access
Restricted” warning at the bottom right when
I tried regular porn sites. It was easy to fool
the software in a Google Image search to get
images of nudity. It was not very good with
non-English sites: its database doesn’t seem to
include as many foreign sites as the other soft-
ware in this test do.

To its credit, the software allowed a site
which had adult-oriented ads to be displayed,
while blocking just the ads. This may not be a
comfort for paranoid parents, but it seemed a
good feature to me.

Security-wise, the software loses miserably
because it’s easy to End Task the application
using the Task Manager. I can’t understand why
the authors of the software didn’t look at this!

Overall, a good software that blocks content
well, and smartly, but with its poor security it’s
not something you want to buy—especially if
you are one of the many families where your
kids know more than you about computers!

Net Nanny

The most famous Internet nanny of all time,
this software is easily the most popular of

them all. The Nanny has put on a lot of weight
over the years though, and at 22.8 MB, she was
the fattest download in this test. And at the stan-
dard price of $39.95 (Rs 1,800), she doesn’t come
cheap either! You can find her at
www.netnanny.com.

Installation took a bit longer because of the
size, but was easy nonetheless. Configuration
was a snap, and I found that you could even
choose to block online games—unique indeed.

There’s also a paranoid setting that blocks
all images and ads online, so it’s good for
parents who want kids to only see text online—
but that’s a little too old-fashioned for me!

Anyway, straight to the tests: the Nanny does-
n’t seem to have kept abreast with the times,
and this was clear when it let a few obvious sites
slip by unnoticed. Another indication of age

having caught up with
this software was the
fact that it refused to
filter any images, and
the most explicit of
images just kept
popping up in Google
Image searches!

Internet slang,
which your kids are
likely to be using, just
leaves the Nanny
confused, and text
blocking was abysmal!
The only way it offered

me a challenge was when I set the filtering level
to maximum—which, incidentally, means that
only sites that are manually allowed can be
viewed! It even blocked www. thinkdigit.com in
this paranoid mode! The final nail in the coffin
was that the Nanny doesn’t seem to recognise
Opera as a browser, and just let anything by! 

Overall, this was a very unsatisfying experi-
ence, and to be honest, I expected more of a chal-
lenge from the Nanny. I think it’s time she
retired. Her “block everything or nothing”
philosophy is certainly not what you’re looking
for in a content filter!

Optenet Web Filter

This is a software I stumbled across when
reading through a few forums, and is

certainly not a popular choice. However, I
decided to include it based on a few reviews
from people who seemed to know what they
were talking about. At 17.7 MB, this software is
almost as fat as the Nanny, and at $39, just as
expensive. I got the 15-day free trial from
www.optenet.com, and found that installation
and configuration was simple enough. After a
reboot I was ready to pit my wits against it.

I was shocked to see that it refused to open
the administration panel, which it was trying
to do in my browser. I soon learnt that it proba-
bly uses some code that Opera can’t understand,
because when I pasted the address it was trying

Net Nanny’s
“block

everything or
nothing”

philosophy is
certainly not
what you’re

looking for in a
content filter   

iProtectYou has a lot of features such as e-mail
notification and filtering, but it couldn’t block any
images or content (right) from our “Innocuous Sites” list

NetNanny does not have
too many blocking

options, except for a
“Block all Web graphics”
option that seems a little

too severe.
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to open in IE, I had a username and password
dialog pop up.

The Web interface is a little irritating, but
might be easier for people less accustomed to
PCs. Every option is visible on the page in the
form of links, instead of behind tabs and
buttons like in every other software. I person-
ally hated it though!

The configuration options were easy enough
to follow, and the “Advanced Configuration” link
took me to options where I could set port block-
ing and P2P application blocking settings. 

A disappointment was the lack of a Task
Manager disabler, which made it easy to bypass
the software’s protection. It was good at blocking
obvious pornography, but failed miserably in my
Innocuous Site test!

Smart Google Image searches also brought
this software to its knees.

Overall, this product is just about average as
a porn blocker, and has nothing too special to
write home about. The best thing that can be
said about it is that it offers decent port blocking
and monitoring, and successfully blocks IMs and
P2P applications.

Parental Filter 0.24

This is freeware from www. ecomm-
sec.com, and is just a 3.03 MB down-

load. It installs easily, but offers many
advanced configuration options that
might confuse not-so-tech-savvy
parents. For those at home on a PC, this
software offers some interesting
options.

It does not offer e-mail reporting or
logging, but allows you to completely
hide the application and even run it as
a Windows Service. You need to be care-
ful though, because if you set the
option to disable the Task Manager, and
set it to hide itself, you might not be
able to uninstall it too easily, or even
find the administrator controls for that
matter. Again, this is bad for PC novices,
and good for those who know how to
use it and get additional security.

The software can be set to scan your Favorites
and Outlook Express, and allow you to redirect
to sites of your choice when adult content is
found. This is good: all the other software with
this feature redirect you to their home pages,
making it obvious that they’re protecting your
PC.

You can also tweak the way the software
works depending on how much of system
resources you have and how powerful your CPU
is, by setting the milliseconds the software waits
before re-scanning a page. 

Parental Filter showed some bugs with Fire-
fox and Opera however, most noticeably in Fire-
fox, where instead of redirecting to the page that
I set, it just kept opening new tabs. So at one
point I had this porn Web site open and about 20
google.com Firefox tabs!

It was not too hard to bypass its filtering in
Google Images. At one point, I clicked on a rather
graphic image result. Google opens image results
in frames—the top frame is by Google, and the
bottom frame is the site where the image is
located. The top frame was redirected to
google.com (as I had set it to), while the bottom
frame just went ahead and loaded!

Apart from these bugs, the software
performed decently, and even caught a lot of
Internet slang for pornographic content when I
used them as search keywords, or when they
were found on a page.

A bug in the security meant that if you do
not disable the Task Manager, you can End Task
the application and then uninstall it! It does not
ask for the administrator password when unin-
stalling, unlike all the other software. However,
if you disable the Task Manager via the software,
it will not let you uninstall while the process is
running—you have to open the administration
panel using the password and stop the applica-
tion before uninstalling it.

Apart from the few bugs, this is a good soft-
ware that filters as decently as the other soft-
ware in this test—better than quite a few,
actually—and has only a few hiccups with Firefox
that might be addressed with the next release.
Considering that it doesn’t cost you a paisa, I
would recommend that everyone install this
software to protect your kids. If you’re willing to
spend, however, that’s a different story!

We-Blocker 2.0

This is another freeware tool, and the last soft-
ware in our test. It’s 2.41 MB large, and you

can get it at www.we-blocker.com. As usual, it’s
easy to install and configure.

As soon as you install it, you can select the
age of the child who uses the computer, and
select what subjects you want to block. Pornog-
raphy, adult subjects, and any categories you
define are blocked by default. You have to
update the We-Blocker data after installation to
get the latest list of blocked sites.

The software does not offer e-mail notifica-
tion, but does keep logs that you can check. 
It offers password protection, but does not 
offer Task Manager disabling. But when I 
End-Tasked it using the Task Manager, it

If anything, Parental Filter offers you
a little too much control! It’s an
excellent option—especially because
it’s completely free

Optenet Web Filter has a browser-based interface that’s very different
from the others—not better, just different. It offers port blocking and
can disable P2P applications and Instant Messengers
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promptly started up again, so there’s a decent
level of security here.

That’s where the security stops, however!
After the installation, I found that it was only
working with IE and not with Firefox and Opera.
I rebooted the computer, and then found that it
started blocking access in Opera, but still noth-
ing in Firefox.

I soon found that this was because the appli-
cation acts as a local proxy server, and you have
to set the appropriate settings in the browsers.
However, this means that if your child knows
anything about proxy servers, or even stumbles
upon the settings, disabling the proxy server is
as good as the software not being installed! This
is unforgivable, but we cannot complain
because you’re not being charged to use this
software. It blocked content pretty well, but was
easily fooled with
Google Image searches
and Internet slang.

Overall, this soft-
ware is strictly for
parents who don’t want
to spend money on soft-
ware and have pre-teens
who are just starting to
use the Internet. Even
then, Parental Filter is
free as well, and better,
so there’s really no
sense in downloading
and installing We-
Blocker 2.0!

Summing It Up
All the software here are good or bad in
different respects. There’s no perfect software
out there yet, and absolutely all of these
were very, very disappointing in terms of
analysing images.

CYBERsitter did the best in terms of filter-
ing images, by forcing safe searches and seem-
ingly checking ALT tags—according to the logs
anyway. Also, I liked the way it just stops you
from viewing a site without announcing its
presence to your kids—many of whom will
promptly search Google for ways to bypass
software that’s stopping them! I would recom-
mend this as the software to buy if you want
to protect your kids.

Parental Filter is very good, and in order 
to be secure, all you need to do is create a 
low-level access account for your kids so that
they cannot install Firefox to bypass the 
software and use IE as the default browser.
Since it doesn’t cost you a rupee, and is 
almost as good as CYBERsitter, everyone who
doesn’t want to spend or cannot afford 
CYBERsitter should install this very useful
software. Just make sure you choose to display
the icon on your Taskbar before you choose to
install it as a Windows Service. And do not
select the “Don’t show password dialog. Invis-
ible login” option unless you know what
you’re doing!

Apart from these two, another good choice
is CyberPatrol, which came in third! 

agent001@thinkdigit.com
We-Blocker does not offer Task Manager disabling, but if
you kill the process it just restarts! Bad blocking though

Scoreboard                             Content Filtering Software

Site
Features (Out of 20)
Blocking
URL Blocking
Image Blocking
Chat Filter
Reporting
E-mail reports
Logs
Security
Password Protection
Task Manager Removal
Overall Security
Other Browser Support
Firefox
Opera
License
Ease Of Use (Out of 10)
Download Size
Setup
Configuration
Performance (Out of 50)
Normal Setting
Sites Blocked (Out of 5)
Images Blocked (Out of 5)
Words Blocked (Out of 5)
Paranoid Setting
Sites Blocked (Out of 5)
Images Blocked (Out of 5)
Words Blocked (Out of 5)
Price (Out of 20)

Overall Score (out of 100)

Cyber Patrol

www.cyberpatrol.com

12.2

✔

✖

✔

✖

✔

✔

✖

2

✔

✔

14
6.42
12
4
4
28

5
0
4

5
0
4
7.51

54.13

CYBERsitter 9.0

www.cybersitter.com

16

✔

✖

✖

✔

✔

✔-Paid  version only
✔-Paid  version only
5

✔

✔

10
8.12
2.36
4
4
44

5
4
4

5
4
4
7.51

75.63

iProtectYou Web
Filter v7.10
www.softforyou.com

13.2

✔

✖

✔

✔

✔

✔

✖

2

✔

✔

14
7.95
2.57
4
4
24

4
0
4

NA
NA
NA
8.58

53.73

Net Nanny

www.netnanny.com

11

✔

✖

✖

✖

✔

✔

✖

3

✔

✖

15
6.22
22.8
4
4
18

3
0
3

5
5
5
7.51

42.73

Optenet Web
Filter
www.optenet.com

11.8

✔

✖

✖

✖

✔

✔

✖

3

✔

✔

15
6.28
17.7
4
4
18

3
0
3

NA
NA
NA
7.69

43.77

Parental 
Filter 0.24
www.ecommsec.com

12.4

✔

✖

✖

✖

✖

✔

✔

4

✔

✔

Free
6.65
3.03
4
3
24

4
0
4

NA
NA
NA
20.00

63.05

We-Blocker 2.0

www.we-blocker.com

10.6

✔

✖

✖

✖

✔

✔

✖

3

✖

✔

Free
8.07
2.41
4
4
16

4
0
0

4
0
0
20.00

54.67

ContentProtect

www.contenwatch.com

11.2

✔

✖

✖

✔

✔

✔

✖

2

✔

✔

14
6.97
5.15
4
4
26

5
0
3

NA
NA
NA
7.50

51.67

Child Control 2006

www.salfeld.com

14.4

✔

✖

✖

✔

✔

✔

✔

4

✔

✔

30
6.96
5.23
4
4
24

4
0
4

5
0
5
10.03

55.39
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Ahmed Shaikh

Sony’s monster brand of PlayStation has been
dominating the console scene ever since its
inception. The first of that console’s line

usurped the crown from Nintendo and has been
unstoppable ever since—selling more than 100
million hardware units and up to a billion soft-
ware units. Lately, Sony has been positioning the
PLayStation 3 as a unit to replace the computer—
with Linux on its 20 GB or 60 GB hard drive,
keyboard support, a Web browser and HD reso-
lution out of the box (up to 1920 × 1080), “the PC
is no longer needed”, Sony points. With a 100
million hardware base, the PS3 is thus a very real
threat to the Microsoft domination of the PC
market. Microsoft, of course saw this coming a
mile away, more precisely, around the year 2000
when it took its first steps into the console busi-
ness. 2000 is when Microsoft approached
Gigapixel; getting the ball rolling on what would
be the Xbox brand.

Both Sony and Microsoft would like their
products to sit next to your television—serving
all manner of content from games, to music and
movie downloads. The potential market is huge,
the money pot at the end of this rainbow, astro-
nomical. While the business of consoles is
intriguing, this article will take a look at
what’s inside one of the two, so-called,
“next-generation” offerings-Microsoft’s
Xbox 360. 

The architecture of the Xbox 360 is unique in
many aspects but hardware alone does not make
a system. Some would say that the Xbox 360’s
unique strength lies with its LIVE component—
an online matchmaking service, a marketplace, a
gaming playground, all rolled into one—LIVE is
what makes the 360. We will thus a brief look at
both these aspects of the console-the
hardware and the software.

Sins Of The Father
Back when Microsoft was kicking around the
concept of the first Xbox, the team in-charge of
bringing the console to fruition did not have the
luxury of time—they were already launching
after the PlayStation 2 and they needed to get
the product out at once or lose market traction.
Due to this, the Xbox was practically made up of
off-the-shelf computer parts: a slightly modified
Intel processor, some memory, a
Seagate hard drive, a slightly
modified NVIDIA video
chipset, thrown together
in a huge, ugly cabinet.
It wasn’t the prettiest
of engineering but
it got the job
done: the Xbox
sold around

A 360 degree
view on
Microsoft’s
second gaming
console
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thing that increases processor and
power efficiency as well as paral-
lelising disparate tasks across the
processor cores. 

Traditionally, cache is meant to
act as a holding unit for frequently
used data, such that the processor
need not travel all the way to the
system’s main memory to fetch
and process information which is
often used. Under the Xenon
however, the 1 MB of L2 cache plays
a much more interesting and flex-
ible role: it is possible to use the

cache in the traditional sense but it can also be
shared between the processor and the graphics
chip of the Xbox 360. This is a very unique archi-
tecture which allows a programmer to push
content from the L2 cache to the GPU, much like
a FIFO queue (First In, First Out). The L2 can thus
be used as a temporary storage for the GPU.

Before we head further into the 360’s core,
let’s take a look at one of the new “schools of
thought” which we alluded to earlier in this
piece. If you have followed Will Wright’s upcom-
ing PC game called Spore, you are probably aware
of the concept of procedural content. The idea is
simple: free the artists from producing high-reso-
lution art assets and content, and utilise hard-
ware and software to churn out the same. A
typical game is bound to contain repeated
content-in a title such as Grand Theft Auto III, for
example, you will see trees, lampposts, fire
hydrants, trash bins and so on, being used
throughout the game. Presently, a game uses the
same model and texture for each of these
common objects and repeats them throughout
the title. The result is a bland, uniform look to a
game, which reduces the immersion. 

Procedural creation of content would take a
template of an object, run it through a processor
and churn out a finished product in real-time.
Traditionally, a game developer would have to
hire a team of artists to produce say, trees, then
put them on disk, feed them to the computer
memory and then put them out to the graphics
chip for rendering. With a procedural approach,
the developer would only need to define the tree
mathematically and ship this information on
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24 million units by the end of its life, running
second to Sony’s behemoth and overtaking
Nintendo’s Gamecube by a small, but significant
margin. Mission accomplished, the Xbox brand
was etched into the psyche of console gamers,
rap artists, and PC gamers tired of the upgrade-
and-patch dance of PC games.

Almost immediately after releasing the Xbox,
Microsoft got to work on its successor. The almost
four years of head-start that the 360 would thus
get, was instrumental in the design that the Xbox
360 now sports-inside and out. It also allowed
Microsoft to correct a major drawback that the
original of the species had: Microsoft did not own
the IP to any of the Xbox’s internals—Intel owned
the processor, NIVIDIA the graphics chip. Microsoft
thus had to rely on two third-parties to supply
essential elements of the console, and was depend-
ent on their whims and manufacturing capabili-
ties to cut prices or throttle production as needed.
With the Xbox 360, Microsoft owns both the
processor and the graphics chip, and has the flex-
ibility to set up fabrication plants, drop prices, and
shrink processors as and when needed.

Original Of The Species
The Xbox 360 is unique in several aspects. The
most benign of which is that the 360 is the only
console to simultaneously launch
across the three major gam-
ing markets of USA, Europe
and Japan. More interesting
is the unit’s hardware
design. It seems to do a fine
job at balancing raw power,
flexibility and ease-of-use. It
is also the potential proving
ground for some new school
of thought, schools rather—be
it unified memory architecture,
procedural rendering or unified
shader architecture. The 360 is also
the first gaming console which pays attention
to its software user interface. It is a far cry from
the ugly brick which was its predecessor—the
unit has a pleasant white exterior, a concave
body, a chrome DVD tray, and the ring of light—
a circle of LEDs which indicate wireless con-
troller and unit status.

Let us begin this dissection from within,
from the core of what makes the 360 so unique.

A Procedural World
Microsoft approached once-rival IBM to design
the processor of the Xbox 360. The resulting
processor is a three core unit for which IBM bor-
rowed design ideas from the Broadband
Processor Architecture (BPA) that produced the
PlayStation 3’s Cell processor. The 360’s proces-
sor, codenamed Xenon consists of three identi-
cal cores to one side, each with 64 KB of L1 cache
(32K for data and 32K for instructions) and a
large 1 MB of L2 cache which is shared by all
three cores, on the other side. Each of the cores
has two hardware threads for simultaneous
multithreading (SMT); the entire processor can
thus process a total of six hardware threads
simultaneously. This multithreaded approach is
vital to keeping the parts constantly fed—some-

The sleek looking Xbox360

The cool new Xbox
controller

The Xenon processor is a three core unit
designed by IBM
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disk. The Xbox 360 would then read this mathe-
matical template, send it to its processor where
one of its six hardware threads would process and
produce the required vertices of the tree, based
on the mathematical template. These vertices
would then be fed to the GPU for rendering and
output-greatly reducing art content, developer
costs, and even bandwidth requirement.

Such a procedural approach is not limited to
geometry. It can also be used for animating game
objects: specifically, the game developer need only
define key frames for an animation, letting the
Xenon generate the transition frames for complet-
ing the animation. The processor can also be fed
key differences between two frames—for example,
only certain parts of an object might change
between two consecutive frames, the processor
can be fed only the difference frames greatly
reducing the content requirement and alleviat-
ing bandwidth needs to push the content. 

Finally, the Xenon can tessellate an object: A
3D object within a game is represented via
vertices and polygons. What might be a smooth
soccer ball in real life is composed of a collection
of triangles within a game—the smoother you
want the ball to look, the greater the number of
vertices needed. It takes more data to represent
an object as a collection of triangles, than it does
to represent it as a bunch of smooth curves. Tessel-
lation is the process of breaking up a curve into a
bunch of representative triangles. The Xenon can
perform tessellation in hardware, thus signifi-
cantly accelerating the process. A game can thus
ship with curve information on an object, and
take less space; the Xenon can subsequently use
that information to generate the final object. This
real-time tessellation can also be used for dynam-
ically throttling the level of detail on an object:
take the soccer ball as an example—when viewed
from a distance, the number of polygons which
comprise the ball can be reduced, as you approach
the ball, the polygons can be automatically
increased to give the ball a smoother look.

Currently, not a lot of titles use the proce-
dural tools afforded by the Xenon’s architecture.
The RPG title Oblivion is perhaps the only one to
use the trick to some effect. It employs a third
party tool termed SpeedTree which procedurally
generates the trees and the foliage which popu-
late Oblivion’s vast landscape. But even Oblivion
does not use it in real-time. Perhaps as time goes
on, more titles will employ the idea.
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A Unified Approach
Microsoft decided to award ATI the contract for
the Xbox 360’s graphics processing unit (GPU).
ATI is thus making the graphics part for two
consoles this generation—the C1 or Xenos for
Microsoft’s Xbox 360 and the “Hollywood” chip
for the Nintendo console, called Wii (pro-
nounced “We”).

Xenos, much like its neighbour Xenon, is a
unique chip in many aspects.

On the PC, a graphics card divides its real-
estate between vertex shaders and pixel shaders-
hardware units which act on vertices of a 3D
object and on individual pixels, respectively.
This traditional architecture has its limitations.
In a given game scene, it is never clear how
much the vertex shader or the pixel shade
would be employed, although current titles tend
to lean heavily on the pixel parts. Thus, effi-
ciency comes to question: a scenario in which a
pixel pipeline is waiting for the vertex shaders
to finish, or vice-versa is quite common. This
leads to idle-time, wherein either of the two
shader units is in essence twiddling its thumbs,
waiting for the other to finish. This is a waste of
power, not to mention of the transistors which
comprise the idling unit.

A workaround is proposed via the 360’s GPU
in the form of unified shader architecture. Here,
instead of specific shader units for each type of
data, the GPU employs transistors which can
handle both manner of tasks-pixel and vertex.
Balancing and juggling a game’s scene becomes
much easier: for a game scene employing lots of
special effects, the processor can put more
shaders for pixel work and less on constructing
the geometry of the scene, and so on.

A unified approach to shaders is very much
on the cards for the PC space as well.

A shader is essentially a vector unit, much
like the SIMD (pronounced “simdy”) units of a
PC processor. As such, shaders can carry out
mathematically intense tasks not just restricted
to graphics. The in-thing nowadays is physics
acceleration on a chip. We currently have two
distinct proposals for such a tactic—a dedicated
physics processor sitting on a PCI bus, or employ-
ing a GPU to perform physics acceleration.
Indeed, ATI has also proposed use of its GPU to
handle audio tasks. All of this is also doable on
the Xenos. Furthermore, the ATI part can also
push and pull content to the shared 512 MB of
memory. This allows the unit to work on data,
push the result to memory and pull it back to
another shader unit for additional processing
and physics tasks. The GPU’s unified approach
to shaders, the multithreaded architecture of
the 360’s processor and the fact that both the
CPU and the GPU share the 1 MB of L2 cache and
the 512MB of system memory, all add to produce
an extremely flexible architecture: the Xbox 360
can load balance—on its six hardware threads
and its 48 shader units-tasks pertaining to
procedural synthesis, pixel shading, vertex shad-
ing, physics, AI, and animation. 

Such flexibility and interconnectedness keeps
the entire system busy and increases its efficiency.

Apart from the unified shaders, the GPU also
employs a very unique tool-embedded memory.Oblivion showcases procedurally generated trees and foliage
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The Xenos part from ATI comprises of two cores,
the traditional unit where the shaders lie and a
daughter core, which is the smaller of the two
and is comprised of 10MB of
embedded high-speed memory
along with some processing
hardware. To understand this
engineering feat we need to take
a short detour and visit two
places-one is the concept of
embedding itself: in broad terms
the shorter the path between a
processing unit and any form of
memory, the better it is for the
system. Hence, you currently
have 1 MB and 2 MB worth of L2
cache for processors even though
the system itself might offer as
much as 4 GB of memory. Embed-
ding things is generally a good
idea, thus. The second stop is the
fast-approaching HDTV, and the whole HD-
era/revolution/better-than-sliced-bread thing.

High-definition content is said to start at
720p resolution (1280x720, progressive or non-
interlaced scan). 720p is incidentally the resolu-
tion that the Xbox 360 is happiest displaying at.
The Xbox 360 requires the 10 MB of embedded
memory to work on frame buffers at HDTV reso-
lution. Think of a frame buffer as a canvas to
paint on—the final image shot to the television
screen, will come from this buffer. The 10 MB of
eDRAM (embedded DRAM) is capable of storing
up to a 4X anti-aliased image at 640x480 or a
1280x720 frame (720p) without anti-aliasing
applied. This math applies to a single large
frame, or canvas. The Xenos cuts up the frame
into so-called tiles and instead of working on one
very large canvas, it divides the final output into
more manageable chunks. Each of these tiles can
now easily fit into the 10 MB of eDRAM, even
with 4X FSAA (full-screen anti-aliasing). Basically,
your games will look pretty.

Playing It LIVE
The Xbox 360 builds on the success it enjoyed
with the LIVE initiative of its predecessor. LIVE,
in essence, is a whole bunch of services rolled
into a uniform package. As a match-making
service it offers each owner of the console a
unique identity-based on his or her username
of choice, and a display picture. This
“Gamertag” displays a player’s “Gamerscore”,
tracks all the games played, his or her reputa-
tion based on peer-feedback, and acts as an
identifier to online friends. LIVE also collates a
list of your online friends and messages from
friends or challengers. You can also link your
Gamertag to forum avatars, track your mes-
sages from a PC, send invites to a game via a
computer while away from the console, and so
on. In addition to text, LIVE also offers voice-
chat during a gaming session.

This communication layer is just one aspect
of the LIVE package. The system also offers the
Xbox Live Marketplace which offers casual and
arcade games (Xbox Live Arcade) for trial down-
loads and online purchases. You can also pay for
additional content packs from game developers-

these can take the form of wallpapers for the 360’s
interface, or themes, or icons for your Gamertag,
and so on. The Marketplace also offers free
content in the form of game trailers and game
demos. It is fairly common to find a demo of an
upcoming title to try out; we PC gamers might
not consider these features too revolutionary but
it is certainly a great addition to console gaming. 

This diverse range of content is presented
via a pleasant interface comprised of “blades”.
Each blade is in essence a tab, which leads to a
different menu:

Xbox Live/Marketplace - Connects the user to
Xbox Live. It also offers management options for
the player’s list of friends, messages, and Market-
place transactions.

Games - Keeps track of played games and
earned achievements. Also allows access to Xbox
Live Arcade and downloaded game trailers and
demos.

Media - This is where one can manage media
content and use the Media Extender functional-
ity of the Xbox 360.

System - Changes to the system, privacy, and
security console settings are found here.

A shaky start
The Xbox 360, at least on paper, does a com-
mendable job of balancing sundry tasks and
offers a compelling gaming platform. Marry
that to a collection of development tools
which are perhaps the most mature and easy

to get into in the
console space, and
one can imagine
the 360 doing
much better than
its predecessor
this time around. 

One of the
main goals of
Microsoft this
round was to
launch early and
amass sufficient
user base to
compete effectively
when the PlaySta-

tion 3 launches late this year. At
this, the console has been largely
unsuccessful. Production problems
during the holiday season of 2005
curbed the units sold to a huge
extent. Moreover, its performance in
Japan is actually worse than its
predecessor’s already dismal show-
ing. To date, Xbox 360 has shipped
close to three million units world-
wide and plans to sell around 10

million before the PS3 ships. Right now, it
seems a difficult goal to achieve. Sony mean-
while, plans to ship a total of six million PS3
units by March of 2007. Some would call Sony’s
projection just as optimistic. While it remains
to be seen which of the two consoles will win
this round, one thing is certain-we consumers
have never had it better-between these two and
Nintendo’s Wii, everybody wins. 

readersletters@jasubhai.com

Seen here, the Xenos sitting next to its
daughter eDRAM

The Xbox 360 can display a unified blade during gameplay.
This blade allows one to send messages, check your score and
play custom music

The Marketplace offers
both free and paid content
to Live users



Digital Passion l Tomorrow

Robert Sovereign-Smith

So many of us have already spent years, in
terms of man-hours, sitting in front of a
computer, clickity-clacking away at the

keyboard, clicking a mouse and damaging
tissue in our collective quest to develop the
geek’s disease—Carpal Tunnel Syndrome.

Think of how much the world of IT has
changed: phones have gone from big bulky
things that sat on your desk and weighed as
much as a bowling ball to tiny little gadgets
that fit into the pockets of a pair of skin-tight
jeans; CPUs have gone from glorified calcula-
tors to teraflop-measured powerhouses; RAM
and hard drives have gone from being meas-
ured in MBs to GBs today—not to mention
having become several orders of magnitudes
faster. Yet, sadly, the way we interface with our
computers has remained unchanged…

The Mouse And Keyboard
This writer is plodding away at his keyboard writ-
ing this, and all of you do the same while using
your computers. If you’re not a keyboard warrior,
you’re most definitely a mouse wrestler. Ever
since the GUI (graphical use interface) first

appeared, the mouse and keyboard have been a
staple of our digital diets.

Sure, the mice and keyboards being made
today are anything but ordinary (see box Devices
Of Desire), but the fact of the matter is that this is
just design, and not anything groundbreaking.

Other Controllers
The first major shift in input devices was
brought about by gaming—so many of us grew
up playing games on our Atari and Nintendo
gaming systems. Next we saw joysticks being
connected to computers; then there were the
wheel controllers for car racing games.

However, we’ve seen gaming branch off into
the direction of consoles, and they seem to have
taken the controllers with them: who really
uses a joystick or wheel on a PC anyway? It’s so
much simpler—not to forget cheaper—to just
use the default interface devices, the trusty
keyboard and mouse, for gaming.

Perhaps the truth is that we just haven’t
found anything better than these relics of tech-
nology to control our PCs. Well, hopefully,
that’s about to change. Perhaps not as soon as
we might wish, but it’ll change nonetheless.

Amidst all the hype over all the other thou-
sands of new technologies and inventions that

If only we could
actually do that
with computers!

Act Naturally

Illustration Chaitanya Surpur
3D Modelling Vikram Kathare
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keep popping up, there’s hope for those of us
who want to be able to sit back instead of
hunching over our keyboards and reaching out
for that oddly-placed mouse!

From all the news and prototypes we’ve come
across, at least a few revolve around changing
the way we interface with PCs. The research
points in four basic directions: better touch-
based devices (as in new designs for glorified
keyboards and mice), speech control, eye control,
and even thought control. Basically, we’re look-
ing for computers to develop the senses we have—
touch (they already feel us typing and clicking),
hearing (speech control), vision (eye control), and
extra-sensory perception in terms of thought
control. Smell and taste we might not want them
to develop—the last thing you need is your PC
telling you that you smell, or chomping down on
your finger if it gets hungry!

Listen To Me
Speech recognition has been around for quite
some time now, but isn’t really going anywhere
far. We’ve reached a point where computers can
understand us when we talk—at least as far as
understanding commands goes—but that’s
provided you talk in an expressionless mono-
tone, and are prepared to spend hours training
the software. And don’t forget that you always
have to keep shushing people because the mic
cannot tolerate background noise.

The shortcomings of speech-to-text are well
documented, and we don’t need to focus on it
here. All we can hope for is adaptive or intelli-
gent software that will be able to understand
what we say, regardless of whether we have a
cold, are breathless, or are talking to our PDAs
in noisy railway stations!

Watch Me
The more interesting alternative input devices
being researched are the visual-aided ones. Eye-
control or gesture control devices use a camera
to interface with customised software, and
translate your motion into mouse control.

Interestingly, this was first thought of to
help the physically disabled interface with PCs.
However, as technology progresses, and as we
all become a little disabled in our own way
(basically, lazy!), such input techniques might
come as a boon to us all.

Most devices actually track deviations in
your eyes or the entire head. Some of these
setups let you left-click with a wink of your left
eye and right-click with your right eye; double-
clicking is taken care of by rapid blinking. The

problem with such devices is that you’re gener-
ally confined to your chair and cannot move
your head more than a few inches to the left or
right. This is because the camera needs to focus
on your face or head. Now, for the physically
handicapped, such restrictive devices make
perfect sense, but not for the majority.

Take TrackIR 4 Pro (www.eyecontrol.com)
for instance, a head-control system by Natural-
Point Inc. This system consists of a little head-
piece with three reflective surfaces, and which
can be attached to almost any headwear, such
as a baseball cap. It has a sensor system that,
with the help of software, tracks the way your
head moves and translates it to movements in
games. So instead of moving your mouse to look
left, you can just look left!

“But doesn’t that mean looking away from
the monitor?” is the question everyone asks.
The answer is simple: sensitivity! You can set
the software to be less or more sensitive to your
movements, so moving your head left by a
degree could change your view in the game by,
say, 10 degrees.

What’s more, TrackIR 4 Pro looks for move-
ments along all three axes, and also tracks
movements in the form of pitching, yawing,
and rolling. This is ideal for, say, a game like
Microsoft’s Flight Simulator.

Reviewers from around the world claim that
this form of control is very easy to get used to,
and that it shouldn’t take you more than an
hour to be in complete control!

Now if the TrackIR system is built specifi-
cally for gaming, there are other products built
for regular computer use. An example is Quick
Glance from www.iriscom.org, which is specif-
ically targeted at people unable to use a mouse
and keyboard. It’s a completely custom-built
solution that comes with training, so not too
much detail can be provided here. However, it
does use eye-tracking to move a pointer, which
can click on a particular area either by just leav-
ing it over an icon for a short while (by staring
at the icon), or by blinking slowly. As you can
expect, the system comprises software and a
camera that can be mounted on your desktop or
laptop monitor.

The typical wireless keyboard and mouse, which are the
norm today

TrackIR 4 Pro translates head movements into mouse
movements on your screen

Photograph Amrut Patki
Imaging Chaitanya Surpur
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It’s clear that enough inroads have been
made in this field to already have viable prod-
ucts. As for “tomorrow,” things can only get
better and more accurate!

Read My Mind
Wouldn’t it be great if PCs could read your
mind? Well, they can! Back in March 2005,
Wired Magazine (www.wired.com) wrote an
article about Matthew Nagle, a victim of a
violent crime that left him with a severed
spine—a quadriplegic for life. Nagle, thanks to
some innovative technology research, was able
to regain a little control of his life. After his
doctor suggested that he join a clinical test
being conducted by Cyberkinetics
Neurotechnology Systems (www.cyberkinetic-
sinc.com), Nagle received a brain implant.
After intensive training, Nagle can now turn
his TV set on and off, raise the volume, and
change channels. He can also interface with
his computer and play Pong, draw basic shapes,
and more.

The chip in his brain connects to software in
his PC or home appliances, and Matthew “wills”
them to work by thinking about what he wants to
do. Thanks to Cyberkinetics Neurotechnology
Systems’ BrainGate Neural Interface System,
Nagle has hope. Though the clinical trials are
only open to people suffering from similar condi-

tions as Nagle, the technology works! We now
know that thought control is actually possible,
and research will get us there soon enough!

A Brain Computer Interface was recently
showcased, at CeBIT 2006. It allowed two people
to put on some strange-looking headgear and
then play Pong—perhaps one of the simplest
games ever made. Yes, the headgear is funny,
and the sheer number of wires emanating from
it are likely to have people cracking “Please
don’t hurt me, I’ll take you to my leader!” jokes.
But the fact is, we haven’t reached the stage of
aesthetics yet. When (with emphasis on the
word when) such technologies are perfected, we
can start worrying about aesthetic appeal; for
now, we’re just happy that it works.

There are many research projects working on
this new way of interfacing with computers, and
that’s heartening for those of us who are fed up
of keyboards and mice! Here’s Wikipedia’s entry
for Brain-Computer interface, which should help
you find more interesting news about this excit-
ing technology change: http://en.wikipedia.org/
wiki/Brain-computer_interface.

We Don’t Want Silly Hats
Well, we don’t! We don’t want to have to sit
stationary in front of our computers either, as
is required by head or eye tracking systems. The
same holds true for the gloves and other devices
that connect to limbs and allow you to control
motion. Most of us would not be willing to
undergo surgery for implants either, for fear of
short-circuiting our brains! So what do we do?

As the research, prototypes and products
mentioned here already suggest, researchers
are already looking for a non-intrusive, mini-
mal-fuss interface that will only limit you as
much as a mouse and keyboard do. 

What Happens Tomorrow?
In the near future—five years or less—we hope to
be able to see a coming together of all these tech-
nologies and methods of interfacing. This is the
only way in which a truly complete solution
might emerge.

Think about it: thought control will never be
perfect, because human brains are unique
enough to cause anomalies in the way the soft-
ware registers thought patterns. What is
“Minimise” for me might be “Close” for you and
so on. What can help iron out the creases are
speech and motion detection software. If you
think “Minimise,” and the PC is confused about
whether you meant “Minimise” or “Close,” it can
use the eye tracking camera and software to
figure out which button you were looking at. Or
perhaps it can use a little AI to understand that
your body language does not suggest that you’re
done with the window in front of you, and there-
fore would not want to close it.

If someone could integrate speech recogni-
tion (or natural language processing, prefer-
ably), motion detection, thought control and a
little bit of AI, we might finally be rid of our
traditional, boring input devices. Until that day,
nothing is going to dethrone them—old habits
die hard! 

robert_smith@thinkdigit.com
The cap looks silly, but typing with your brain is cool! Here’s another Brain Computer
Interface under development at the Laboratory of Computational Engineering in Finland

Iriscom’s Quick Glance 2 follows your eyes and clicks on
icons when you blink slowly
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The Plot
At the alarmingly young age of 18, Vineet
Kumar from Ranchi is now managing director
and the face of NAG. His interest in cyber secu-
rity and hacking goes a long way back, and
during his activities in hacking groups online,
he met Rakesh Sharma (now 23), then a
student of computer engineering in
Rajasthan. Predictably enough, the two found
a common ground, and numerous—no doubt
healthy—conversations later, they decided to
form an organisation dedicated to protecting
Indian Web sites from malicious attack. They
would encourage and nurture budding hack-
ers, making them use their powers for good,
so to speak.

Enter Anup Girdhar, an independent secu-
rity consultant, who, during the course of a
seminar he was taking at IIT Delhi in 2004, was

The founders of the 2,000-strong National Anti-Hack Group, and why they
would rather guard what they could so easily destroy

Nimish Chandiramani

“Is your port 80 wide open?” the Web site
ominously asks. In these paranoid
times where wars are fought in cyber-

space and anybody could be a victim, who will
stand against the forces of e-vil? Who will
protect you from the malicious being that is
the hacker? And when will we stop with these
corny clichés?

There’s probably no answer to the last
question, but in 2003, two young men sat up
and decided to be the answer to the others. In
the face of increasing attacks on Indian Web
sites, Vineet Kumar and Rakesh Sharma
decided to form a community of ethical hack-
ers (or White Hats, as they now call them-
selves) to secure the country from cyber
attacks—the National Anti-Hack Group (NAG).
Both are highly skilled hackers, and they do it
because “only hackers can prevent hack
attacks,” as they say.

Illustration Chaitanya Surpur
3D Modelling Vikram Kathare

The Protectors
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approached by two earnest young men with an
offer he couldn’t refuse. He was sold on the
idea of this budding community called NAG,
and promptly agreed to join the group and
lend his guidance to its members. 

The Why And How
“I had taken a computer course in my 10th,”
says Rakesh, “and was hooked ever since.
When I started making my own Web sites, I
began to take an interest in how these sites
could be exploited, and started learning all
I could.”

Vineet, on the other hand, got his inspira-
tion from his father, who is himself an accom-
plished programmer.

Power corrupts, and the idea of being able
to wreak havoc on the Internet is one that
inspires evil laughs and sinister rubbing of
hands. So what kept the devil at bay? “I come
from a defence background, so the desire to
protect my country was natural. My aim was to
help India recover its hijacked sites.” And
when Ankit Fadia, renowned White Hat, is one
of your best friends, your goal becomes a good
bit easier to achieve.

How does one go about acquiring such
“1337 sk1llz,” then? For Rakesh, it’s “mostly
through friends, books and participating in
online hacking groups and forums.”

Trivia Interval: Colourful Hats
You’ve probably wondered at our repeated
mention of the term “White Hat.” It comes
from American Westerns, where the good guys
would typically sport a white cowboy hat and
the bad guys preferred black. So in the mean,
lawless world of cyberspace, the White Hat is
the force of good, the protector of the weak,
the saviour of… you get the point. Then there’s
the Grey Hat, who conveniently sits the fence—
carrying out activities that nudge the legal
boundaries ever so slightly, but doing so for a
good cause such as catching a criminal.

The Cast
When he was just 14, Vineet became one of the
world’s youngest Microsoft Certified Profes-
sionals. He has since obtained an embarrass-
ingly large number of certifications—ranging
from Microsoft Certified Database Adminis-
trator to Novell Certified Linux Professional.
As the MD of NAG, he handles most of
its administration.

Rakesh Sharma now works as a security
engineer for a software firm in Bangalore. He
often simulates malicious attacks on networks
to test them. One of his pet peeves is the nega-
tive connotation that his “hacker” tag carries.
“People don’t realise the true definition of
hacking,” he says, “A hacker is just anyone who
tinkers with hardware or software to see what
it’s capable of.”

Acting as a mentor to NAG is Anup Gird-
har, a security consultant based in New Delhi.
Anup has nearly 14 years of experience in the
field. He taught Vineet all he knows, and
regularly conducts seminars on security
and hacking.

The Result
Today, NAG boasts of more than 2,500 members
from all over the world, ranging in skill from
your average newbie to some ultra-scary virus
creators and reverse-engineering experts. They
work as a security consultancy, advising even
government sites on how to stay secure.

“We aim to create ethical hackers so that
they can act as early warning system for the
nation’s information infrastructure,” says
Vineet: “We guide them in learning network
security and ethical hacking and certify their
hacking skills.” A large number of NAG’s
members are in their teens and early twenties:
at 29, Anup is the second-oldest! 

When not grooming the hackers of the
future, the NAG team helps the Government by
scanning their Web sites for vulnerabilities and
advises them on security—completely free of
charge. They are also affiliated with the Indian
Computer Emergency Response Team
(www.cert-in.org.in), a wing of the Ministry of
Information Technology in the effort to secure
India’s sites. 

If you want to learn from the experts, you
can attend one of the many seminars and train-
ing sessions that they hold all over the country.
Their security forum, Igniteds, is a hotbed of
activity at all times, with members from all
over the world discussing new and crazy hacks—
from fun methods to take revenge on spammers
to reverse-engineering viruses and Trojans. 

The NAG Web site: www.nag.co.in
The Igniteds Security Forum Web site:
www.igniteds.net

The Clichéd Road Ahead
“Right now, we’re working on our project
Abhedya—an open source effort to build the
most powerful security solution in the world,”
says Vineet. “Anyone can join NAG and
contribute to it. We are also getting ourselves
registered as an NGO.” (Which will probably
have happened by the time you read this.) 

So if you’d like to do your bit for the secu-
rity of the Internet—or if you’re just curious to
see how it works—hop away to NAG’s Web site
and begin your training. Just remember—most
members have the ability to make your PC
beg for mercy, so don’t do anything to tick
them off. 

nimish_chandiramani@thinkdigit.com

From left To right: Anup Girdhar, Rakesh Sharma, Vineet Kumar
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Here’s how to delete the Recycle Bin from the
Desktop and remove Shared Documents from
Windows Explorer. Before making changes to
your Registry, we strongly recommend you
back it up.

Disclaimer: Digit is not responsible for any
damage you may cause to your system as a result
of following the steps described below.

Method 1: Open the Registry Editor. Navigate
to HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows\CurrentVersion\Explo
rer\Desktop\NameSpace. Click on Edit, and
then on Find. Search for {645ff040-5081-
101b-9f08-00aa002f954e}. Delete it. Exit the
Registry Editor.

Wait for a moment. When you get back to
the Desktop, the Recycle Bin icon will have
disappeared. If you want to bring the Recycle
Bin icon back to the Desktop, follow these
steps: in the Registry Editor, navigate to
HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows\CurrentVersion\Explo
rer\Desktop\NameSpace. Right-click, then
click on New, select Key, and key in
“{645ff040-5081-101b-9f08-00aa002f954e}”
(without the quotes). Exit the Registry Editor.
The Recycle Bin icon will have been restored.

Method 2: Here’s another method to remove
the Recycle Bin from the Desktop: open the

Group Policy Editor by going to Start > Run >
“gpedit.msc”. Navigate to User Configuration
> Administrative  Templates > Desktop. In
the right pane, double-click “Remove Recycle
Bin icon from desktop” and select Enable.

To remove Shared Documents from
Windows Explorer

Method 1: Open the Registry Editor. Navigate
to HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows\CurrentVersion\Explor
er\MyComputer\NameSpace\DelegateFolde
rs\{59031a47-3f72-44a7-89c5-5595fe6b30ee}.
Right-click that key and delete it. Exit the
Registry Editor. Shared Documents will be
removed from Windows Explorer.

Method 2: As with the first problem, the
second method involves using the Group
Policy Editor. Open it and Navigate to User
Configuration > Administrative Templates >
Windows Components > Windows Explorer.
In the right pane, double-click “Remove Shared
Documents from My Computer”. Select Enable.
If you want to bring the Shared Documents
icon back to Windows explorer, in the Registry
Editor, navigate to

HKEY_LOCAL_MACHINE\Software\
Microsoft\Windows\CurrentVersion\Explore
r\MyComputer\NameSpace\DelegateFolders.
Right-click, click New, select Key, then key in
“{59031a47-3f72-44a7-89c5-5595fe6b30ee}”
(without the quotes). Exit the Registry Editor.
Shared Documents will be restored. 

THIS MONTH’S CHALLENGE

LAST MONTH’S CHALLENGE

Win!

Vijay Pahilwani
Bani Park

Jaipur

LAST MONTH’S WINNER

Has the “Windows File
Protection” message ever
bugged you? Figure a way
to bypass this message.

Send in your solution with
the subject “Take a Crack”,
and your postal address, to
takeacrack@thinkdigit.com

Delete the Recycle Bin from the Desktop and remove the
Shared Documents

DIGIT JULY 2006

Bypass Windows
File Protection in
Windows XP

Using the Group Policy Editor to achieve the same thing

Remove Shared Documents from My Computer using the
Group Policy Editor

A simple registry hack to get rid of the Recycle Bin!



So, excited about
your shiny new 
8 MegaPixel digital
camera? Here’s one
that makes it look
pretty silly

Imaging Sivalal S

Digital Passion | Geek Dreams
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Just how many pixels do you need to satisfy
your urge for bigger and clearer photos? 8, 10,

or 12? These numbers look minions before the
monstrous 39 MP Digital SLR from Hasselblad—
the H2D-39. The H2D-39 is the latest in the rich
lineage of consumer offerings from Hasselblad,
which is known for producing some
extraordinary cameras; their photography
solutions are used even by NASA! 

Almost everything about this camera's
specs leave you speechless. Its shutter speed
can be set to as low as a full 32 seconds. The
image sensor is more than double the size of
today's 35mm sensors! Images captured by the
H2D-39 are about 78 MB in RAW format, and
with lossless compression, 50 MB. The storage
medium can be an optional 80 GB external
hard disk, a CF-II card, or a PC or Mac
connected through a FireWire port. 

It is the intelligence of this camera, apart
from the brute megapixel numbers, that makes
it special. Along with image data, the H2D-39
captures an extended set of metadata to
perform automated correction for colour
aberration effects. This ensures that the
captures are optimised to provide the finest
detail that the lens can resolve. 

It's difficult to imagine what justifiable use
we can put a 39 MP camera to, but there sure is
a longing to
own one—if you
have $37,000
(approx Rs. 17
lakh) to spare,
that is!

Hasselblad H2D-39
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Day 1
Installation was a snap, and with a surprisingly smallfootprint of only 118 MB. My immediate concern waswhether functionality would be affected. I first started upThinkFree Office Write, the word processor. First surprise:the interface is nearly identical to that of Word! Somecompetitors try to make their office suites look different;ThinkFree have used a layout familiar to most of us, andI'm glad they didn't change the interface! Opened Calc,ThinkFree's spreadsheet package. 

Day 3
The first niggling shortcoming I came across today withThinkFree's Write is that there's no highlight tool—anabsolute shame! I did like the  Grow Font and Shrink Fontbuttons—definitely a plus.

Day 6
After the initial hiccups, I found both Write and Calc prettydecent on the productivity front—it's easy to navigatearound the menus, and MS Office users will hardly needany time to get used to ThinkFree Office. Everything is welllaid out. All the basic functionality is there, and at timesyou actually think you're using Word and Excel. 

Day 8
I navigate to the help menu—another surprise: a neat littlemenu laid out in the same order as the menu bar on top. SoI got headings such as File, Edit, and so on, meaning thatthe help file is organised according to the menu layout. 

Day 14
Needed to create a few slide shows for the good folk at theoffice, so I start up ThinkFree Show, the counterpart to

PowerPoint. A few quick clicks later,I'm done—it's very similar toPowerPoint.
By this point I have used ThinkFree Officeenough to compare it with a competing product,OpenOffice. ThinkFree is much lighter on features thanOpenOffice. Moreover, OpenOffice is free, while ThinkFreewill cost you. That being said, it's significantly lighter onsystem resources. 

Day 19
I discover that ThinkFree Write can export PDFs directlyinto Write, something the mighty MS Word cannot do. I'mpleased since I can type out a few mails in Write whilebrowsing the PDFs (also in Write). After some distractedtyping I finish an e-mail and give the spell-check tool a testrun. A bit of a pain, since the tool always goes to the firsterror I make. Word scores over Write here since it startscorrecting from your current cursor location.I had a quick stint with Calc to discover that hyperlinkscannot be created in a spreadsheet!

Day 23
I move on to Write and import an MS Word document thathad some tracked changes and comments. Instead ofopening the tracked document, Write opened a blank one!Checked this again, just to be sure: same result. 

Day 28
I'd be lying if I said I'm not impressed. It's a miniatureversion of Office, without some of the frills but also withouta few important functions. It still has a long way to gobefore getting anywhere near the functionality that MSOffice offers. 

michael_browne@thinkdigit.com

Michael Browne

“How'd you like to spend some quality time with a software package this
month?” my editor asks me. OK, cool, I think: a change! “It's an office

suite,” he continues. Change gone out of the window! Anyway, let's give it a whirl, I
thought. That's how I was introduced to ThinkFree Office 3. So I downloaded myself a
copy, and got down to installing it. You can use the trial version we gave in June ‘06 CD.

ThinkFree Office

Digital Passion l 30 Days With...

3D modeling Vikram Katare, Imaging Sivalal S 
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Ahmed Shaikh

Most current Web mail solutions
are a bit more relaxed on the
issue of attachment size, and

allow you to mail as much as 10 MB of
attachments, but what if you need to
send  a 500 MB video presentation for
a client? That's where services such as
YouSendIt come into play.

The service comes in various
flavours, the basic of which is the Lite
account—this allows you to send a file
up to 1 GB in size; the file can be down-
loaded 100 times, and is available
online for a period of one week. There
are three flavours apart from the Lite
account—these require you to pay any-
where between $5 (Rs 225) and $30
(Rs 1,350) per month. As you climb
higher on this scale, the number of
times the file can be downloaded
increases, for a maximum of 500
downloads. Finally, a paid
account allows you to send a file
as large as 2 GB in size. Inter-
estingly, the major difference
between the paid tier services
is the maximum number of
downloads per file; other ele-
ments such as maximum file
size (2 GB) and online life of the
file (14 days) remain constant.
If you routinely send across
large files, you can consider the
$5 per month YouSendIt Plus
account as the best value for money.

To send a file to someone, you
need his or her e-mail ID. YouSendIt
sends the recipient e-mail account a
link to your file, which can be clicked
for the transfer. The paid accounts also
keep track of which e-mail account has
downloaded your file and when. Let's
take a brief tour to setting up and
uploading a file through YouSendIt:

Sign Up
Head to www.yousendit.com
and click on the “Sign up for

free…” link to get started. Note that
you can also try the service out before

signing up. The trial will only allow you
to send a file to one recipient.

Take Your Pick
Choose between a Lite
account and a Plus account.

If you decide to opt for a paid service,
note that the site only accepts major
credit cards—it does not support
PayPal accounts.

The Final Touches
Signup requires the usual
personal information. Here,

we signed up for the Lite account,
which offers the minimal features of
keeping track of your sent items and
maintains a list of your contacts.
Note that the 100 recipients adver-
tised here basically implies that
your file can be downloaded 100
times—assuming each recipient
downloads once.

The service will now send an acti-
vation e-mail to the e-mail address
you specified during signup. You will
need to sign into your e-mail account

YouSendIt.com
and click on the activation link before
you can sign in to use the service.

Getting Around
Once you sign in, you will see
a list of folders to your left.

These are self-explanatory and keep
track of items sent and people you
have sent them to.

YouSendIt also offers a branded
service: you can pay to upload your
company's logo to a YouSendIt custom
page, sans ads. It's an attractive
offering if your business routinely
transfers large files across distances
and cannot afford the associated
bandwidth. Click on the Branding link
to the left to learn more.

Get Sending!
The rest is simple: add recip-
ients in the e-mail input box,

add a message if you wish to, pick the
file you wish to send to the recipient
and click on “Send it”. Note that you
can make a secure transfer by clicking
on the “Need secure…” link; however,
we aren't sure what this does, since
our browser didn't detect any encryp-
tion settings after clicking the link.

The Other Side
The recipient will receive a
mail notification containing

a link to your uploaded file. He or she
needs to click on this link to be able to
download the file. 

readersletters@jasubhai.com

Send files
as large as
1 GB over
the
Internet!
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92Shades 
of Colour

New &
Notable

More Power 
To You!

Net gain

Sign up at the front page

Choose your account type

Organise your data
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Imaging Pravin Warhokar
Photograph Jiten Gandhi

We bring you the lowdown on some of the latest inkjet
printers available in the market, without actually doing
a comparative shootout

Michael Browne

Shades 
of Colour

Canon’s entry level Pixma model, the IP 1200, was the little boy in
this group—nonetheless a printer that performs and is suitable for
the home segment. It prints photos fast, they come out decently

well, and the printer doesn’t cost much either. 

Looks And Features
The Pixma IP 1200 is sleek, with a forward-sloping wedge-shaped body. There’s
one readily apparent demerit: there’s no output tray at all! You’ll need to
keep the printer at least a foot away from the edge of the table, else all your
printouts will be on the floor. The outer body is rather flimsy, as are the
movable parts. Canon could have done a much better job here: the Epson
units we tested show how this can be done at a budget price.

Performance
Canon’s Pixma series feature some of the
fastest printers you’ll see. With timings of
two minutes and five seconds for printing
our combi-document, and just under four
minutes for the A4 photo, the IP 1200
leaves the competition chewing the dust,
speed-wise. 

In the pure text tests, the IP 1200 gave
poor results at the draft setting, with the
printed text looking slightly faded, and
with slight spiking (imperfections in lines
and curves) noticeable—but nowhere near as
pronounced as on the Epson models. At high settings, the print quality was
good, though upon magnification, a slight spiking around the edges of the
text was noticeable.

The combi-document was a little blurry at medium settings—notice-
able in the smaller font sizes—but this cleared up at high quality. The level
of detail for the fruit printout was acceptable, but some of the brighter
colours seemed to merge at times. The embed-
ded photo was sub-par at medium settings, and
even at high settings, the quality was just decent.

Our A4 test photo looked good with the
Pixma IP 1200: no lines whatsoever, good detail,
and the fine details of facial features weren’t
missed. The IP 1200 seemed to produce slightly
saturated images at default colour and tone
settings: the yellows, while vibrant, appeared too
bright, and this caused the skin tone to change a
little. The highlights and contrast were good.

Canon Pixma IP 1200

The Quick And The Cheap

Very fast
Good for photo
printouts, though some
colour adjustments are
needed
Doesn’t do too well at
text printing
Build quality leaves a 
lot to be desired

Price: Rs 3,495

Canon Pixma IP 1200
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A good photo printer
Very good for text
printing, especially at
high settings
Blazingly fast
Tawdry build quality
Offers very good value
for the performance it
delivers
Good buy for the home
user, all considered

Price: Rs 4,495

Aslightly higher-end look-alike of the IP
1200, this one offers much of the same
thing. It’s more suitable for photo print-

ing, and is one of the fastest entry-level printers
we’ve seen thus far.

Looks And Features
The Canon Pixma IP 1600 looks identical to its
cheaper cousin, the IP 1200. Unfortunately, the
similarity extends to the build quality! 

Performance
If the IP 1200 is fast, the 1600 is faster. A text docu-
ment saw nine seconds at the high-quality setting
and 19 seconds at the draft setting: very unusual.
At the draft setting, there were minor anomalies
in the form of streaking and a bit of blotting. At
high quality, most of these issues were ironed out,
and the print looked crisp and clean. The Pixma
IP 1600 is therefore reasonably suitable for mass
document printing; the fact that it’s lightning-
fast doesn’t hurt either!

The IP 1600 performed well in our combi-
document tests; even at the normal setting, the

text was clear. The
photo was repro-
duced well,
though the
Epson C67
edges out the
IP 1600 here.
The fruit basket
was also done well,
with nice detailing and
colour blending. In high quality mode, the qual-
ity was even better, of course, and even the small-
est font was readable. The contrast test, too,
treated the IP 1600 well. 

A4 photo quality on the Pixma IP 1600 was
good—better than on the IP 1200, with vibrant
colours and good contrast. Facial features were
well detailed, though the tone and colour satu-
ration seemed a little too rich. At three minutes
and 52 seconds, the IP 1600 is fast, but a bit
slower than the IP 1200.

This printer is worthy of recommendation as
both a document and a photo printer, and comes
very close to delivering the best of both worlds.

Canon Pixma IP 1600

For The Fast Photu-holic 

Canon Pixma IP 1600

Our test bed was an Intel Pentium 4 at 3.2 GHz on an Intel
D875PBZ motherboard with 1 GB of memory. The printouts were

timed with a stopwatch, from the moment we hit the Print button to
the time the document was ejected by the printer. This was the norm
for the text, combi-document and photo printouts. 

For our quality tests, we used two text-only documents. The first
was a simple one-font, one-size. It was printed once at draft settings,
and this test was repeated at normal settings. This
was done because these are the most commonly-used
settings for black text-only documents. The quality of
the printers was assessed on the basis of their ability
to produce flawless printouts at both settings.
Anomalies such as blurring and blotting were noted.
The settings were kept constant for all the printers so
they could be fairly compared.

The second monochrome document consisted of a
single sentence, the first half of which was written in
CAPS, while the second was in lowercase. The
sentence was repeated starting with a font size of 8,
going all the way up to 24. Sharpness of text was
noted, along with the the points mentioned above. 

Our combi-document was a PDF file with text,
images, and shading boxes. Once again, we used
Normal and Best mode, which are the norm for any
colour documents such as brochures and graphs. The text point size
varied from 12 to 2. At the smallest point size, most of the printers
gave illegible results, but the degree of difference is what we noted
here.

There was also an embedded photo in the PDF file, the clarity of
which was noted at both the settings. We also used an image with a
collection of fruits of different colours on a light blue background,
faded in parts. We checked this part of the document for the level of
detail on the fruit—for example, the contours on the body of a
pumpkin; the texturing effect the printer could impart; and the
degree of separation between fruits, for example, individual grapes in
a bowl. We also checked for the highlighting that appears when light

reflects off the skin of a shiny fruit.
The PDF also had concurrent lines drawn within a circle. We

tested whether these lines were straight: most inkjets have problems
with this. Next, we had a contrast test, which consisted of yellow text
on a black background. To make the test difficult, we threw in
different font sizes, and points were awarded for how well a printer
could replicate this. Imperfections were noted and points deducted

accordingly. Finally, using the same PDF file, we
conducted a shade test. This consisted of eight
sample colour boxes, and seven columns of varying
shades of colour—starting with the lightest shade at
the top, and the boxes showing successively darker
shades down the line. Each box had two variations in
shade of the same colour, and the ability to
distinguish between these two shades was something
we specifically looked for. The shades should also get
successively darker, following proper colour
gradation.

Finally, we had an A4 photo test: the photo
occupied an A4 sheet with very narrow margins on
the four sides. The photo was of a person wearing a
multi-coloured, heavily-embroidered T-shirt sitting on
a bright yellow sofa, with a red silk coverlet lying on
one end. A flower vase with white roses is in the

foreground, while the background is a blue wall. There was a potted
plant with lots of green leaves, behind the sofa. 

We looked at the printout of the person for facial detail—
particularly in the eyes, lips and teeth. Skin tone was checked, and
the ability to reproduce the detail on the T-shirt was noted. The
highlights on the sofa were noted, as was the detail on the shiny
silver bracelet worn by the person. The sofa had a number of folds in
the cloth, and the ability of the printers to reproduce these folds
well—reflecting good colour gradation—was noted. Finally, the red
coverlet and the bracelet allowed us to test the printers for their
ability to produce vivid, vibrant colours, and the flowers were checked
for detailing. The bright blue background, and the leaves with their

How We Tested

The combi-document used to test
text and image quality
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Epson’s offering to the value home user. It’s
a sturdy little performer, but not as suitable
for photo printing as some of the others

here. The fact that Epson made this one real easy
on the eye makes the C45 something you can live
with on your desktop for quite a while!

Looks And Features
The C45 has the smallest footprint amongst the
entry-level inkjets, and was the second-smallest
of all the printers we received. A tiny retractable
output tray adds to the overall compact image.
The in-feeder has a small detachable paper
guide and is top mounted—another neat space-
saving trick.

We liked the colour combination, as well as
the translucent top. Build quality was decent—
sturdy enough for daily home use.

The ink monitoring software wasn’t accu-
rate. A few printouts down and the ink indicator
dropped to 50 per cent, and stayed there for the
rest of the tests!

Performance
The C45 was the slowest in our combi-document
and photo printout tests, with an A4 photo
taking nearly 17 minutes to complete: you can

actually take a coffee break after
hitting the Print button! Our combi
PDF file took seven minutes and 15
seconds to print—almost 40 per cent
longer than its bigger brother,
the C67, which at four minutes
and 20 seconds was a slow-
coach. Monochrome printing
was a bit more acceptable, but
still sorely slower than what
we expected. 

Quality-wise, text documents
suffered at draft settings. At high
quality, the fading disappeared, but there was
noticeable blotting around the edges of the text. 

For the combi-document, the C45 displayed
colour detail quite well. It did not fare well in
the contrast test (yellow text on a black back-
ground). Black text quality was not good, with
visibly spiked fonts and ink blotting. 

The A4 photo quality was surprisingly good,
with decent colour vibrance and contrast, and
accurate reproduction of detail. The photo
wasn’t very high-quality, but for Rs 3,295, this
printer is an ideal buy for those on a shoestring
budget who just need to print a few decent-qual-
ity photos.

Epson Stylus C45 

Bangs Your Buck And Looks Cool too!

Agreat-looking printer that delivers on the
performance front as well. It’s stylish,
prints well, and occupies a modest

amount of desk space.

Looks And Features
The C67 is bigger and even better looking than
the C45. The front portion falls open to double
up as the output tray.  The unit employs
“DuraBrite Inks,” claimed by Epson to be
smudge- and water-resistant, as well as fade-
resistant for 120 years! These tests are, however,
carried out on Epson select photo paper, and the
same won’t hold true for other photo and
normal papers. 

The Epson C67 doesn’t have the one black and
one tri-colour set of cartridges that the C45 has.
Instead, it has four individual cartridges—a popu-
lar setup for photo printers. The ink monitoring
software worked fine on the C67, which made us
believe the issue with the C45 was a one-off glitch.

Performance
While printing black text in Draft mode, there
was noticeable artefacting, similar to the blot-
ting on the C45 at high settings, but thankfully,
there was no fading in the text. At high quality,
some of the blotting prevailed, though it wasn’t
as noticeable. Surprisingly, the C67 was slower
than the smaller C45, taking 40 and 54 seconds

respectively at the draft and high
quality settings.

The PDF combi-document
gave mixed results, with
jagged spikes reappearing at
both medium and high qual-
ity modes. Some of the high-
contrast text was also not
clearly visible at medium
settings, though at high
settings this was ironed out. The
embedded photo was reproduced well, with
good detailing, especially at high quality. The
level of detail in the fruit scene was good,
though the C45 highlighted the fruit better.
Speed-wise, the C67 was slower than the compe-
tition but faster than the C45.

The C67 produced good A4 photos with good
contrast and highlights, but missed out on
colour gradation: the cloth settee in the back-
ground has several folds in the cloth, which
weren’t picked up properly. Facial features had
good detail. The C67 took five minutes for the
photo printout—which is more than three times
faster than its sibling, though it’s still slower
than what we expected. 

Overall, the difference between the C67 and
C45 is small. If you’re looking for an affordable
printer that offers high-quality photos at
Rs 4399, the C67 is a good pick.

Epson Stylus C67

Looks Great, Prints Great, Goes Slow!

Canon Pixma IP 1200

Good photo printing
Good for printing casual
colour printing
Great looks and build
quality
Suffers a bit as far as
monochrome printing
goes, but is more
suitable for the task
than its smaller brother
the C45 
Printing speed is slow
for a printer of 
this class 

Price: Rs 4,399

Epson Stylus C67

Digital Tools l Printer Test

Good build quality
Good looks
Decent at printing
photos, but there are
better options out there
Good value for money
Text printing suffers as
far as quality goes 

Price: Rs 3,295
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Scoreboard                             Inkjet Printers
BRAND
MODEL
Features
Printing Technology
Resolution (dpi)
Interface
Input Buffer
Output / Input Tray Capacity
Cartridges Included?
Dual-side Printing Support
Accessories
Data Cable
Power Cord
Manuals and Documentation
Troubleshooting / Quick Setup Guide
Miscellaneous features
Status of Ink Tanks through Driver
Special Features
Type of Cartridges 
Weight (kg)
Dimensions (H x W x D) (cm)
Build Quality
Movable Parts, Trays, Sliders, etc. (So5)
Movable Parts in the Cartridge Bay (So5)
Performance
Speed Tests (Time)
Plain Text in Draft Mode (Black and White;
Lowest Quality)
Plain Text in High-Quality Mode (Black
and White)
Photo Printout (Colour; Highest Settings;
Kodak Paper)
Combi-Document (Normal Mode)
Combi-Document (Best Mode)
Image Quality Tests
Image Quality (Black-only Text Document)
Text Quality (So5)
Image Quality (Combi-document, Normal)
Colour Saturation (So5)
Spatial Resolution (So5)
High-Contrast Details (So5)
Image Quality (Combi-document, Best) (So5)
Colour Saturation 
Spatial Resolution 
High Contrast Details
Image quality (Picture, Best) (So5)
Colour Reproduction 
Colour Saturation 
Specular Effect 
Level of Detail
Price (Rs)

Canon
Pixma iP1200

Thermal
4800 x 1200
USB 2.0
96 KB
None / 150
✔

✖

✔

✔

✔

✖

NA
Black/Tri-colour
2.9
16.5 x 43.5 x 24.9

2.5
3

18 sec

20 sec

3 min 50 sec

44 sec
2 min 5 sec

3

2.83
3.3
2.5

3.08
3.15
3.75

3.50
3.75
4
4
3,495

Canon
Pixma iP 1600

Thermal
4800 x 1200
USB 2.0
96 KB
None / 150
✔

✖

✔

✔

✔

✖

NA
Black/Tri-colour
2.9
16.5 x 43.5 x 24.9

2.5
3

19 sec

9 sec

3 min 52 sec

42 sec
1 min 58 sec

4

3.25
3.6
3.5

3.00
3.1
4

3.63
3.92
4.25
4
4,495

Epson 
Stylus C67

Piezoelectric
5760 x 1440
USB 2.0
32 KB
25 / 120
✔

✖

✔

✔

✔

✔

NA
4 Individual Tanks
4
19.5 x 44.7 x 24

4
3.75

40 sec

54 sec

4 min 59 sec

1 min 41 sec
4 min 20 sec

3.25

2.58
3.05
3

3.17
3.6
3.5

3.75
3.67
4.25
3.5
4,399

HP
Deskjet 460cb Mobile

Thermal
4800 x 1200
USB 2.0
32 MB
None / 50
✔

✖

✔

✔

✔

✔

PictBridge,USB,MemCardSlot
Black/Tri-colour
2.22
8 x 34 x 18.4

3.75
4

11 sec

14 sec

3 min 53 sec

54 sec
1 min 39 sec

4.25

3.50
4.05
3

3.92
4.3
3

4.00
4.17
4.25
4.5
14,999

Epson
Stylus C45

Piezoelectric
2880 x 720
USB 2.0
12 KB
25 / 100
✔

✖

✔

✔

✔

✔

NA
Black/Tri-colour
3.04
16.2 x 41.9 x 19.9 

4
3.5

11 sec

37 sec

16 min 50 sec

1 min 57 sec
7 min 15 sec

2.5

2.83
3.35
1.75

3.25
3.5
2

3.88
3.67
4
3.75
3,295
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HP
Photosmart 7838

Thermal
4800 x 1200
USB 2.0
32 MB
50 / 100
✔

✖

✔

✔

✔

✔

Pictbridge,USB,MemCardSlot
Black/Tri-colour/Photo
4.2
15.8 x 46.5 x 23

4
3.5

11 sec

19 sec

3 min 3 sec

30 sec
1 min 4 sec

3.5

2.75
3.1
2.5

3.50
3.65
3.25

3.38
3.00
3.5
2.5
5,499

HP
Officejet K550 Pro

Thermal
4800 x 1200
USB 2.0
32 MB
150 / 250
✔

✖

✔

✔

✔

✔

NA
4 Individual Tanks
9.7
21.3 x 49.5 x 40.3

4.5
4.25

12 sec

13 sec

3 min 5 sec

16 sec
34 sec

3.75

2.92
2.9
2.5

3.42
3.7
3.25

3.38
3.83
3
3.5
7,999
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Acompact photo printer that gets the job
done in style; in fact, it’s a safe bet to say
this one should give many normal-sized

inkjets a run for their money. An excellent buy
for the professional who needs to cart his

printer around.

Looks And Features
The 460cb is by far the smallest printer

we’ve received. The in and out paper
trays and the top flap have been

designed to fit flush with each
other. The build quality of the
movable parts is excellent.
Being a photo printer, the

460cb comes with an SD/MMC
and a CF slot. It uses the stan-

dard black/tri-colour
cartridges—no individual
tanks here.

Performance
Under our text tests, the 460cb performed
commendably, with no blotting at high quality.
In Draft mode, the document showed signs of
blotting, although this wasn’t very noticeable.
At high-quality settings, the printout was as
close to perfect as we’ve seen. This is thus a very
good printer for monochrome printing, and is

fast as well, taking 11 and 14 seconds in our
draft and high-quality tests respectively. 

Our combi-test was handled very well too,
with the text crisp and clear. The embedded
photo was reproduced well, with minor arte-
facts at normal settings. At both quality
settings, the fruit basket was perfectly repro-
duced with excellent detail on the colours, and
realistic textures.

With such results, we were optimistic about
the photo test as well. The diminutive 460cb
galloped along, taking only three minutes and
53 seconds to print an A4 size photo. Photo qual-
ity was impressive: the flowers in the foreground
looked good, with good detail around the petals.
Facial features looked life-like, with perfect
colour blending, giving a realistic texture feel to
the skin. Tones were vivid, yet not overly bright.
This printer can handle contrasts very well, and
the bright-coloured bracelet was reproduced
perfectly. Even the red silk coverlet looked rich
and vivid—something a few of the printers
missed out on.

This printer delivers performance, and is,
like we said, very compact. No compromises
whatsoever! The only sore point is the price—
Rs 14,999. Still, for the professional who might
need to cart around a printer with him, the HP
460cb will deliver with aplomb!

HP Deskjet 460cb Mobile

An ultra-compact
printer; very portable
Excellent for
photographs
Very good build quality 
Costly and not really
worth the price unless
portability is of
tantamount importance

Price: Rs 14,999

Very good looks; a good
colour combination has
been used
Supports PictBridge 
plus a lot of different
memory slots
Well-priced for the
features it brings to
the table
Mixed results in the text
and combi tests, where
the printer performed
well only at higher
settings, which will
consume more ink
Not really great for
photo printing, which
is the segment it’s
aimed at! 
Price: Rs 5,499

The 7838 is a feature-rich printer with all the
goodies such as PictBridge and support for
multiple memory slots. Its looks will win the

hearts of many, while the inclusion of a discrete
photo cartridge along with the package make it a
sweet value-for-money deal.

Looks And Features
The HP PhotoSmart 7838 is a photo printer with
top-class build quality. The fit and finish of the
paper trays and top panel are great.

The 7838 comes with PictBridge support. It
also supports SD/ MMC/CF and XD memory cards.
This printer has a two-cartridge setup: the black
one can be swapped for a photo cartridge.

Performance
The 7838 produced clear, crisp text without visi-
ble quality loss. At draft settings, we noticed some
artefacting—unacceptable for a printer in this
price range. At the higher settings, there was no
loss in quality. 

The printer fared rather badly in our combi-
document test—surprising for such a printer . The
embedded photo was distorted, and the contrast
test saw a hardly-legible output when the font size
was reduced. The detail in the fruit scene was also
missing, and the colours also could have been

better. Qual-
ity and clarity
was somewhat
better at high settings,
but this is expected, though
we feel the entire page
could have been a tad better. Speed wasn’t an issue:
the printer took one minute and four seconds at
the high-quality setting.

The 7838 completed the photo in three
minutes and three seconds. We did two photo
printouts—one with the regular black cartridge,
and another with the photo cartridge. With the
photo cartridge, the printout took 24 seconds
longer. With the regular cartridge the photo
looked a bit dull, and there was easily-detectable
graininess. With the photo cartridge, the graini-
ness disappeared, as did the problem with vivid-
ness. The tones looked much richer—in fact, we felt
the yellow sofa was over-saturated, but the lack of
a dedicated black cartridge (you need to pull out
the black cartridge when inserting the photo
cartridge) caused quite a few problems, particu-
larly noticeable as blurring in the hair and around
the pupils of the eye of the subject.

All in all a very well-built, feature-rich printer,
but the performance is mediocre for Rs 5,499.
There are cheaper options that do the job better.

HP Photosmart 7838

Doesn’t Really Live Up To Its Name

Small In Size, Big On Quality

HP Deskjet 460cb Mobile

HP Photosmart 7838
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Supreme build quality
and sturdiness; looks
good
Suitable for the SoHo
segment
Individual ink tanks and
changeable print heads
Very suitable for
moderate-volume text
printing
Moderately suitable for
photo printing
A bit bulky though

Price: Rs 7,999

Targeted at the office and SoHo segment,
this tank (built well, built large), can just as
easily be used at home for printing photos.

In fact, just using it for monochrome printouts
doesn’t do it justice at all!

Looks And Features
The K550 pro is a large printer with excellent
build quality. It comes with changeable print
heads, which is a good thing, as regular use
degrades the print heads. The K550 has large indi-
vidual ink tanks. The paper-in tray can hold 250
sheets—suitable for heavy duty printing. 

There’s a DTN variant of this printer as well,
which has an Ethernet port. The K550DTN costs
Rs 5,500 more than this one. Besides the Ether-
net port, the models are identical.

Performance
This printer took just 12 and 13 seconds respec-
tively to print our text page at draft and normal
settings. The printout at high quality was
almost flawless. At draft quality the ink volume
seemed a little light; quality, therefore, wasn’t
too good, but for a business that prints in high
volumes and wants to save on ink, this is actu-
ally a plus.

Our combi-document took 16 seconds and 34
seconds to print at normal and best quality respec-

tively. At normal settings the printout was a little
light: the embedded photo lost out on clarity. The
fruits were reproduced well though; we
would have liked it if the
printer used a little more
ink at lower settings. Print
quality at high settings was
good, with the fruits
coming out well with all the
highlights. The contrast test
was just OK—the K550
missed out on the smallest
font even at high settings.

Although not many busi-
nesses will use their inkjet to
print photos, we nevertheless decided to set this
test up. The photo that resulted was adequately-
detailed, with all the facial details being captured
well. The eyes looked very realistic; the yellow
settee came out well; and the shiny red silk cover-
let was very vibrant. We noticed a little graini-
ness at one portion of the photo, and took
another printout just to be sure—this was not
repeated, but the little quirk was noted.

Overall, a very good product that delivers for
its price. It is perfectly suited to the SoHo
segment, and even to the home user for whom a
little extra ink spent at high settings is well
worth the quality. 

HP OfficeJet Pro K550

The Speedy Workhorse

Many consumers who use inkjet printers
opt for cartridge fill-up kits, or visit refill

centres after they use their first set of ink
cartridges that came bundled with the printer.
And why not—after all, you can easily get a
refill for around a one-third of what a new
cartridge would cost. 

Quality doesn’t come cheap, however, and
using such fill-ups or re-manufactured
cartridges can compromise printer components
via leakages or deposits, thereby chalking up
greater long-term costs due to repairs and
possibly even device replacement. There are
short-term repercussions, too: refilled
cartridges generally do not last as long as
originals do, because of the filling and sealing
procedures used. And the print quality is almost
never as good as with original cartridges. 

You might be lucky enough to find a
cartridge refiller in your area who does a good
job. Many don’t, but some do. We can’t
recommend any refilling companies because
refilling your cartridge voids your warranty!

It’s a trade-off of sorts. Basically, home
users, who always want value, will opt for refills
while sacrificing on quality, while for small
business houses and the corporate sector, its
quality all the way. There is no real solution and
the debate goes on; it all depends on what you
want from your printer, and to what extent
you are willing to trade price with quality.

Cartridges—Original Or Refilled?

HP OfficeJet Pro K550
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5.1 Speakers
Philips MMS 5.500 i/C

Good for music
Not suitable for gaming

Contact Philips India Ltd
Phone 022-56912332
E-mail pcp.india.info@philips.com
Price Rs Rs. 4,990

2.1 Speakers
Altec Lansing MX-5021

Great sound and build quality
Slightly expensive 

Contact Rashi Peripherals
Phone 022- 55090909
E-mail divya@rptechindia.com 
Price Rs 7,900

Projectors
Sharp XR-10S

Brilliant quality and 
performance
Bulky

Contact Sharp Business
Systems Ltd
Phone 011-26431313
E-mail anilsodhani@

sharp-oa.com
Price Rs 71,000

LCD Monitors (15-inch)
BenQ FP51G

Good performance
None in particular
Contact BenQ India Pvt Ltd
Phone 022-25705230 
E-mail kamlesh.salunke@

benq.com
Price Rs 9,900

PVR Software
WinDVR 3.0 

Ease of use, pause TV, zoom
in on TV, tiled preview of
channels, DV-to-MPEG, good
picture clarity
None  

Contact www.intervideo.com

Digital Cameras
(High- End)
Sony CyberShot DSC-P200

Compact, 7-megapixel
performance-oriented
camera
None in particular

Contact Sony India Pvt Ltd
Phone 011-55006600
E-mail mktginfo@ap.sony.com
Price Rs 20,990

LCD Monitors (17-inch)
NU QL-711V

Inexpensive
Below average build quality

Contact Shiba Comp Pvt Ltd
Phone 011-26413437
E-mail shiba@del2.vsnl.net.in
Price Rs 11,970

LCD Monitors (19-inch)
NU L921G

Low price, good viewing 
angles
Below-average build quality

Contact Shiba Comp Pvt Ltd
Phone 011-26413437
E-mail shiba@del2.vanl.net.in
Price Rs 18,000

Hard drive-based MP3
Players
Apple iPod 

Amazing Sound Quality,
Easy Interface, Plays Video
No FM, No Protection For
Screen

Contact Apple Computer
International Pvt Ltd

Phone 1800-425-4683
E-mail indiainfo@

asia.apple.com
Price Rs 19,800

Flash-based MP3 Players
SAFAQ100

Good Sound and Interface
Very Small Screen For Video

Playback
Contact Arihant Computers
Phone 022-23822424
E-mail arihant_computers 

@vsnl.com
Price Rs 8,600

External DVD-Writers 
Lite-On LightScribe SHW-16H5S

Good performance, EZ-DUB 
No FireWire

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@mediatechindia.com 
Price Rs 6,495

Internal DVD-Writers
Lite-On Super AllWrite
SHM-165P6S

Good performance, supports 
all DVD formats
None in particular

Contact Mediatech India 
Distribution Pvt Ltd

Phone 022-26361111
E-mail digit@media

tech india.com
Price Rs 3,085

Graphics Cards (High-End) 
XFX GeForce 7800 GTX
256 MB

Extreme performance, great
price, exotic features 
None
Contact Rashi Peripherals
Phone 022-28221013
E-mail navinderc@ 

rptechindia.com
Price Rs 32,950

Linux
SuSe 9.3 Linux Professional

Up-to-date software bundling
None

Contact G T Enterprise
Phone 080-26695890/91/

92/93/94 
E-mail gtcdrom@vsnl.com 
Price Rs 4,398

Motherboards
Mercury PI915GVM

Supports PCIe, DDR/DDR II
RAM, 6-channel audio
Only 2 PCI slots. No SATA.

Contact Kobian ECS India Pvt ltd
Phone 022-23020767 / 774
E-mail mumbai@kobian.com
Price Rs 4,750

MSI RS480M2-IL
PCIe-based, 6-channel audio,
supports 4 GB RAM, Socket
939, FireWire port
No Gigabit Ethernet

Contact Tirupati Enterprises 
Phone 033-22251192 
E-mail mail@tirupati.net
Price Rs 4,950

The best products tested so far in different 
hardware and software categoriesThe A-List

DIGIT JULY 2006
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Budget Cell Phones
Nokia 2600

Value for Money, Easy
Navigation
4k colour screen

Contact Nokia India
Phone 30303838 
Website www.nokia.co.in
Price Rs.2869

Mid-range Cell Phones
Motorola L7

Sleek and elegant looks,
Good build quality, expand-
able memory

None in particular

Contact Motorola India Pvt. Ltd
Phone 0124-230-3212 / 7212 
Website www.motorola.com
Price Rs.10,007 

PCs above Rs 25K
Acer Aspire ASP V4324

Good performance and pack-
age contents, low price
None in particular

Contact Acer India (Pvt) Ltd
Phone 080-25219520
E-mail ailenquiries@acer.co.in
Price Rs 25,999

Media Center PCs

HP Pavilion m7280in
Great design, features, and
performance
Expensive 

Contact HP India Sales Pvt Ltd 
Phone 0124-2566111
E-mail incontact@hp.com  
Price Rs 63,999

Burning Software
Sonic/Roxio Easy Media
Creator 8

Feature-rich, low on system 
resources, many bundled 
utilities
None in particular
Web site www.roxio.com

Feature-rich Cell Phones
Sony Ericsson K750i

Very good camera & audio
quality, good display crispness
Screen could have been bigger 

Contact Sony Ericsson
Phone 0124-2560808 
E-mail dhiraj.soni@

sonyericsson.com
Price Rs. 14,995 

Home Inkjet MFDs
HP Officejet 4355 All-in-One

Fax with handset, compact
Only sheetfed scanner  

Contact HP India Sales Pvt Ltd
Phone 0124-2566111
E-mail ashwini-k.aggarwal

@hp.com
Price Rs 6,499

Office Inkjet MFDs
HP Officejet 5610 All-in-One

Good performance
Expensive, No memory card
support

Contact HP India Sales Pvt Ltd
Phone 0124-2566111
E-mail ashwini-k.aggarwal

@hp.com
Price Rs 9,999

Keyboard-Mouse Combos
Gigabyte GKM-10

Good ergonomics
Can do with more features

Contact Gigabyte Technology (I) Ltd
Phone 022-26526696
E-mail sales@gigabyte.in
Price Rs 790

Mono Laser Printers
Brother HL-5170DN

Good build quality, network
support
Expensive

Contact Lipi Data Systems Ltd 
Phone 022-22882960
E-mail sharatk@lipidata.com  
Price Rs 21,900

Lifestyle Ultra-Portable
Laptops
Sony VAIO VGN-S46GP/S

Good looks, great performance,
excellent LCD display
None in particular

Contact Sony India Pvt Ltd
Phone 011-55006600
E-mail mktginfo@ap.sony.com
Price Rs 99,990

Lifestyle Workhorse Laptops
Acer Ferrari 4002

Great looks and flaunt value,
great performance  
None in particular

Contact Acer India (Pvt) Ltd
Phone 080-25219520
E-mail ailenquiries@acer.co.in
Price Rs 99,999
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Keyboards
iBall Power Key Designer

Feature-rich
None in particular

Contact Best IT World (India) 
Pvt Ltd 

Phone 022-3081 5100 
E-mail sales@iball.co.in  
Price Rs 990

Mice
Logitech G7 laser mouse

Feature-rich, offers fantastic
performance
Expensive

Contact Logitech Electronic 
India Pvt Ltd 

Phone 022-26571160
E-mail kavita_nath@

ap.logitech.com  
Price Rs 6,495

Mono Laser MFDs
Samsung SCX-4521F

Good performance and
quality
Low input tray capacity 

Contact Samsung India
Electronics Pvt Ltd 

Phone 011-26431313
E-mail vikram.negi@

samsung.com
Price Rs 21,990

Value PCs
HCL Ezeebee 4981

Great performance and
upgradable
None in particular

Contact HCL Infosystems Ltd
Phone 0120-2520977 
E-mail wecare4u@hcl.in
Price Rs 23,999



Trendy And Functional

Easily one of the best-looking headsets we’ve come across,
and by far one of the most compact, this headset comes

ensconced in a neat little aluminium box—very showy!
Everything about it is unique, from the three-piece headset
(you actually need to assemble this one) to the multiple
charger attachments and the swanky pen-like dock. 

The Discovery 640 is ultra-compact as far as Bluetooth
headsets go, and features one-button operation. Volume is
controlled by a two-way button. The attachments include a
small pen-like docking station that vibrates when you receive
a call, and doubles up as a charger. It also clips onto your
pocket, much like a pen. There are also
small adapters compatible
with most cell phone
chargers that can be
plugged onto the dock,
so you need only carry
your cell phone
charger with you. An
A/C charger has also
been provided. The
device itself has a
detachable ear hook,
consisting of a twisted
metal wire encased in
plastic—comfortable

despite what that sounds like! Three soft earplugs with
different sizes to suit your ear size are provided. 

All the attachments besides the ear assembly come in a
steel and black finish—very classy. 

Voice clarity was very good, with zero distortion when the
cell phone was close by. Signal integrity is good for around 20
feet, after which degradation occurs, and the signal distorts
badly after 28 feet. Having obstructions will only hasten
distortion, but these figures are good: you can leave your cell

on your table as you move around
the room. 

The Discovery 640 is the way
to go you’re in the market for a
quality Bluetooth headset.

Compact and stylish, it’s a
combination of looks and

performance. The slight problem of
music playback is there, but that’s

what regular headphones are for! A
worthy buy, even at Rs 4,700.
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Plantronics Discovery 640 Bluetooth Headset

Transcend StoreJet 2.5 40 GB

Rating

Company Plantronics Inc

Price Rs 4,700

Phone 0124-5105192

E-mail bobby.joseph@plantronics.com

Web site www.plantronics.com

Rating Rating

Your Mobile Desktop

The Transcend StoreJet 2.5 external USB 2.0 hard drive is
sleek, and the build quality is rugged. Data storage capacity

is 40 GB. The device requires two USB ports—one for data and
one for power. Data transfer speeds are quite fast—it took just 6.5
seconds to transfer a 100 MB file.

What makes this drive special is the bundled software—
StoreJet PC Lock can be used to lock your OS when the

drive is unplugged and unlock it when the drive is
plugged back in. Mobile IE, Mobile OE and

Mobile Address Book let you carry your
Internet settings, bookmarks, e-mails,

and more such stuff around for use
on any computer. All these

utilities come inside the
Device Desktop, which lets
you carry your Desktop

anywhere. The low price tag
of Rs 5,200 is enticing.

Some Of The Good, Some Of The Bad

A12.1-inch screen with a wide viewing angle, 802.11 b/g,
standard 10/100 LAN, PCMCIA Type II slot, a DVD-Writer,

and an MMC/SD card are the goodies here. 
With a 1.73 GHz Pentium Mobile 740J

processor supported by 512 MB of
DDR RAM and a 60 GB hard
disk, the N211U logged
above-average CPU and
memory benchmark scores.
The GMA 900 video card can
handle only moderate gaming. 

The kill-joy is the extremely
badly-designed touchpad. It’s
hard to even move the cursor
around the desktop! Thankfully,
the keyboard feel was satisfactory.
The battery lasted only 116 minutes
of continuous DVD movie
playback—a big let-down.

GIGABYTE N211U

Company Gigabyte Technologies

Price Rs 60,999

Phone 022-26526696

E-mail sales@gigabyte.in

Web site www.gigabyte.in

Company Mediaman

Price Rs 5,200

Phone 022-23828100 

E-mail sales@mediamangroup.com

Web site www.transcendusa.com
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Nah... We’ll Wait For The Movie

This is Nokia’s second touch-screen phone to hit the Indian market after the 7710.
Touted as a business phone for individuals on the go, it runs on the Symbian7 OS

with the UIQ 2.1 interface—quite dated if you’re looking for good features. 
No grouse as far as looks are concerned; the silver-grey colour combination gives

the phone an executive look. The large 65K colour screen works in the favour of
the phone—especially when you’re using it as writing pad—and dominates the
front facia. The keypad, however, is quite cramped.  

Handwriting recognition is accurate, but needs time to get used to. Devoid
of any other option of inputting data, the 6708 doesn’t really qualify as a
good business phone—one-handed operation is a must, and the Nokia 6708
is uninspiring on that front. 

Connectivity options include IR, Bluetooth, a mini USB jack and GPRS
for connecting to the Internet. The phone also includes a universal
remote for your TV, DVD player, air conditioner, and so on. The phone
has 18 MB of memory dynamically shared between applications, and a
hot-swappable miniSD slot for memory expansion. The integrated
1.3-megapixel camera delivers mediocre performance.     

For documents, the 6708 comes equipped with the Quickoffice
software bundle. It also supports all major e-mail protocols.

This Nokia is a decent product by itself, but falls short of being a good
“business” phone. At Rs 21,500, we’d recommend you wait for the upcoming
E series of business phones from Nokia.

Ready For Some Football Fever?

Genius has launched the LOOK 315FS Webcam, which
looks like a football. After all, the World Cup is on! The

body is made of rubber, reminiscent of an actual football,
and you’ve got to appreciate the inclusion of the 32
national flag stickers of the 2006 FIFA qualified teams. 

The LOOK 315FS has an inbuilt microphone, though its
quality is not too good. The DD Theme Party application
that comes bundled is, without a
doubt, the strongest reason in
for buying this thingy. You
can track a face and add
funky-looking theme
masks to it. The image
quality is nothing to
boast about, and is
grainy at times.

The 315FS has
decent gimmick value
for Rs 2,400. Combined
with the software
package and its looks,
this is a must-have for
the football
aficionado. But the
video and audio quality are
no more than average, making it a can-do-without for
someone who wants performance.

Perpendicular Storage Behemoth!

The Seagate Barracuda 7200.10 750 GB SATA—Seagate’s
first hard drive built upon perpendicular storage—is

currently the storage behemoth in our test lab. The new
recording technology has enabled Seagate to provide
oodles of space for all those games and that meticulously-
maintained MP3 and movie collection. 

Seagate has, surprisingly, positioned this drive for the
gamer, movie buff, and lower enterprise segment, which
doesn’t need the raw speed of the faster 10,000 rpm drives.
HD Tach clocked it at a read burst speed of 86.1 MBps—
impressive, though CPU utilisation was a bit on the higher
side at 26.8 percent. It also posted impressive data transfer
scores in SiSoft Sandra 2005 Pro. The size doesn’t seem to
affect the performance at all. 

Overall, we’re very impressed with this Goliath.
Although it’s a bit of overkill for lesser mortals like us, if
space is what you crave and your pockets are deep enough,
this one is sure to satisfy!

Rating

Seagate Barracuda 7200.10 750 GB

Company Nokia India Pvt Ltd

Price Rs 21,500 

Phone 30303838 (toll-free)

E-mail advait.vaidya@nokia.com

Web site www.nokia.co.in

Rating

Company Transtek Infoways Pvt Ltd

Price Rs 2,400

Phone 0250-3950072

E-mail amit@ttek.in

Web site www.geniusnet.com.tw

Company Seagate Technologies

Price Rs 26,200

Phone 011-41811694

E-mail msinghal@esysmail.com

Web site www.seagate.com      

Rating

Genius LOOK 315FS

Nokia 6708
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A Formidable Design Tool

Seventeen years after the first one, Corel breaks away from
its earlier naming convention (version 13 unlucky,

perhaps?) to release the CorelDRAW Graphics Suite X3. The
box pack contains four CDs—one containing the program

files for CorelDRAW, Corel
Photo-Paint and Corel
Capture, and the
remaining three full to
the brim with clipart
and fonts.

Time and again,
CorelDRAW has
wowed us with its vast
array of abilities and
all within a small
memory footprint—
both DRAW and
Photo-Paint are
beautifully stable
and light on
resources. 

Among the
best new
additions to
CorelDRAW X3
is the Crop tool,

which lets you
crop vector graphics

the same way you would
raster—just select the area

you want to keep, and double-
click! No more hunting and

deleting specific points on the
curves. Another nifty tool is the Smart

Fill, which automatically estimates boundaries and only fills
the space inside. We tried this by drawing a bunch of
squares to create a haphazard boundary, and the Smart Fill
filled the enclosed area precisely. Text and paragraph
formatting is a breeze thanks to new DTP features, bringing
CorelDRAW another step closer to becoming an excellent
page layout program. In fact, the supplied font and clipart
catalogue was laid out in CorelDRAW itself!

Corel Trace,
the tool for
converting
raster graphics
to vector in
CorelDRAW, is
now Corel
PowerTrace,
and gives
much better
results when
tracing
bitmaps. 

Both
CorelDRAW
and Corel

Photo-Paint are now much easier to learn
thanks to the addition of a Hints pane on the
right of the window, which tells you what to

do with the tool
you’ve currently got
selected—a boon for
new users.

Photo-Paint has
improved on
performance, and
we found it capable
of handling
complex files
without any
stability issues.
When we decided to
verify the claims
that Photo-Paint is
actually faster than
Adobe Photoshop in some respects, we
were quite amazed—applying a Radial Blur
(Amount: 10) to a 66 MB, 300 dpi TIFF file
took Photoshop CS2 4 minutes and 17
seconds, and Photo-Paint a jaw-dropping 1
minute and 45 seconds! Its memory
footprint is also much smaller with the
image loaded: 104 MB to Photoshop’s 167. Factor in the fact
that the price of the entire suite is about two-thirds that of
Photoshop, you have a product that inches ever so close to
the Master itself.

The third application—Corel Capture—seems like a
gratuitous addition. It’s utterly pointless, especially when
you consider other screen capture tools such as SnagIt and
HyperSnap. Ditto Font Navigator, which still seems to be
stuck in the stone age of font managers.

Overall, CorelDRAW Graphics Suite X3 is an undoubted
must for old and new users alike. It’s lightweight and yet
delivers features that will give your graphics a slick,
professional look. 

Try out CorelDRAW Graphics Suite X3 from this month’s DVD.

Now crop vector graphics just like
bitmaps

The Hints pane makes
the new X3 Suite much
easier to learn

Now trace bitmaps better with PowerTrace

The Smart Fill tool easily
fills up enclosed areas.
Here, we just made a
rough boundary with
squares and used the
Smart Fill for the middle. 

CorelDRAW Graphics Suite X3

Rating

Company Sonata Information Technology Limited

Price Rs 20,475 (full), Rs 10,200 (upgrade)

Phone 080-26575800

E-mail rajeev.nagar@corel.com

Web site www.corel.com
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Use A Toolbar
Don’t bother going to Google’s

homepage by typing in
www.google.com every time you want
to search. Don’t even set your
homepage to Google—it takes up a
couple of seconds, which add up! Use
the Google toolbar—it comes inbuilt in
Firefox and Opera, and for Internet
Explorer, head to toolbar.google.com
for the small download. For the Yahoo!
search toolbar, visit toolbar.yahoo.com.

Filtering Search Results
Google and Yahoo! don’t have

parental controls, but you can control
what you yourself are exposed to! If you
don’t want obscene images turning up
in an image search, for example, set
your Google preferences to “Use strict

filtering.” The Google preferences link
is to the right of the search bar on
www.google.com.

Excluding Unwanted Results #1
The “-” (minus) sign is used to

exclude certain words from your search. If
you want to search for information about
5.1 speaker sets, you’ll probably get a lot
of results that speak about other speaker
configurations. Instead of “5.1 speakers”,
try “5.1 speakers -2.1 -4.1 -6.1 -7.1”.

The Use Of Quotes
Use quotes as often as possible for

the most relevant results, and for your
desired results to appear as high up in
the list as possible. For example, if you
want to know who the Time Man of the
Year for 1990 was, it’s better to type in
“time’s man of the year” with the
quotes, followed by “1990” (with or
without the quotes), rather than just
“time’s man of the year 1990” without
any quotes. Check it out!

Using The “Cached” Feature
If a result link is taking too long

to open, and the information you need
doesn’t relate to time (as in news
items), use the “cached” link (if there is
one) after the result. This will almost
certainly load, since Google and Yahoo!
are almost never down!

Personalised Search
If you want your search results to

become more and more relevant over
time, and if you don’t mind Google
knowing a lot about you, sign in before
you search. The sign-in link is at the top
right corner of the Google homepage,

and you’ll need to use your Gmail
username and password. From then on
until you sign out, Google remembers
what you searched for and what you
clicked, making it possible to give you
more accurate, personalised results.

Some may be paranoid about Google
knowing so much about you, but in
some peoples’ opinion, “Who cares what
a server in California or somewhere
knows about me?” It’s your choice…

Forget The Dictionaries
Google can replace several other

kinds of searches. If you want to know
what the time in New York is just now,
just type in “New York time”! Similarly,
if you need to know the difference in
usage (or use?) between the words
“usage” and “use,” you don’t need to go
to an online thesaurus or dictionary.
Simply type in “use usage” into Google,
and you’ll get results directly from
dictionaries and thesauri! Note that in
this particular example, Google does
the job for you, but Yahoo! doesn’t. MSN
brings up the required result second,
which is quite nearly there.

Force Keywords
Not all words in a search string

come up in search results. You’ll
sometimes find that somewhere down
in the results, there are pages which
don’t contain one or more of your
search terms at all! This is especially
true for searches with many keywords.
It suffices to say that it’s Google’s way
of giving you the most relevant results.
To force a certain keyword or keyphrase
to be included in the search, use the “+”
sign. For example, typing in “favourite
example hardware sata mouse”
(without the quotes) will bring up some
results without one or more of those
words. If you need the word “example”
(which is a common word, so Google
might leave it out), type “favourite
+example sata hardware mouse”.

Excluding Unwanted Results #2
To exclude irrelevant results, try

using extra keywords. For example, if
you want information on various fruits,
such as apples, grapes and mangoes, you
might key in these words into, say,
Yahoo! You’ll see results that include lots
and lots of fruits. Take a few of those
from the first couple of results and
exclude them using a minus sign.

For example, “apples grapes
mangoes” (without the quotes) brings up
84,000 results on Yahoo, with lots of
irrelevant fruits mentioned. Now, type in
“apples grapes mangoes -bananas -pears -
plums -lemons -oranges -pineapples”.
Voila—just 1,100 results! Of course, this is
just an example of how you can
drastically trim down your results.
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Ready Info
Google has some hidden gems.

One amongst these is information
about people, countries and such. For
example, if you need to know when
Mozart was born, just type in “Mozart
born” (without the quotes), and Google
will give you the required date of birth.

Quick Definitions
A very useful function in Google

is the “define” command. If you want
to quickly know what SATA is, simply
type in “define:sata”.

Searching Within Sites
Some sites have a Google search

on their homepage, from where you
can search for stuff within that site.
You don’t need to go to the site to get
that functionality. Simply add
“site:www.examplesite.com” to your
search terms, and you’ll get results
only from www.examplesite.com. You
can also specify domains, such as .edu
this way: “admissions scholarship
site:edu”.

Related Sites
You’ve probably seen the “related”

link after page results in Google. Again,
you can directly get sites related to a
certain sites by typing in something
like “related:www.examplesite.com”.

Bring Up Only Certain
Filetypes

If you want results of a certain file type,
such as PDF, you can use “filetype:pdf”
before your search query. This will
return only PDFs. Of course, you can
use this for any file type, including
MP3, XLS, or anything you want.

Putting Document Titles To Use
“allintitle” searches for pages that

have all your search words in the title
of a Web page. So if you want sites that
have “microsoft” and “knowledge” in
the title, type in “allintitle: microsoft
knowledge” with a space between the
“allintitle” and “microsoft”.

Searching By URL
You can also search for terms that

occur in the URLs of documents. For
example, if you want to find the word
“mac” in sites that have “apple” in the
URL, where “mac” might or might not
be in the URL, use this: “inurl:apple
mac”. The word “apple” will then be in
the URL. Note that there should be no
space between “inurl” and “apple”.

Saving Searches in Outlook
You can create search files in

Outlook, executing which will conduct
the search. For example, say you
frequently search for very large files,

which usually indicate those with
attachments. You can make up and
then save such a search.

Go to Tools, click Advanced Find,
and then click the More Choices tab. In
the “Look for” box, click Messages.
Then in the Size list, click greater than,
and then type a number such as 1024,
for files that are 1 MB or larger in size.
Select any other search options you
want, then click Find Now.

When the search is complete, you can
save it as a shortcut: click Save Search on
the File menu of the Advanced Find
dialog box, and just save it anywhere. The
next time you want to conduct the same
search, double-click this shortcut.

Skip Unknown Mail Senders
If you know that only certain

people are going to send you mail on a
certain e-mail address, you might want
to skip messages that come from
people other than these. You can
specify rules to relocate messages from
those not on your “trusted” list to a
separate folder, called, say, “unknown.”
This also helps in avoiding spam.
Besides, you’ll get only your most-
needed mails in your Inbox, and you
can browse through the files in your
“unknown” folder.

First, you’ll need to create a new
folder in your Inbox. This will be that
“unknown” folder. In the Folder List,
right-click Inbox and click New Folder.
Type in the folder name, say
“unknown”, and click OK. If your
Folder List is not visible, click Folder
List under View. Now, you’ll need to
create a new rule using the Rules
Wizard: go to Tools > Rule Wizard.
Click New, then click “Start from a

blank rule”. Click “Check messages
when they arrive”, and click Next.

In the “Which condition(s) do you
want to check?” box, check the “On this
machine only” box. Click Next. Then, in
the “What do you want to do with the
message” box, click “Move it to the
specified folder”. In the “Rule
description” box, click Specified. Then
click the folder you created—”unknown”—
and click OK, then Next.

Under “Add any exceptions”, check
the “Except if sender is in specified
Address Book” box. In the “Rule
description” box, click Specified. In the
“Add Address List” dialog box, choose
“Outlook Address Book”, click Add,
then click Next. Type in a name for
your rule, click Finish, then OK.

Recurring Reminders
Say you want to add recurring

tasks or reminders to your Outlook
calendar. These might be things like
“Order pizza.” For this, open the
Calendar in Outlook. From the menu,
select Actions > New Recurring
Appointment. In “Appointment Time”
in the dialog box, select a Start Time.
Select the same time for the End Time—
this is so that Outlook will not block
the time on your calendar. Make sure
“0 Minutes” is displayed under
Duration. Input your desired options
under “Recurrence Pattern” and “Range
of Recurrence”. Click OK, then type in a
name for the reminder in the Subject
box of the Appointment Screen. Click
Save and Close.

Quickly Setting Up A
Reminder

If you don’t have the time to respond to
an e-mail just when you receive it, you
might want to add it to your calendar
so that you can be reminded to reply to

MICROSOFT
OUTLOOK XP

Bet You Didn’t Know

FFllaaggggiinngg  CCoonnttaaccttss
If you’ve been using Outlook, you know
that you can flag e-mail messages for
follow-up. But did you know that you can
also flag contacts? Once you’ve flagged a
contact, you will receive a reminder to take
the action you specify.
To flag a contact, open your Contacts folder
and right-click on the contact you want to
flag. Select Follow Up from the drop-down
menu. Select the desired action, date and
time, and click OK. This is the date and
time when you will receive the reminder.
At that specified appropriate time, a
reminder window will pop up to remind
you that you need to take an action with
this contact. Click Open in the Reminder
box, and the Contact’s information (e-
mail address, phone number, and more)
will be displayed.
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it later.
Drag the message from your Inbox to

the Calendar icon on the Shortcut Bar.
Outlook will create an appointment that
includes the text of the message. Make
sure the start time and other details are
entered, and also make sure the
Reminder box is checked.

Saturdays And Sundays
By default, Outlook combines

Saturday and Sunday into one column in
the month view of the Outlook Calendar.
Of course, this is customisable: you can
change it to make it show a separate
column for the two days.

So where’s the command? Right-
click anywhere on the Calendar and
select Other Settings. Remove the
checkmark from the option that says
Compress Weekend Days.

Minimise Outlook To The
System Tray!

You might want to make Outlook
go and sit in the System Tray
when you minimise it. Here’s how
to make it do this: open the
Registry Editor. (Remember to
make a backup first.) Navigate to
HKEY_CURRENT_USER\Software\
Microsoft\Office\10.0\Outlook\
Preferences. Add a new DWORD
value called “MinToTray”. Assign
it a value of “1”.

Attachments Taking
Long To Open?

Some folks might experience
this problem: when you double-
click an attachment, the
computer seems to hang,
although the attachment
eventually opens. There is a way
to rectify this. When you double-click
on the attachment, the familiar dialog
box is displayed, asking you whether
you wish to open the attachment or
save it to disk. Beneath that is a box
that says “Always ask before opening
this type of file…”. This box is checked
by default. Uncheck the box. Opening
future attachments could be
significantly faster.

The Intrusive Read Receipt
Read Receipts can be irritating.

For example, it could seem rude if
someone asks for a Read Receipt and
you don’t send one. At the same time, if
you do send one, it will indicate what
time you opened the message—an
invasion on your privacy!
You can choose to mark which
incoming messages have Read Receipts
attached: set your Inbox to display that
field. At the Inbox menu, select View >
Current View > Customize Current
View. Click the Fields button.

In the “Select Available Fields
From” box, make sure “All Mail Fields”
is selected. Select “Receipt Requested”
from the “Available Fields” box. Click
Add to add it to the list of fields that
display in your Inbox. Keep clicking OK
until all dialog boxes go away.

Setting Up An Auto-Mailer
Say you use Outlook only while

you’re in office. If you plan on being
out of the office for a while, you can
configure the Out of Office Assistant to
automatically respond to any e-mail
you receive while you’re away.

From the Inbox menu, select Tools
> Out of Office Assistant. Complete the
dialog box and click OK. Outlook will
send the response you’ve indicated for
as long as “I am currently out of the
office” is selected. When you return,
follow the same path as above and
click “I am in the Office” to deactivate
the Out Of Office Assistant.

Emphasising Text
To give your text some kind of

emphasis, highlight the text, right-click,
and select Font. When the Font dialog
box appears, select Text Effects. A list of
effects will appear such as Shimmer,
Blinking Background, and more. Select
your desired effect. You can see how it
will look in the Preview area. Press OK
to close the dialog box.

Delete The Fonts 
MRU List 

Word maintains a list of most recently
used fonts, which appear at the top
when you click the fonts drop-down.
You’d like to modify the list, wouldn’t
you? But you can’t! However, you can
turn it off completely using the
Registry Editor, which you might want
to do in a number of situations—for
example, if you’ve just experimented
with a lot of fonts, and all of them
keep appearing.

Navigate to HKEY_CURRENT_USER\
Software\Microsoft\Office\10.0\Word
\Options. (The “10.0” becomes “11.0” if
you’re using Word 2003.) Choose Edit >
New > String Value, and call it
NoFontMRUList. Press Enter. Now with
the NoFontMRUList string value
selected, choose Edit > Modify. In the
Value Data box, type in “1”. Click OK
and exit the Registry Editor. You can,
of course, change the setting back by
changing the value to “0”.

Paste Quickly
Not too many folks use the

[Insert] key to switch between insert
and overwrite mode. You can turn the
[Insert] key as a shortcut for pasting.
Go to Tools > Options. In the dialog box
that appears, click the Edit tab. Check
“Use the INS Key for Paste” and close
the dialog box. Now whenever you press
[Insert], the contents of the clipboard
will be pasted into the document.

Save All And Close All
If you’re working on several

documents at once, you may want to
save or close all the documents
without closing Word. To do so, hold
down the [Shift] key and click the File
menu. The Save option will become
“Save All”, and the “Close” option will
become “Close All”.

Pinacle Ad

QQuuiicckk  MMeessssaaggiinngg
To quickly create a new mail message to an
Outlook contact, drag the contact to the
Inbox on your Outlook Folder List. Of
course, the contact must have an e-mail
address associated.

Bet You Didn’t Know

MICROSOFT 
WORD XP

Turn off that MRU Font List
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Nimish Chandiramani

They did it again, minus the
“oops.” Google’s SketchUp will go

down as yet another of Google’s
victories, this time in the world of 3D
modelling. You will find SketchUp on
the June 2006 CD. Here’s the dirt you
need to get cracking at creating your
own monument.

Getting Around Quickly
When you start SketchUp, all
you will see is a 2D human

figure. To move around the centre of
the scene (called orbiting), hold down
the middle mouse button and drag
the mouse. To move from side to side
(called panning), hold down [Shift] as
well. Alternatively, you could press [O]
to select the Orbit Tool and use the
left mouse click, and hold down [Shift]
when you want to pan.

Start Building!
To lay the first block (which
you will then manipulate to

turn into a house), first select the
Rectangle Tool (shortcut: [R]) and
draw the rectangle as shown in the
screenshot alongside. Then use the
Push Tool (shortcut: [P]) to give it
some depth.

More Complex Building
You can now draw rectangles
(or circles (shortcut: [C]), for

that matter) on the surface of the box
you just made. To be absolutely sure
you’re drawing on the surface, just
hover the cursor where you’re
drawing, until a tool tip tells you
where you’re drawing. And once you
draw these rectangles, you can use
the Push Tool again to create
protrusions and dents.

Real-World Dimensions
SketchUp is meant for
building houses, right? So

where does the ever-important
“accurate to scale” part come in?
Hidden in the bottom-right corner,
you will see a little box that contains
the dimensions of the figure you’re
drawing. If you’ve just drawn a new
rectangle, just key in the dimensions
you want—if you wanted 12 feet by 15
feet, you’d type “12’, 15’”. You can
also use other units—“m” for metres,
“in” for inches and so on. This applies
no matter which tool you’re using.

All Are Equal
If you’re modelling something
like a platform, chair or table,

you will obviously need to have legs of
equal height. One way to do this is by
using dimensions as above. However,
you can also use the following simple
method: start with the first leg and

use the Push Tool to push it to where
you want it. Now click on the next leg,
and hover the mouse cursor at the
bottom of the first. The new leg will
automatically extend to that height.
Lather, rinse, repeat!

Cutting Holes In Objects
To cut holes into your models,
first draw a shape on the

surface of the model. Now use the
Push Tool (shortcut: [P]) and push this
shape towards the surface at the other
end. When the two surfaces meet, let
go of the mouse button. Peek-a-boo!

To prevent unnecessary
confusion, turn on the X-Ray display
mode: select View > X-Ray. To make
sure the surfaces intersect properly,
use the method described in Step 5. 

Grouping Objects
Once you’re done poking
holes and making random

protrusions on objects, it’s a wise idea
to group them to prevent any
accidental editing. Hit the spacebar to
switch to the Selection Tool, and draw
a selection box around the object to
select all its edges and surfaces. Now
right-click on it and choose “Make
Component”. Give it a name, and now
you can’t accidentally edit this object.
To edit it, double-click on the
component with the Selection Tool—
you can now edit it while the rest of
the objects in your scene fade out.

nimish_chandiramani@thinkdigit.com

Building Homes In Google SketchUp
Free 3D design tools have never been this easy to use

Digital Tools l Tips & Tricks

The default start-up screen

draw the rectangle, then push!]

Use the Rectangle and Push Tools to create
more complex structures

Hover the mouse cursor to make the 
heights match

1. First draw the hole and push…
2. …then marvel at your handiwork

The little dimension box that nobody sees

1 2
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Using The Mouse More
Effectively

To select a line of text or a paragraph,
you probably move the mouse pointer
over the entire line or paragraph you
want to select while keeping the left
mouse button held down. There’s a
much easier way to do this, which works
with many different software.
Move the mouse pointer to the left of
the line or paragraph until the cursor
changes from the “I” looking stick to
the standard arrow cursor. Click once to
select the current line of text, twice to
select the current paragraph, or three
times to select the entire document.

Sorting Names
Say you have a list of

names in a document, and
need to sort them. You can
accomplish this task using
tables, but if you don’t want to
mess with tables, here’s the
alternative approach.

First make sure the names
in your document are arranged
so there is only one person per
paragraph. Select all the
paragraphs that contain
names. Choose the Sort option
from the Table menu. Word
displays the Sort Text dialog
box. Click Options. Word
displays the Sort Options
dialog box. Select Other.

Erase the contents of the
box to the right of Other,
replacing it with a single
space. Word will now know that you
want to consider spaces as the dividing
point between the sort fields. Click OK
to close the Sort Options dialog box.
Then, use the Sort By drop-down lists to
specify the word by which you want to
sort. For instance, if you want to sort by
last name—which is the word after the
first space—you should choose “Word
2” in the Sort By drop-down list. Click
OK, and your names will be sorted.

Table-To-Text
There will be many occasions

when you want to convert a table to
text. To do this, first select the entire
table. Choose Convert from the Table
menu, then chose Table to Text from
the resulting sub-menu. Word displays
the Convert Table to Text dialog box.
Select an appropriate character for
Word to use to separate the columns of
text. Click OK.

Large Icons In Word 
The icons in the Word toolbar—

such as the disk icon for Save—may be
too small for you, or perhaps you just
like large icons. You can make them
bigger. Under Tools, click Customize.

When the Customize dialog box
appears, choose Options and check
Large Icons. The toolbar icons will
instantly get big!

Adjusting Column Width
If you have a table in your

document, you may find that your
overall table width is the way you want
it, but the columns within the table

are not just right. As an example, you
may want the columns to be the same
width as each other—this without
disturbing the overall width of the
table. To achieve this, select the table
and then choose Table > AutoFit >
Distribute Columns Evenly. Done!

Freeze Tables
If you don’t want your table to

readjust itself to fit whatever you put
in it, Word allows you to freeze a
table’s layout. For instance, you might
want the cells to be a certain size, and
never change even when you place a
large amount of data in the cell. The
first step is to adjust the column width
so that the columns in your table are
the way you want them. Then, choose
Table Properties from the Table menu.
Word displays the Table Properties
dialog box. Make sure the Row tab is
selected. Select the Specify Height
checkbox, and enter a height for the
rows. Use the “Row Height Is” drop-
down to choose Exactly. Now, go to the
Table tab. Click Options. Word will
display the Table Options dialog box.
Clear the “Automatically Resize to Fit
Contents” box. Click OK to close the

Table Options dialog box, then click OK
to close the Table Properties dialog box.

Track Changes Options
If you use the Track Changes

feature in Word, added text is shown in
a different color, and deleted text is
shown with a strikethrough. You may
want to change how Word shows your
changed text. To make your
configuration changes, first go to Tools
> Options. Word will display the
Options dialog box. Select the Track
Changes tab. Using the controls in the
dialog box, indicate how you want your
changes to appear when you have Track
Changes turned on. Click OK.
The following are some of the options
available:

*Track Changes Options: Here you
specify how you want text insertions to
appear. They normally appear as
underlined text in a different colour,
but you can instruct Word to use
different types of formatting for the
text you add to the document.

*Balloons: The controls in this area
allow you to specify if Word should use
change balloons. These balloons appear
at the right side of a document and
indicate the changes made at different
points.

*Changed Lines: This setting is used
to specify how any lines that contain
changes should be noted. Normally,
Word adds a vertical bar to the outside
border of the line.

Deleting Pages In A Document
If you need a quick way to delete a

page in your document, you can use the
following macro:
Sub Delete_Page()
ActiveDocument.Bookmarks(“\Page”).Ra
nge.Delete
End Sub

Assign the macro to a toolbar
button or a shortcut key (we’re
assuming you know how to do so), and
you can easily delete the current page,

Pinacle Ad

Get bigger icons for Word

Use the “Track Changes” feature in Word to
track changes in your documents
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Jayesh Limaye

How can you make your Windows
desktop more useful—for

example, have it deliver the news?
Well, via a generally neglected (and
discarded!) Desktop feature called
Active Desktop, which has been
around since Windows 98. At that
time, it was (rightly) blamed for
consuming system resources and was
irritating, so folks just turned it off.
But as we will see here, the Active
Desktop is surprisingly useful, and
can be used to deliver Web content to
your Desktop even on dial-up.

We’ve chosen two useful sites for
the purpose of this exercise. The first is
www.itools.com, a site that not only
allows you to search the Net right from
your Desktop, but also lets you query
online dictionaries, translate text, and
search for news stories. The second is
http://news.bbc.co.uk, one of the best
news portals around. Get ready for a
surprise!

Turn It On
By default, Active Desktop is
always on in Windows XP.

Turn it on if it is off. To do this, right-
click anywhere on the Desktop,
mouse over to Arrange Icons By, and
click Show Desktop Icons.

Open Desktop Properties
Right-click anywhere on the
Desktop and select

Properties. This will open the
Display Properties dialog box. Click
the Desktop tab and the Desktop
Items window opens. Here, click on
the Web tab and set the Web items
you wish to display on your Active
Desktop.

Create A Web Item
Click the New button. In the
New Active Item box, enter the

URL http://www.itools.com in the
Location dialog box. Click OK. This new
Active Item will now begin to
synchronise itself with the Web, which
will take a few seconds to complete—do
not interrupt the process. Click OK
twice, and the Active Item will be
visible on your Desktop.

Lather, Rinse, Repeat
Repeat step 3 for
http://news.bbc.co.uk, and let

the synchronisation happen. Since
this is a news site, schedule it to
update after a certain interval of time.
Click on the item called
http://news.bbc.co.uk in the Web Pages

window. Click Properties, then on the
Schedule tab. Here, select “Using the
following schedule”. Click Add.

Make A New Schedule
In the New Schedule box, type
in the fields to change the

default schedule. Once you’re done
with the scheduling, click OK thrice.
Both your Active Items will be
displayed on the Desktop with their
current contents.

Moving Them Around
Active Web Items are quite
like regular windows. You can

resize them by dragging the borders.
You can move the entire window by
placing your cursor near the top
border, after which a title bar will
appear: click on the title bar, drag the
window, and place it wherever you
like on the Desktop.

Endnote
You can, of course, place as many
Web Items on your Desktop as

you want, but remember that they do
consume some memory. If you’re low on
RAM, don’t create too many.

Interesting Desktop, eh? 
jayesh_limaye@thinkdigit.com  

Use Windows XP’s Active Desktop
Did you even know your Desktop can ably act as a window to the Web? That “Active
Desktop” means just that? Here’s how to get your Desktop to go beyond icons

Turn on Active Desktop if it is off

Open the Web tab in Desktop Items Schedule the Synchronisation

Your Active Desktop

The web contents get synchronised
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the one in which the insertion point is
located. The macro bases its
determination of a page on the current
pagination of the document, which is
affected by the printer driver you’re
using and, of course, the formatting
characteristics of the document.

Blank And Non-Blank Cells
Figuring out the number of non-

blank cells in a range is not entirely
straightforward. The COUNTBLANK
function returns the number of blank
cells in a range, but what if you want
to count the number of non-blank cells
in the same range? One way is to
use the COUNTA function:
=COUNTA(B1:B13)

The problem with this
formula is that it doesn’t return
the complementary value to what
COUNTBLANK returns. In other
words, the result of COUNTA
added to the result of
COUNTBLANK doesn’t equal the
total number of cells in the
original range. The reason for this
is that both COUNTBLANK and
COUNTA treat formulas
differently. COUNTBLANK
includes, as blank, formulas that
return a blank value. COUNTA
does not consider such cells
blank (even though a blank is
returned), so it includes them in
its count. If you consider non-
blank cells to be those that are not
returned by COUNTBLANK, you will need
to use this formula:
=(ROWS(B1:B13)*COLUMNS(B1:B13))-
COUNTBLANK(B1:B13)

This subtracts the COUNTBLANK
result from the total number of cells in
the same range.

Counting Unique Values
Excel provides several different

ways in which you can count unique
values in a long list. Say you have a
worksheet in which there is a list of
first names, in cells A1:A100, which can
contain duplicates. Say you need to
determine the number of unique names
in the list. First define a named range
that represents the list of first names.
In the following examples, we assume
that the range is named FirstName. If
the list contains only text entries and
no blank cells, the following will
provide a count:
=SUM(1/COUNTIF(FirstName,FirstName))

This should be entered as an array

formula, by pressing [Ctrl] + [Shift] +
[Enter]. If the list contains blank cells,
then the formula becomes a bit more
complex. The following long array
formula will work if there are blanks:
=SUM(IF(FREQUENCY(IF(LEN(Countries)
>0,MATCH(Countries,Countries,0),””),
IF(LEN(Countries)>0,MATCH(Countries,
Countries,0),””))>0,1))

Assigning Names To Formulas
Once created, formulas are

valuable, and you may need to use them
over and over again. Unfortunately,
Excel has no way to paste commonly-
used formulas. But there’s something
you can do to make your formulas more
accessible: assign names to your
formulas in the following manner.

Enter your formula. Select the cell
containing the formula and press [F2].
This brings Excel to Edit mode. Hold

down [Shift] as you use the cursor
control keys to select the entire
formula, including the equals sign at
its beginning. Press [Ctrl] + [C]. Then
press [Esc] to get out of edit mode. The
cell with the formula is still selected.

Choose Name from the Insert
menu, then choose Define. Excel
displays the Define Name dialog box. In
the Names in Workbook box, enter the
name you want assigned to the
formula. Select whatever is in the
Refers To box at the bottom of the
dialog box, and press [Ctrl] + [V]. The
cell reference is replaced with the
formula on the Clipboard.

You need to make sure there are no
dollar signs in the formula. If there are,
select and delete them. This method of
using formulas, therefore, does not
work well with absolute references.

Now, whenever you want to use the
formula, you simply enter an equal
sign and the name you gave to the
formula. Even though the name shows
in the cell, the formula assigned to the

name is actually used in doing the
calculation. Since the formula uses
only relative references since you got
rid of the dollar signs, it is always
relative to where you use the name in
the worksheet.

Formulas And Values 
Excel normally displays the results

of your formulas, but you can also force
it to display the formulas themselves. If
you’re like most people, you choose Tools
> Options, then on the View tab, make
sure the Formulas checkbox is selected.
A much faster way to get the same result
is to press [Ctrl] + [`]. The second key is
the one to the left of [1]. The shortcut is
a toggle, which means you can press it
repeatedly to switch between the display
of formulas and results.

Using the TEXT function 
Say you want a description for

your data. One approach is to put the
description near the cell containing
the data—for instance, a numeric value
could go in cell B1, and the unit
description in cell C1.

Another approach is to put the
description text and the numeric value
together. Creating text strings does
this. So to display “2 + 2 is 4”, you’d use
=”2 + 2 is “ & 2+2

The disadvantage of this approach
is that formatting the value takes more
effort; since the result is a text string,
numeric cell formatting does not apply.
For example, considering the above
formula, say you need to display two
decimal places. You might select
Format > Cell > Number tab and then
choose a Number format that has two
decimal places, but the results would
not change. (The result of the formula
is text, not a number.)

To affect the value formatting, use
the TEXT function. To force the above
results to display the value to two
decimal places, use the following
formula.
=”2 + 2 is “ & TEXT(2+2, “0.00”)
Here’s an example that displays “Today
is” along with the current date. Enter
the following formula:
=”Today is “ & TEXT(NOW(),”dddd,
mmm dd, yyyy”) 

The quotation marks are important,
since you’re constructing a text string.

Pinacle Ad
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Finding The Smallest Or
Largest Values

There may be times when you need to
derive the smallest or largest value
from a range, unless the smallest or
largest value is zero. For instance, you
might have a range of values such as
{0, 3, 1, 4, 2}; in this case, the lowest
value is zero, but the value you want
returned is 1. There is no intrinsic
function within Excel to return such a
value. However, you can use a formula
that will do the trick. Assuming that
the range of values you want to
analyze are in A4:A8, the following
formula will return the lowest non-
zero value:

=IF(MIN(A4:A8)=0,SMALL(A4:A8,COUNTI
F(A4:A8,”=0”)+1),MIN(A4:A8))

This formula uses the MIN function to
determine if the lowest value in the range
is zero. If it is, then the SMALL function is
used to derive the lowest value, excluding
the zeros. The COUNTIF function returns
the number of zeros in the range, and
therefore tells SMALL which item from
the range to pick.

A small change to the formula
allows it to be used to return the
largest non-zero number in a range:

=IF(MAX(A4:A8)=0,LARGE(A4:A8,COUNTI
F(A4:A8,”=0”)+1),MAX(A4:A8))

These formulas will work for any
range, unless the range is made up
entirely of zeros. In that instance, a
#NUM! error is returned.

Concatenating Cell Text
It’s easy to combine the contents

of your cells. Say you have a list of last
names in column A, a list of first
names in column B, and a list of
salutations in column C. If you wanted
to derive a full name for these people,
you could use the following formula:

=C4 & “ “ & B4 & “ “ & A4

The result is that Excel combines the
values from the specified cells and
places spaces between them. The
ampersand character (&) is used to
indicate that Excel should add text
together to create a new text value.

More Useful Averages 
The average value for a set is in

many cases determined by removing
the highest and the lowest scores and
then averaging the rest. You may need
to do similar types of averages. To
perform this type of averaging, you can
use the SMALL function. Consider the
following formula, which assumes you
want to find an adjusted average of the
range A10:A14:

=(SUM(A10:A14)-SMALL(A10:A14,1)-
SMALL(A10:A14,2))/(COUNT(A10:A14)-2)

The SMALL function is used to
determine the two lowest values in the
range, and these are subtracted from
the overall sum of the range. The
resulting value is then divided by the
COUNT of values in the range. Note
that the COUNT value is decreased by 2
to compensate for the fact that you are
ignoring the two lowest values.
Another way to calculate the same
average is to use an array formula:

=AVERAGE(IF(A10:A14>SMALL(A10:A14,
2),A10:A14))

Since this is an array formula, you
need to enter it by pressing [Ctrl] +
[Shift] + [Enter]. It examines each of the
values in the range and only considers
them for use in the average if they are
larger than the second smallest value in
the array.

While the array formula is shorter
than the longer regular formula, there
is one thing to remember: the array
formula will produce an undesired
result if there is a two-way tie in the
second-lowest value in the range, or a
three-way tie in the lowest value. For

instance, if the values
being averaged are 3, 2,
10, 3, and 7, then the
array formula will
produce an average of
8.5. This is because only
the values 10 and 7 are
above the second-lowest
value, and the average
of those two is 8.5. If
you use the longer
formula, then the
average returned is
6.666667, 
which is the average of
10, 3, and 7.

If these formulas
don’t work, check to

make sure you have the Analysis
ToolPak installed. The SMALL function
is a part of the Analysis ToolPak.
Choose the Add-Ins option from the
Tools menu and make sure there’s a
checkmark next to the Analysis
ToolPak option.

What Is Excel Doing?
It’s often frustrating to figure out

exactly how Excel arrives at a
particular result, particularly if the
formula is complex. But Excel provides
a tool you can use to help figure out
what is going on when it evaluates a
formula. To access this tool, select the
cell containing the formula you want
to evaluate. Choose Formula Auditing
from the Tools menu. Excel displays a
sub-menu. From the sub-menu, choose
Evaluate Formula. Excel displays the
Evaluate Formula dialog box.

At this point, Excel shows the full
formula from the cell, and part of it is
underlined. This underlined area
represents the part of the formula that
Excel will next evaluate. This allows you
to see what intermediate steps Excel
follows in arriving at a result. Every
time you click the Evaluate button,
Excel replaces the underlined portion
of the formula with a result.
Nothing you do with the formula
evaluator actually affects the formula in
your worksheet; it remains unchanged.
Instead, Excel simply shows you what
happens as it works through each part of
the formula to arrive at a result.

From CAPS To Sentence Case
Some people type everything in

CAPS, and if you receive a spreadsheet
from one such person, what do you
expect? You can use a macro to select a
range of cells and convert any
constants to “proper case.” After you’re
done, the first letter of each word will
be uppercase, and the rest will be
lowercase. If a cell contains a formula,
it is ignored. Here’s the macro.

Sub MakeProper()
Dim rngSrc As Range
Dim lMax As Long, lCtr As Long
Set rngSrc =
ActiveSheet.Range(ActiveWindow.Selec
tion.Address)
lMax = rngSrc.Cells.Count
For lCtr = 1 To lMax
If Not rngSrc.Cells(lCtr).HasFormula
Then
rngSrc.Cells(lCtr) =
Application.Proper(rngSrc.Cells(lCtr))
End If
Next lCtr
End Sub

The “l” in “lCtr” and “lMax” is a
lowercase “L.” 

Concatenate text from different columns and display the result
in another
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Multi-Session VCDs?
I have Nero 6.0.1. Please tell me how I can write
video files (in VCD format) onto a multi-session

CD, so that I can add video files the next time I write
to the CD. I want to run the CDs on a VCD player.

Also, when a video file is on the hard drive, a
certain size is displayed, say 630 MB. But when I
add this to Nero for writing in the VCD format, it
shows a much smaller size (like 580 MB). Why?

Chatendra Dev

It is possible to create multi-
session VCDs or even DVDs

using Nero. The problem is that the
VCD created may not be playable on
your VCD player, since it will not be
compliant to the standards set by
the VCD industry. You will still be
able to play it on your computer.

Most standalone VCD players
can read only the first session of a
VCD—the remaining sessions will
remain inaccessible to the player.
Some new VCD players support
multi-session VCDs, but since you
haven’t specified what VCD player
you have, you’d do best to burn a
VCD in a single session.

MPEG-1, used in VCDs, provides
352 x 240 at 30 fps, 15-bit colour, and
CD-quality sound. So your video files
get converted to MPEG-1. If you’re burning, say,
an uncompressed video file, the size may reduce
to as much as 10 per cent of the original!
Similarly, if you’re burning a DivX movie, it gets
upsampled since it’s more compressed than
MPEG-1, and you’ll see a larger file size in Nero.

There are two other things to consider here:
first, a VCD is burnt in Mode 2/XA instead of
ordinary data mode. This mode has less error
correction than data mode, so some of the space
reserved on the CD for error correction can be
used to store data. Second, a larger DAT file on
the hard disk appears lower-sized on a VCD
because some of the data is stored in the sub-
channel area of the CD.

Mad At My Modem
I recently bought a v.92 56.6 kbps Krypton
internal modem for my AMD Athlon64 3000+

based PC with Windows XP SP2. The modem only
generates noise and never connects, whereas it
works fine on other PCs.

Abhishek 

Read the modem manual and set the appro-
priate modem initialisation string and also

the country setting. Sometimes, the country
setting might not be “India”; you might have to
use trial and error to figure the correct country
setting. If that doesn’t work, uninstall the drivers
and install the latest drivers from the manufac-
turer’s Web site. You can also try to lower the
baud rate of the modem to, say, 33.6 kbps and
then try to connect. If it does connect, there’s
surely a noise problem with your telephone line,
and you’ll need to contact your phone company
to find a solution. Also try plugging the modem
into a different PCI slot.

DD:MM:YY/HH:MM:SS
When writing files to CD using Windows
Explorer in XP, the date and time of the files

change to the current date and time. Is there a
setting that can prevent this change so that the orig-
inal values are retained?

Dr Kiran K Kalra

When you copy a file to CD, a new
file is created on the CD, so the

“Created” date and time is set to the
current date and time. Bear in mind
that the “Modified” date and time
remain the same as in the original.
This cannot be changed using just XP.

You might want to use Nero
Burning ROM for burning CDs: you
have three options—to retain the
original date and time, to set them
to the current values, or even to set
custom values!

My Music’s Running Away!
I have an Intel 845GL chipset-based
motherboard with a Celeron 2.4 GHz

processor and an AC’97 supported audio
device. I’m running Windows 98. My prob-
lem is that is the speed of the audio—the

tempo—is faster than normal. What can I do?
Sanjay

The problem of audio playback at a higher
tempo is caused if you install the audio driv-

ers for AC’97 audio devices before you install the
chipset drivers for your Intel motherboard, or if
you have not installed the chipset drivers at all.
Download the latest drivers for your audio and
motherboard chipset from the manufacturer’s
Web site. We recommend that you download the
latest chipset drivers for your motherboard from
www.intel.com, which is mentioned as an INF
Update utility. The current version is 6.3.0.1007.

Uninstall the audio driver you’ve installed.
Install the motherboard chipset driver you
downloaded. Then install the audio driver, and
your problem should be solved.

An Obscure Error Message
I recently installed Internet Information Server.
The problem is that whenever I click on Default

Web Site, I get the 0x8ffe2740 error. What does this

Your Questions, Our Answers

Pinacle Ad



92 DIGIT JULY 2006

error mean, and how can it
be resolved?

Nitika Raturi

This error occurs if a
port conflict exists on

the system. IIS uses port
80 for communication by
default. If an application
other than IIS is using the
same port and IP address,
and then when you try to
open a Web site using IIS
manager, you get the
above error.

The error can be
resolved in either of two
ways. Stop the application
that is using port 80 and
then start the Web site
using IIS manager. Or, you
can change the port bind-
ings for that Web site to a
port other than 80 in the IIS manager. To do this,
open Internet Services Manager; right-click
Default Web Site and view its Properties. On the
Web Site tab, change the TCP port number from
80 to a port number of your choice.

Driving Sound
I have a Sound Blaster Live! Value sound card. I
recently installed XP, and it doesn’t have inbuilt

drivers for the sound. They aren’t there at Creative’s
site. Where can I find them?

Anirban Ghosh

The Windows XP/2000 drivers for the Sound
Blaster Live! Value card can be downloaded

from www.fileshack.com/ file.x?fid=544. It’s a 27
MB download.

Covering Your Tracks
Is it possible to clear the Run dialog box
history?

Nishant Joshi

Assuming you’re using XP, right-click on the
Taskbar and choose Properties. Navigate to

the Start Menu tab and then click Customize.
Another pop-up window will appear with two
tabs—General and Advanced. Click on the
Advanced tab and then on the Clear List button.
This will clear all recently opened files and
commands, and it will also erase records of Web
sites visited through Internet Explorer.

If you just want to clear the entries from the
Run dialog box, open the Registry Editor and
navigate to HKEY_CURRENT_USER\Software\
Microsoft\Windows\CurrentVersion\Explorer\
RunMRU. Delete the value corresponding to the
command you want to remove, or remove all
the entries to clear the list entirely.

No Pages Being Made
I am not able to run Adobe PageMaker 6.5. It
displays an error message: “Unable to load icon

DLL for this screen. Continue-8027:6623”. I tried
uninstalling and re-installing the program but the
problem persists. 

Y Thakkar

Do one or more of the following to address
this issue:

Solution 1: Uninstall fonts using the
CorelDraw 6.0 font utility if you have installed
CorelDraw 6.0. Use the bundled font utility to
uninstall the fonts it installed. The FontMaster
6.0 utility installs fonts incorrectly and causes
the issue you’re facing. To remove fonts using
FontMaster 6.0:
1. Close all applications and start FontMaster by
choosing Start > Programs > Corel Graphics >
Corel FontMaster 6. 
2. Select all the fonts in the “Permanently
Installed” section of the Corel FontMaster
window and choose Edit > Delete. You need not
delete fonts from the other sections in this
dialog box.
3. Open the Fonts folder by choosing Start >
Settings > Control Panel, and then double-click
Fonts.
4. Select the fonts that need to be removed and
choose File > Delete.
Solution 2: Temporarily remove TrueType fonts
in the Fonts folder until you have a hundred or
fewer, and then restart your computer. Don’t
remove Windows standard fonts, which are
required by various applications. For a list of
these fonts, see Additional Information. If
PageMaker starts without an error, read the fonts
a few at a time, starting PageMaker after you add
each set of fonts to determine which fonts cause
the error, or how many fonts you can have
installed without errors.
Solution 3: Remove and reinstall PageMaker
Aldfont*.fon files:
1. Locate the PageMaker application folder. Open
the folder and select each of the Aldfont*.fon
files (Aldfonta.fon, Aldfontb.fon, Aldfonte.fon,
and Aldfontf.fon), and choose File > Delete.
3. Reinstall the Aldfont*.fon files by performing a
Custom Install of PageMaker from the installa-
tion CD (that is, select only PageMaker from the
list of items to install). Make sure you install
PageMaker to the same location on the disk.
Solution 4: Delete and re-create the ttfCache file
by exiting all applications, locating and deleting
the file, and then restarting Windows in Safe
Mode to create a new file.

Pretty Darn Funny
I use Windows XP Professional, and I am not
able to download PDF files. When I try to open

a PDF file, a message appears: “An internal error has
occurred.”

Sarabjeet Singh

This problem can be caused by a variety of
reasons. Sometimes, it occurs if you don’t

have enough memory installed. The error can
also occur if you have an older version of Acrobat
Reader installed or if you have more than one
version installed at the same time—in which case
you should uninstall both versions and reinstall

Change the port number for the Web site in IIS
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Create Ringtones And Wallpapers For Your
Mobile Phone

Sanket Naik

Almost all entry-level cell phones
today have colour screens and
polyphonic ringtones, and

allow customisation of these. While
most phones bundle good ringtones
and wallpapers, creating some of
your own has its own charm. Various
applications are available for creating
ringtones; we chose Create-Ringtone
because apart from ringtones, it also
allows you to make custom wallpa-
pers for your screen.

You can download a 15-day trial
copy of Create-Ringtone from
www.create-ringtone.com, and if you
like it—we think you will!—you can
purchase it for $19 (Rs 850).

Creating A Ringtone  
The main interface of Create-

Ringtone is as shown above. To create
a ringtone, select from one of the
three choices listed under the Ring-
tones menu.

For this exercise, we’ll select the
source audio file from the PC; you
can also get it from an audio CD.

Click “Just Run Audio Converter”,
doing which, obviously, starts the
audio converter!

From the File menu, select
“Open an audio File from my

PC”, or press [Ctrl] + [O]. From the
browser window that opens, browse
to any audio file—such as an MP3
file—and select one from which
you’ll extract your ringtone. Upon
selecting the file, the application
will process it and open it in the
editing window.

Once the audio file has
opened in the editing win-

dow, you can select the portion of
the song that you want to set as
your ringtone.

In the editing window, left-
click where you want the portion
to start, then right-click where
you want to end it. Alternatively,
while keeping the right mouse but-
ton pressed, drag the cursor to
select the portion. The selected part
will be highlighted in white.

To play the selected portion,
click Play in the top panel.

While creating ringtones, do
pay attention to the file size.

Create-Ringtone allows saving of
ringtones in both the WAV as well as
the MP3 formats. If your phone does-
n’t support MP3, you will have to
save it as a WAV file. The settings for
both formats are available in the
left-hand corner of the application.

For MP3, we would recommend
you set the bitrate to 64 kbps. The
amplifier allows you to set the loud-
ness—don’t touch this unless your
MP3 is too faint. The final size of the
ringtone will be shown in the status
bar at the bottom. 

Once the settings are taken
care of, you can go to the File

menu and simply click “Save my
Ringtone as”, give it a name, and
select the file format—MP3 or WAV.

Creating Wallpapers
From the main menu, click “Just

Run Image Converter”. It should open
the image converter, which looks
pretty much similar to the audio con-
verter; however, the tools and menus
pertain to image manipulation.

From the File menu, select
“Open Image”, or press [Ctrl] +

[O]. This should open the browser.
Browse to your image collection and
select the image you want to use as
your wallpaper.

Once the image is selected, it
opens in the image converter.

Create-Ringtone has an inbuilt data-
base for screen sizes of selected
phones. Just select the phone model
from the drop-down list, and the
application will automatically crop
the image to match your screen size.
If it fails to, select Custom, and spec-
ify the pixel size yourself.

After choosing the phone model
and selecting the part of the

image to be cropped, go to the File
menu and click on “Save my Wallpa-
per as”. Before clicking Save, give it
a name and select the file format.
Voila! You have a wallpaper ready for
your phone. 

To transfer the ringtones and
wallpapers to your phone, connect it
to the PC via Bluetooth, cable or
infrared. 

sanket_naik@thinkdigit.com

We bet you’d love to have one of your favourite MP3s as a ringtone—and really, it’s easy!
And how about putting your desktop wallpaper on your phone? Here’s how you can

Create-Ringtone’s main user interface

Select the bitrate and amplification

Select your phone model from the drop-down

Select the portion of the song you want to use
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the latest version. Another reason could be that
your firewall or proxy server is corrupting PDFs
while they download. The solution here is to
download the PDF to your hard drive and then
view it rather than viewing it in your browser.

TV-Tuner Trouble
I use Windows XP Media Center Edition.
Recently, I installed a Pinnacle PCTV 50i TV-

Tuner card. It works fine with the Pinnacle Media
Center software, but whenever I start the
Windows XP Media Center TV application, it
shows an error: “Your TV card is not compatible
with Windows or is not configured properly…”
Does this mean that I can’t use the TV card with
Windows XP Media Center?

Siddhartha Biswas

We would like to bring to your notice that
you can only install and use Windows XP

Media Center Edition OS if you had bought a
Media Center PC. Windows XP Media Center
Edition is not available off the shelf and only
comes bundled with Media Center PCs. If you
obtained from elsewhere, it is pirated, and we
cannot help you.

If you have a Media Center PC and are trying
to replace the TV-Tuner with the Pinnacle PCTV
50i, then we must tell you that there are a
limited number of TV-Tuners that are compati-
ble with Windows XP Media Center Edition. Your
TV-Tuner is not supported by this operating
system—hence the error message. You can still
use this TV-Tuner with the OS by installing the
required drivers and using third-party PVR soft-
ware as in other flavours of Windows XP, but it
does not fulfil the TV-Tuner hardware require-
ments of this OS—and hence cannot be used with
the Windows XP Media Center TV application.

You can find out about TV-Tuners supported
by or compatible with Windows XP Media
Center Edition from www.microsoft.com/
windowsxp/mediacenter/partners/dfw/tvtuner-
cardsreq.mspx.

500 Per Cent Indeed!
I use Windows XP Pro and IE 6. I have installed
Internet Download Accelerator. But the down-

load speeds are more or less the same, when

people say it can increase download speeds up to
500 per cent. I use a 128 kbps connection. What
other download accelerators would you recom-
mend? Also, I use Opera 8.5. I can’t incorporate any
download manager into Opera. What do I do?

Saurabh Sood

Download managers try to give you the
highest download speeds from your

Internet connection by splitting the file being
downloaded into multiple segments and then
downloading the segments simultaneously.
The highest download speed you can get is
limited by the speed of your Internet connec-
tion which in your case is 128 kbps. Then
again, the Web site from which you are down-
loading files also is a factor in the maximum
download speed you can get. The 500 per cent
claim is almost rubbish; it does say “up to
500 per cent,” which can be as little as 5 or 
10 per cent!

A good download manager we can suggest is
FlashGet, from www.amazesoft.com. The
FlashGet plug-in for Opera can also be down-
loaded from the same site.

The Registry To The Rescue
I own a cyber café. People come and down-
load files, and I want to change the download

location of the files to a location of my choice. How
do I do this?

Abhishek Yadav

You can set the download path using the
Registry Editor. Browse to HKEY_

CURRENT_USER\Software\Microsoft\Interne
t Explorer and find the String “Download
Directory” in the right pane. Double-click on
this and change it to a valid location of
your choice. This is where files will get down-
loaded the next time someone clicks a down-
load link.

However, this location can be changed if a
new location is specified. To prevent the user
from doing this, navigate to
HKEY_CURRENT_USER\Software\Policies\Mic
osoft\Internet Explorer\Restrictions. If this
value is not present, you can create it. In the
right pane, create a new DWORD called
“NoSelectDownloadDir” and set its value to 1. 

E-mail us your computing
problems along with your
contact details and
complete system 
configuration to
ssooss@@jjaassuubbhhaaii..ccoomm, 
and we might answer
them here! Since we get
many more mails per day
than we can handle, it
may take some time for
your query to be
answered. Rest assured,
we are listening!

Get Help Now!

Is 64-bit Worth It?
I recently bought a new system with an AMD Athlon64
3200 processor, ASUS A8N-VM motherboard with inte-

grated graphics (NVIDIA GeForce 6100 256 MB), 512 MB 400
MHz Transcend RAM, and a Seagate Barracuda 80 GB SATA
hard disk.

Should I install the regular Windows XP Professional with
SP2 or should I go for Windows XP 64-bit? What are the advan-
tages of the latter? I use my system mainly for home applica-
tions and gaming.

Ayush Sobti

While the 64-bit edition of Windows XP has been
around for quite some time now, there isn’t a suffi-

cient number of applications that use the 64-bit
architecture. There are a few, though—for
example, The AMD64 version of Far Cry is avail-
able for the 64-bit version of XP. The AMD64
version is an upgrade that installs on top of the
retail boxed version, and AMD claims it “gives you an
enhanced Far Cry experience.”

Earlier, the non-availability of 64-bit driver support was
an issue with the 64-bit operating system, but 64-bit drivers
for your system are easily available and can be downloaded
from the respective manufacturers’ Web sites.

32-bit applications will, of course, run on XP 64-bit, but
in 32-bit mode—just as in the 32-bit version of XP. So for the
time being at least, there’s no point opting for the 64-bit
version of XP.

Question 

of the

Month
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To begin with, I just love the Mumbai
monsoon: it allows me to take a break from
my usual routine and sit by the window

pane sipping coffee. But somehow, my computer
back home doesn’t like the rains—it breaks down
every year when the rains come!

Having stacked my cabinet with three hard
drives, a deluxe motherboard, two DVD-Writers
and a GeForce 7900 card, my not-so-well-powered
supply died when it tried to satiate the demand. I
still blame it on the rains! Now, I can live without
food or water, but without a computer is out of
the question.

While there is no dearth of options are far as
the availability of brands or models is concerned,
the real problem is finding a good, reliable power
supply. In the absence of a proper test from our
Test Centre, or for that matter by any technology
publication in India, spurious, low-quality power
supplies (PSes) are handed across the counter and
are well-received. With hardware getting power-
hungry, these low quality PSes generally fail to
deliver when overloaded.

Also, over the past year, the hardware industry
has undergone a remarkable change. It has seen
the launch of a myriad new chipsets (the 945, 975,
and more), new technologies in graphics cards (SLI
and CrossFire), new processor architectures (dual-
core), and so forth. The resulting new components
require a power supply capable of providing
sustainable, clean power—since the system as a
whole requires more power than it used to earlier.

While a 350W power supply was de facto a year
ago, and a 400W sold for a premium, with the
new hardware requiring more power, these PSes
are being replaced by 450W, 500W and 600W
beasts. The first question that springs up is, what
wattage do I need? If you’re building
a regular PC with onboard graph-
ics, a single hard drive and an opti-
cal drive, then a 400 W PS is more
than enough to supply your
demand, even at full load. On the
other hand, if your PC has all the
latest and best hardware such as SLI
graphics cards and a top-end proces-
sor, make sure your system has at least
a 500W power supply.

A higher wattage rating, of course,
does not necessarily mean a better PS, so
this shouldn’t be used as a rule of thumb when
buying one. What’s more important is the effi-
ciency of the PS. As of today, most high-end PSes
available abroad typically have efficiencies in the
70 per cent bracket. Some new PSes have been able
to breach the 80 per cent barrier. What does that
mean? Well, if your power supply draws 100 watts
of energy from the mains, it will deliver only 70

watts to the components inside; the remaining 30
per cent is wasted as heat. While the 70 per cent is
for PSes available abroad, the PSes in the Indian
market are not a patch on them in terms of effi-
ciency. There are certain brands that we know are
good for sure, and we shall mention these later. 

There are quite a few things that have
cropped up in the power supply category. To
reduce wire clutter inside the cabinet, manufac-
turers have come up with detachable wires. The
wires have connectors on both ends, where one
end plugs into the PS and the other into the
respective devices. Gamers can soup up their
cabinets by putting up PSes with neon lights on
them. Most importantly, the new PSes support
ATX v2.0. All new motherboards require 24-pin
power connectors and not the 20-pin ones used
by older motherboards. 

Coming down to market realities, Mercury,
HIS, PERX, Frontech, and iBall sell cabinets that
ship with Pses, unless you are smart enough to opt
for something better. In our office of 200 people,
we have used all these brands and have found
nothing wrong with them: they work for three to
four years without problems—unless one stresses
them with loads of hardware. But from our test
lab experience, we can definitely vouch for Antec
for their quality of PSes and performance under
load. Currently, this is the only international
brand available in the Indian market, and is expen-
sive. However, considering the fact that one does-
n’t upgrade a power supply every six months,
spending some extra cash is money well spent.

VIP makes good power supplies, and we have a
couple of them running our test benches 24x7. I’d
recommend VIP to those who can’t afford Antec
but want a reliable power supply. Zebronics, an

Indian company, also offers good power
supplies, especially their Diamond series.
Here, I’m listing some good brands and
models, with prices in rupees. 

Agent 001

More Power To You!
Have you bothered about what power supply your dealer bundled with your computer? If you
have, skip the following! But if you don’t even know what brand of PS you have, read on...

Want more of Agent 001? Turn over to read his
answers to your buying questions

Illustration Pradip Ingale

Power Supplies: Brands & Prices

Rs.600
Rs.1,500
Rs.1,500

1,200
5,500
5,000

400W 500W 600W 720WBrand
Frontech
Zebronics 
VIP

800
1,900
2,800

NA
7,000
NA

Antec Models Price (Rs.)
Antec Phantom 350 10,717
Antec Smart Power SP 350 2,854
Antec Smart Power SP 400 3,636
Antec True Control 550 8,037
Antec True Power TP 550 7,576
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Music On The Move
I am planning to buy a new cell phone soon. I
have my sights set on the new Nokia 3250 music

phone. I need a recommendation: should I opt for this
phone? Are there better music phones around? My
budget is about what the Nokia 3250 retails for.

Vijay

The keypad layout and interface of the
3250 is typical of Nokia—simple and intu-

itive. There isn’t much difference between this
phone and the older 3230 phone. You get a 512
MB Micro SD card to store your music, and a 3.2
mm stereo jack—good, because you can connect
any headphone set. Another phone you should
check out before you choose the Nokia 3250 is
the Sony Ericsson W810i. Since both these are
touted as music phones, and you plan to use your
phone primarily as a music player, I suggest you
get a good feel for both before buying. Go to a
shop and spend some time checking out the
keypad and the music buttons.

A Good Old CRT
I want to buy a good 19-inch CRT monitor. What
brand and model should I opt for? Please give

me two options!
Arindam 

There are hardly any choices in the CRT
market: Samsung, LG, and Philips are the

predominant brands. The choice is further
limited in the 19-inch category. I’d recommend
a Samsung, not because they are exceptional,
but because they seem a little more serious
about the CRT business. (Most traditional CRT
manufacturers are moving to TFT panels, and so
are focusing less on CRTs.) Samsung has a good
CRT line. There are two Samsung models I would
recommend—the SyncMaster 997DF and 957MB.

Cam Confusion
I am planning to buy a digital camera and my
budget is Rs 18,000 to 20,000. I have no partic-

ular model in mind. 
S V Subba Rao

Your budget is good enough to get a really
good digicam. I’m considering street prices

and not the official prices—which are atrocious.
Check out the Panasonic DMC-FZ7: this is a pseudo-
SLR-styled digital camera, has 12x optical zoom,
Leica lenses, and image stabilisation. The FZ7 will
set you back by around Rs 20,000. The only prob-
lem with the FZ7 is its size, and if you’re looking
for a compact point-and-shoot camera, opt for
Canon’s A700 or Sony’s W50 and W70 series. These
will cost Rs 15,000 or so.

On A Tight Speaker Budget
I am an avid gamer and am looking for a speaker
set. I have space constraints, so I’ve decided to

settle for a 2.1 set. Can you suggest a good set that costs
about Rs 2,500? Also, I listen to heavy metal or rock
most of the time, so clarity is of utmost importance.

Akshay

Your budget is too low for me to suggest
a good 2.1 speaker set. The Zebronics SW-

8000 will fit your budget, and it performs well
enough for the price tag.  

Have Money, Will Spend...
I want to buy a home theatre system along with
a large screen TV. As far as large screens are

concerned, I don't understand the difference
between LCD and DLP: could you please elaborate on
these? I have set aside Rs 50,000 for the audio part
and Rs 3 to 4 lakhs for the video devices.

Samrat Mazumdar

Wow, will you adopt me? Four lakhs is
more than enough to build a fantastic

home theatre system. There are two parts to a
home theatre; Video and Audio. The proper
combinations of both makes the theatre experi-
ence richer. As far as video goes, bigger screens
naturally mean a better experience. There are
two ways to bigger screens—first, via multime-
dia projectors, and second, by using large screen
LCDs or plasma TVs. 

You get two types or projectors based on
the technology they use—LCD and DLP. Most
multimedia projectors today are based on DLP
technology, and an entry-level device will set
you back Rs 2 to 3 lakhs. Frankly speaking,
nothing compares to the level of experience a
projector provides; however, your living room
should be long enough for the projector to
project a large-format image. You will also
need a good projector screen. On the other
hand, if you have space constraints, you should
consider opting for a large screen LCD; plasma
TVs are out of vogue. 

If you want to buy a new large screen LCD,
make sure it supports HDMI (High Definition
Multimedia Interface). This is a new interface
capable of transmitting uncompressed, high-
definition video and audio content over a single
cable, thus reducing cable clutter when
connecting home theatre systems.

On the audio front, you will have to invest in
a good “receiver,” probably from brands such as
Denon, NAD, and others, and a 5.1 speaker set
from brands such as Whrafedale, PSB, and Sono-
dyne. Also, to play DVDs, you will require a good
DVD player; brands available are Denon,
Marantz, and some others. A good receiver will
set you back by Rs 40,000; the 5.1 speaker set
will cost you a lakh, and the DVD player another
Rs 25,000. Whoops, I think I just overshot even
your generous budget!

I Want A Nano!
I want to buy a Digital Audio player (DAP). I have
a budget of around Rs 15,000; will I be able to

buy an iPod Nano or Samsung YP-T1?
Mayank Rajawat 

For Rs 15,000, you can easily get your
hands on an iPod Nano. I’m not sure

about the YP-T1 though. If you want to look at
the grey market, you can easily get a 30 GB iPod
Video for the same price. If I were in your posi-
tion, I would have chanced the grey market. 

Want a tech product, but
don’t know how to go
about buying it? E-mail
agent001@thinkdigit.com
with your complete 
contact details, and he
might answer them here!
Please note that
Agent001 only answers
purchase-related ques-
tions in this space.

Ask Away!

Ask Agent 001
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Its marriage time
now—in less than
a month two of
my close friends
found their
respective better
halves. These two
marriages were
arranged in
radically different
ways. Asha’s
(name changed)
parents believed
in the newspaper
matrimony while
Mahesh’s (name
changed again)
family however
moved with the
times and decided
to look at
prospective
brides online.

After some initial coaxing, Mahesh registered himself
on two matrimonial sites—www.shaadi.com and
www.bharatmatrimony.com. Registration took about
15 minutes during which he specified his interests
and gave a brief on his family background. 

He also browsed through existing profiles by using
narrower search criteria. He found prospective
brides matching his interest and his father’s
preference of family background in his city. It took
a little encouragement from his parents to send a
mail to three of the girls whose profile he saw.

A mail followed by a reply, then another mail,
then the inevitable Yahoo! and MSN chat (A
matrimony site even offered a chat service
between members who are online). Though never a
substitute for meeting a person eye to eye, Mahesh
did gain some sort of the insight about the
persons he was chatting with. It must have been
the same for the prospective brides as well.

Our man finally zeroed in on one girl who
seemed to reciprocate his intentions. IMs led to
telephone calls which eventually led to the two
families meeting up.

The comfort level was much better (as far as I could
tell) as each of them knew what exactly the other
was looking for owing to the detailed profiles
online. It was one more match made!

Sifting through contacts and newspaper ads... Looking online for a compatible partner....

1
2

3

4
5

And the winner is… obviously the Tech Way!  You can
create your own detailed profile, view detailed

profiles, and even chat online. Searching through
members of your city, preferred educational background
and career are as easy as specifying search criteria. This,

gives great freedom to the person(s) in choosing his / her
partner besides being really easy to put up a profile. No
visiting the newspaper office, no drafting and cutting
down on words and no waiting for it to appear in print
once a week. Mahesh certainly had it easier!

OLD
WAY

TECH
WAY

Time taken to 
establish contact with groom: 30 days

Time taken to 
establish contact with bride: 16 days

And 
The

Winner
Is...

Kailas Shastry (kailas_shastry@thinkdigit.com)

The parents and the couple-to-be spoke on the phone
for what seemed like hours! Finally, a visit was
arranged with the prospective groom. As the families
spoke, Asha and her prince charming got talking as
well and began sharing their experiences, likes and
dislikes…you get the picture!

Some (no, a lot!) more talks and meetings followed
and it was finally decided that the couple would now
be ‘committed’. One of the marriages was settled!

Finding your life partner!

With Asha’s insistence, after the fourth day, the
family decided not to be dependent on only a single
source and decided to place an ad in Sunday’s
matrimonial section in a leading newspaper. The
number of words was a constraint, and they ended
up editing most of their requirements.

After some struggle to trace the match maker, Asha
and her parents had to patiently explain him their
idea of an ideal groom.  He promised to get back to
them with prospective grooms ‘as soon as possible’—
which turned out to be 8 whole days!

The match maker turned up with 7 horoscopes but all
of them were refused by Asha. The ad appeared on
Sunday  and was followed by eight calls. The ad was
repeated on the following two Sundays and the
family collected half a dozen mails from the
newspaper office during the following weeks. Finally
with Asha's participation the family narrowed down
the choices to three. 
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f you’ve ever spent time in cities such as
Bangalore, Hyderabad and Gurgaon, or,
for that matter, any metropolitan city

you’d probably appreciate how tough it is to turn
a corner without bumping into an IT geek. And
with their populations approaching obscene
numbers, you won’t be receiving respite anytime
soon, especially if you join the brigade yourself!

The lure of the ever-growing Indian software
industry is near-universal. Apart from being part
of India’s biggest industrial sector, you will be
exposed to cutting-edge technology and will get

paid a goodish bit more than your counter-
parts in other fields. However, you don’t
want to jump into it without knowing
what it’s all about, do you?

Getting In
Making your way into a software
company has never been easier.
With the industry growing at a

phenomenal pace, demand is high, and there just
aren’t enough IT professionals in this country.
Some companies have even begun hiring students
from non-IT backgrounds and training them for
the role. Engineers and MCAs, though, still
remain the cat’s whiskers, and a good number of
companies still hire only from that pool.

“Engineers, we find,” says a senior HR execu-
tive from Tata Consultancy Services (TCS), “are
better at conceptualising and reasoning, and usu-
ally do well in the long run. Of course, I wouldn’t
like to generalise.” These sentiments are echoed
by Rakesh Gupta, Director of Engineering at
Impetus Technologies. “Engineering programmes
help a student develop strong logical and analyt-
ical skills, and these, more than technical skills,
make them desirable candidates.”

So what do they look for when hiring fresh
graduates? For starters, you need to have a good
academic record. While a number of companies
don’t specify a cut-off, an aggregate of at least 60
per cent will ensure that you don’t walk away
from your campus notice board cursing under
your breath. In addition, you will have to take an
aptitude test, the format of which varies from

company to company. TCS, for example,
has separate tests for aptitude and per-
sonality. You will also need some basic pro-
gramming skills to do well in these tests. 

Once you clear the aptitude tests, it’s
time for the interview. Says Bharti Kakroo,
HR Manager at Impetus Technologies,
“We conduct two separate rounds of inter-
views—one to judge the technical knowl-
edge of the candidate, and another to
judge his or her personality.” 

I’m In! Now What?
Once you’ve been selected by a company, your
training begins. Training typically lasts three to
four months, and will cover all the fundamentals
you need—programming and database concepts,
developing algorithms and so on—before you are
trained on a specific platform such as Java or .NET.
Non-computer engineers needn’t worry—compa-
nies have standardised training programmes that
take this into account, and by the end of your
training, you’re going to be just as well-placed
technically as the rest of your batch.

I

#include me_too.please
Here’s how you
can edge your
way into India’s
most wanted 
tech career

Tech Career

How Technology Can Help Your Organisation
Business
Digital
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Live Chat 
Or Dead?110

Illustration Chaitanya Surpur
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Training also helps build communication
skills and soft skills such as working in teams—all
to help you better fit into the company.

Database fundamentals are usually taught
using Oracle as a reference, but this doesn’t
mean you’d be working with Oracle once out of
training. However, the front-end technology
you’ll be trained on, be it Java, .NET or any-
thing else, is usually decided based on the com-
pany’s requirements, with some thought given
to your preference. A notable exception to this
rule is Larsen & Toubro (L&T) IT, whose training
covers all the technologies you might work on,
letting you further build your skills once
assigned to a project.

The Long And Winding Road
For an idea of the path your career can take in
the software industry, take a look at the mind-
map above. As you can see, there are distinct
tracks you can follow depending on your passion.
Incurable geeks will most likely find happiness
in R&D and architecting software; the half-geek-
half-management types are best suited for project
management.

From time to time, you will be encouraged to
take various certification examinations. As
Rakesh Gupta puts it, “On-the-job training is good,
but it doesn’t have a specific target. Certifications
help individuals brush up on their technical
skills, and define a base for their knowledge.” 

What’s Next For The Industry?
While it may sound foolishly jingoistic, there is a
remarkable amount of truth in the statement
that the Indian software industry can only go up.
Many companies from abroad have started setting
up shop here, contributing to the already bloating
number of jobs in the sector. And think about it—
Indian companies mainly provide customised
solutions to specific clients today. We’ve yet to get
both feet into commercial
product development,
and when that time
comes, it’s going to be
as exciting as an
exploding goose! 

nimish_chandiramani@
thinkdigit.com

Keen on joining a start-up company, but wondering whether it’s the best for
you? There will always be a bunch of mavericks that break away from the

“safety” of a larger company to write software for a smaller one. Working for
a small organisation will ensure you don’t get lost in the crowd, a common
concern now that bigger companies are hiring hundreds of people at the
same time. The lesser manpower translates into more work and more
responsibilities for you, which in turn will help you learn more. So, as the
company grows, you grow too. 

But there are things you need to think about first. Says Akshat Jain,
Systems Engineer with NeoAccel Inc., “It’s a job that requires a lot of passion.
We find ourselves in ‘all work and no play’ situations most of the time, and
you’d end up extremely frustrated if you don’t love the job.”

And who knows—if you’ve got stock options in the company and they get
bought over by a big multinational, you could become a millionaire overnight!

Small Is Beautiful?

The Road Ahead. This is just a general
idea—the actual job titles and number of
sub-levels for each organisational level
may vary

Trainee

Software
Engineer

Project/
Tech Lead

Project
Architect

Research &
Development

Project
Manager

Group
Software
Manager

Analyse, develop and test the unit assigned to you
Gain experience and exposure 
There are usually multiple grades of Software
Engineers

Take ownership of a complete module—the 
technology and the team
Contribute to its technical architecture 
Interact with the customer

Research new
technologies and
feasibility of use
Recommend and
implement good
programming practises
for the company
Develop reusable
components for use
across projects

Design projects at the highest level
Evaluate technologies for use on project

Maintain customer
relationships for your
project
Take a bigger role in
organisational activities
Act as a consultant to
other projects as well

Manage customer
relationships for many
projects
Participate in the cultural
training and induction of
newcomers

Learn the technology used in the organisation
Learn the organisation’s philosophy and culture
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bout as mystical and “ooh”-provoking as
the Matrix itself is this crazy new con-
cept called The Grid. Still being

researched by universities and big corporations
alike, Grid Computing will change the way the
network works. Soon, we will be able to harness
the processing power of every computer on the
Grid to make complex processing the matter of
a jiffy. This, however, is a scenario we’ll have to
wait for—for now.

And then there’s the case for Grid Storage.
The term is quite suggestive—grid storage is
when you don’t have one dedicated file server
for your LAN; rather, the task of storing data can
be extended to nearly every computer on your
network. 

The Grid And You
So what use could you possibly derive from a
storage grid in your office? Well, for one thing,
you won’t need to invest in a pow-
erful built-for-serving-files machine
as a file server—you could actually
make do with a few half-decent PCs
that nobody is using any more. 

More important, though, is the
question of failure. When your cen-
tral file server decides to pack up,
you and your team will most likely
spend the rest of the day twiddling
your thumbs or playing table-tennis,
generally not doing much to earn
their worth—we know from experi-
ence! However, a storage grid is quite
like having a RAID (Redundant Array
of Independent Devices) setup over a LAN—if one
unit goes poof, there are always the others to
keep your data available. 

Still not convinced? With a storage grid, you
can squeeze the most out of old hardware even
after it’s time to upgrade the rest of your PCs—
just add it to the grid and go! 

By now, you’re probably curious to know how
exactly you can turn your office LAN into a
storage grid, so here goes.

GridBlocks DISK
GridBlocks is an open source project by the
Helsinki Institute of Physics. GridBlocks DISK
(Distributed Inexpensive Storage with K-Avail-
ability) is one of the three applications they are
working on—its purpose is quite obvious from
the acronym. Unlike solutions such as SCSI or
SATA RAIDs that would set you back a pretty
penny, GridBlocks DISK (GB-DISK) will make full
use of the resources you give it, with a near-zero
investment.

GB-DISK ships as Java .jar files, and is thus com-
pletely platform-independent. So even if your grid
is a mix of Windows and Linux servers, you should
face no problem at all. If you wish to try out GB-
DISK, you can find it on this month’s DVD.

How GB-DISK Works
The GB-DISK architecture consists of two main
components—the Front End service (FE) and the
Storage Element service (SE). Users will interact
with the FE, which will break the file into
“stripes” and spread them to SEs on the network.

It also saves the metadata—data about the files—
to the Infosystem, where it is accessible to all GB-
DISK services on the network. 

Downloading files from the grid works in the
opposite way. When a user requests a file using
the FE, it uses the metadata to determine where
it has stored the different fragments of the file,
and begins to download them. Once all the frag-
ments have arrived, the FE strings them together
to form the original file.

All this isn’t apparent to the user—all he or
she will see is a plain old Web page or Web folder. 

Firing It Up
Before you start using GridBlocks, you will need
the Java Runtime Environment. Once you’ve
installed that, start the Windows command
prompt (Start > Run > “cmd”) and navigate to the
folder you extracted the GB-DISK files to. To start
the Front End service, use this command:

java -jar gb-disk-fe-0.8.1.jar
Once you’ve started up a Front End, you need

to complement it with at least one Storage Ele-
ment. You can start the SE service on the same PC
as well, making it take part in the actual storage.

The best answer
to your storage
woes is to share
the load

A

Divided We Conquer

100 DIGIT JULY 2006
Illustration Shrikrishna Patkar

The GB-DISK architecture

WebDAV
WebDAV stands for Web-based Distributed
Authoring and Versioning. When Tim Berners-Lee
conceptualised the Internet, one of his intentions
was to make it a writable medium as well—
basically, you should be able to use the Internet
the way you would use your own hard disk. The
WebDAV protocol is an extension of the HTTP
protocol for data transfer over the Web. Nearly all
operating systems come with inherent support for
WebDAV, letting you use files on the Internet as if
they were stored right on your PC.

HTTP/
FTP

GridFTP

Office
LAN

Storage
Elements

Front
Ends

In
fo

sy
st

em
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To start the SE, use this command:
java -jar gb-disk-se-0.8.1.jar
You will want to set up multiple Storage Ele-

ments—certainly more than Front Ends—this
way, you can have some machines dedicated to
the task of storage, rather than having to
manage storage and the interface. 

Once you’re done setting up Front Ends and
Storage Elements, you can start using the grid.
You can either use a browser, or set up a Web
folder. To use your browser, just navigate to
http://[IP Address of Front End]:8080/gb-disk

Using this interface, you can now choose the
files you want to upload to the grid. To see the
fate of your files, you can use the above address
and replace the IP address of the Front End with
the IP address of a Storage Element. What you
will see is a bunch of incoherent file names that
actually represent the fragments of the files you
uploaded through the Front End. 

If you would prefer not to use the browser
and have it look more like the familiar Windows
folders, you can set up a Web Folder—GridBlocks
supports the WebDAV protocol (see box WebDAV)
and will let you do this. Just open My Network
Places and select Add Network Place. When
asked where you would like this network place
to be created, select “Choose another Network
Location” and click Next. In the Internet address
field that comes up, use the aforemen-
tioned address. You can now view
the contents of the storage grid in
a transparent folder-like environ-
ment.

Finally, if you’re feeling par-
ticularly geeky, you can use the

command line to manage files on the grid. Using
the command prompt, navigate to the folder
with the GridBlocks .jar files and use the fol-
lowing command:

java -jar gb-disk-0.8.1.jar [put/get/delete/
exists] [file name] [FE URL]

Adding more machines to the grid is as easy
as can be—just launch the SE service. Launching
the Storage Element service automatically sends
out a message to all the other machines, effec-
tively saying, “Hey, I’m here to share the load
too!” 

Nearly There
With all this capability, and completely free to
boot, you would probably want to embrace GB-
DISK with open arms right about now. Be
warned, though—it is not without its limita-
tions. Firstly, support for subdirectories is shaky,
and you will most likely encounter failure mes-
sages if you try uploading folders. 

Secondly, while it does support authenti-
cating users to have their own private folders
(you will find a “private” folder through the
front end), this feature is buggy at best and not
recommended for use.

Finally, with a dearth of proper documenta-
tion, configuring GB-DISK can be quite the pain
in the hindquarter area. 

All this aside, if what you’re looking for is a
place to dump files where they will be available
almost perpetually—even after failures of one or
more machines—this is the solution for you.

On the bright side, the GridBlocks team seem
to be working night and day to perfect their

program. Scarcely had we finished
bundling version 0.8 of the software on
the DVD than they came up with ver-
sion 0.9! You can track their progress at
http://gridblocks.sourceforge.net.

nimish_chandiramani@thinkdigit.com

The Front End, as seen through your web browser

Setting up the Web Folder

Ah, the comfy world of Explorer-like folders

What happens to your files in the Storage Elements
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Jayesh Limaye and Kailas Shastry

O
ne device, many functions, is the core
philosophy driving innovation today.
Consumers want more from a single
device—and manufacturers are only too

happy to oblige—at times even creating the need.
Printers that can scan are preferred over vanilla
printers. It makes more sense to have a copier on
the device even if it cannot compete in quality or
economy with standalone photocopiers. You now
need not get your photos scanned at your “DTP
Centre”—the scan quality of most of these MFDs
is good enough to convert your old photographs
into digital data.

The 18 inkjet Multi-Functional Devices (MFDs)
we received from Brother, Canon, Epson, HP and
Lexmark ranged from the bare-bones basics to
those with photo-quality printers. Needless to say,
the price disparity was huge, and it would not
make sense to compare a Rs 4,000 MFD to one that
costs Rs 12,000. For this test, therefore, we made
a broad classification based on their photo-
printing capability. All non-photo class MFDs were
looked at as home solutions, while photo-quality
MFDs were segregated, based on price, into Office
and Professional categories.

Fourteen of the 18 MFDs fell under the photo-
printing bracket, and those that cost below
Rs 10,000 are primarily targeted at office users.
The ones on the other side of the five-figure mark
are for imaging enthusiasts and for heavy office
printing, with bulk printing and networking
capabilities. 

FOR HOME USE (NON-PHOTO MFDS)
Performance
Mostly used for black and white printouts, an occa-
sional colour print that is not all-important, and
the copy function used when in a tearing hurry—
that sums up the functionality of this category.
The Lexmark X3350, Epson CX3700, Brother MFC-
3240C, and the HP Officejet 4355  All-in-One make
up this bracket. Colour printing is certainly not
the strong point here, save for the 4355. Even black
ink printing is not up to the mark on the Lexmark
and the Epson. This is especially telling with small
point size text. The HP 4355 and the Brother 3240C
offer the best quality amongst the four here. 

Even though these devices are classified as
non-photo printing MFDs, we still carried out a
photo print test just to see whether they managed
vivid colour prints. We were in for a pleasant sur-
prise, with the 4355 and the 3240C giving us a
rather good printout. In fact, the photo quality of
the 3240C is better than its brother, the Brother
MFC-115C, which is marked as a photo printer! The
HP Officejet 4355 can give some photo printing
MFDs a run for their money. The CX3700 managed
to give an acceptable print, but the same can’t be
said about the X3350—it churned out a speckled
image that had a “burnt” kind of effect.

Print quality, time taken to print, and ink
consumption are the variables in the printing
equation. Different printers/MFDs find different
points of balance under different modes—Draft
or Fast, Normal, and Best or Fine. The HP 4355
took a reasonable 15 seconds for the first print
in Draft mode and 23 in Normal. The 3240C took
the longest to print on the average, with a draft
text coming at 23 seconds; a full A4 photo test
print took over 16 minutes.

The colour copy quality was satisfactory with
the Epson CX3700 and HP Officejet 4355, which
took a leisurely 97 and 72 seconds respectively to
copy an A4 document composed of text and
graphics. The Lexmark X3350 and Brother MFC-
3240C were quicker, taking just about half the
time as the Epson, but the pace is of no avail as
the quality leaves a lot to be desired.  The black
and white print copy was acceptable on all the
MFDs, with the 3240C spitting out something
that was a little smudged.

Build Quality And Ease Of Use
The CX3700 was missing a display,
which is surprising, given its price of
Rs 5,999—Rs 1,000 more than that of the
Lexmark X3350. The X3350 and 3240C
have a basic single-colour display,
making life that much simpler for
the user, especially during trou-
bleshooting. 

The lack of a display on the
CX3700 is compensated for with a
dedicated button for head cleaning,
which doubles up to get the print
head into an accessible position
to replace the cartridges. Error
indication is by way of two warning lights,
one for a “General Error”—that is just as descrip-
tive as the Epson gets—and the other for low/no
ink. The paper feed and output trays fold in neatly,
leaving no protruding parts while not being used.

The X3350 is the most inexpensive MFD in this
category at Rs 4,999. Unfortunately, this shows in
the fit and finish. There is no place for the paper
feed tray to slot into while not in use, and as a
result, it sits awkwardly on the cover. The buttons
are noisy, too.

The HP 4355 has plastic trays jut-
ting out everywhere. It is difficult to
close the output tray once you have the
face-plate installed. The Brother MFC-
3240C and the Epson CX3700 had
good build qualities.

The HP 4355 doubles up as a
phone as well—and why not, con-
sidering it already uses the phone
line to fax. Now this is an MFD that
is truly multifunctional. Space has
definitely been the priority in the design
of the 4355—it is compact and has a flip that
covers the buttons while leaving the display
exposed. However, with all flaps and trays open, it

A device that prints, faxes, and copies our documents? We’re all for one!
Join us as we go under the hood of 18 inkjet multi-functional devices

HP Officejet 4355 All-in-One

JULY 2006

JULY 2006

Brother MFC-3240C
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demands more space for itself. The build quality is
reassuring, and our only crib is that its pure white
body is an open invitation to stains.

A quirk with the Brother 3240C is that the
USB cable plugs in inside the printer: you need to
open the cover that exposes the cartridges and
then plug the cable in, guiding it along a narrow
recess. There simply is not enough room to com-
fortably accommodate the ferrite core that comes
at the end of most cables. This holds good for all
the Brother MFDs across all the categories.

Our Conclusion
Good print quality is essential, and HP’s Officejet
4355 All-in-One and Brother’s MFC-3240C scored
well on that front. Between these two, the 4355
with its rich feature set and compact form right-
fully takes the Digit Best Buy Gold award. Losing
this position by a whisker is the Brother MFC-
3240C, which wins the Digit Best Buy Silver award. 

FOR OFFICE USE: PHOTO MFDS UP TO
RS 10,000
Here you will find MFDs that boast of photo-
printing capability and do not cost a bomb
either. These are suitable for both the home and
SoHo segments. Printing the occasional photo
along with the usual black-and-whites at home,

and volume printing for the SoHo user—these
units are suited to both scenarios. 

Performance
The Brother DCP-115C, at a very affordable
Rs 4,490, marks the entry point to this category.
Its print quality looks acceptable from a distance,
but once you bring it under even a low-powered
magnifying glass, faint lines show up in the black
text. At the Fast setting, these lines are easily
apparent to the eye. You have to choose the Fine
quality setting in order to get rid of them.

The DCP-115C takes 17 sec-
onds for the first print—not
great news in an office setting.
In Normal mode, the time taken
was 26 seconds, the highest in
the category. A full A4 photo
printout generated some bands
in the print, which doesn’t speak
too well for uniformity. At a dis-
tance, though, the print can pass off
as satisfactory.

The copier function is just about passable,
with black as well as colours appearing washed
out. The DCP-115C is cheap, but these are the
compromises you need to make if you are on a
tight budget.

The Test Bed
Our test bed for the Inkjet MFD tests
comprised an Intel Pentium 4 3.6 GHz
processor, an Intel 925XCV motherboard with
1 GB of Micron 533 MHz DDR2 RAM, an
NVIDIA GeForce 7600 graphics card, and a
120 GB 7200 rpm ATA IV Seagate Barracuda
hard disk. We used Windows XP with SP1 as
the OS. The system was loaded with all the
latest chipset and graphics drivers as well as
the latest version of DirectX. 
We used the following media: 
Text/combi-document printouts: 100 g/sm
paper from Berga (A4 size)
Photo printouts: 270 g/sm glossy photo
paper from Novajet (A4 size)

We divided the MFDs into three
categories. The non-photo printers comprised
the Home category. The Photo MFDs were
categorised based on price. Those below
Rs 10,000 came under the Office category,
and the rest under the Professional category.
MFDs that did not fit in any category, or were
priced too high, are given special mentions.

Features
Various features such as PictBridge, memory
card readers, input/output tray capacity, and
maximum print and scan resolution were
noted. For the scanner part, the maximum
scan resolution, bit depth, scanner type, ADF
presence, etc. were noted and rated. For the
copier aspect, the ability to work as a
standalone device, the maximum number of
pages that can be printed in multi-copy mode,
reduction or enlarging a copy, and so on, were
noted. Obviously, most of these features were
standard on the higher-end MFDs.

The Printer Tests
We used a text document to test the raw print
speeds of the printer part of the MFDs. To test
the ability of the MFDs to handle the various
aspects of a regular document, we created a
combi-document with black text interspersed
with graphs and images. The quality settings
used were Draft and Normal for text, Normal
and Best for combi-document (refer to the
combi documnet snapshot in the printer test),
and Best for photo. We clocked the time taken
in each case, and analysed the print quality.
The final test for the printers was the photo
test, where we used 270 g/sm Novajet Glossy
Photo Paper to print an A4 image. We used
the highest available quality settings here.

The Scanner Tests
We tested the scanners for speed using an
average of five previews of an A4 size image.
This was done with the scanner fresh out of
the box, in order to incorporate the warm-up
time. We imported the same A4 size image at
150 dpi and 600 dpi in Adobe Photoshop, and
scanned a full text document in B&W mode at
200 dpi. The scanner then underwent a test
to determine its colour differentiating
abilities using a Kodak IT8 card with different
shades of colour—each a little different from
the preceding one. Next, we tested using the
resolution chart. This is a chart with five
boxes consisting of parallel lines very close to
each other, each with the lines packed more
densely than in the preceding box. We
scanned the resolution chart at 300 dpi. This
test checked whether the scanner could scan
and differentiate between the parallel lines in
the chart, and gave us a measure of the

scanner’s capability to capture minute details.
Finally, we did an OCR test to check the

scanner’s ability to differentiate light and
dark areas: a print article was scanned into
the trial version of ABBYY Fine Reader Pro
8.0 PE, and scanned for wrongly-interpreted
letters. We then counted the number of
misinterpreted characters.

The Copier Tests
We copied the text document in black and
white, and the combi-document in colour,
and rated the MFDs on their speed and
print quality.

The Awards
The scores from Features, Performance, and
Price were given category-relevant
importance. An overall score out of 100  was
calculated. The product that scores the
highest here was adjudged the winner of the
Digit Best Buy Gold award for the category.
The second-highest scorer gets the Digit Best
Buy Silver award for the category.

How We Tested

HP Officejet 5610 All-in-One

JULY 2006

The Kodak IT8 sheet used to test scanning qulity
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The Canon PIXMA MP150 is next at Rs 6,495.
The black print quality is almost as good as that
of the much higher-priced HP Officejet 5610
All-in-One. Even under the magnifying glass, we
could not find any gaps in the print, which is a
good thing—but it does show an occasional
smudge. However, this is no cause for worry: the
print looks good even under close inspection with
the naked eye. Just 10 seconds for the first print
is going to keep a lot of office people happy. For
colour printing, however, the Normal
mode robs images of their
vivid colours. You can
make out speckles that
can even be counted
individually at some
points! This is obviously
an effort to save on ink.
If you need a better print,
you’ll have to set the quality
to Best—the images suddenly
get their life back, which will
leave you pleasantly surprised.

The Brother MFC-215C and the Lex-
mark P6250 are dearer than the Canon MP150
by about Rs 1,000 (at Rs 7,990 and Rs 7,999 respec-
tively). Black printing is better with the P6250, but
it is still not in the league of the HP 5610 or even
the lower-priced Canon MP150. The Lexmark is
one of the fastest printers with just 11 seconds
taken at the Normal setting. The 215C, like its
little brother the 115C, took a lazy 26 seconds. But
when it came to colour printing, the Lexmark pro-
duced very visible bands, which did not go away
even at the Best quality setting. The Brother 215C
produced better colours, but with some specks
visible in the Normal mode—an ink-saving com-
promise again. The Best mode got the prints to
look much better, though the specks could not be
entirely eliminated. Black and white copy quality

Canon PIXMA MP530

This is a heavy-duty MFD targeted at those who want it all. The print, scan, fax are
copy functions are all supported.
The MP530 is capable of printing photos and has special features for this

purpose: the PictBridge feature lets you connect a compliant digital camera or
camcorder directly to the MFD. You can preview a photo in the 6.3 cm colour LCD
screen before printing it. There are five separate ink cartridges to print photos in
colours as close to those of the original image as possible. In addition to being
capable of printing on a variety of media, there is also an attachment that allows
you to print to CDs and DVDs.

A 33.6 kbps modem allows you to send faxes at 200 x 200 dpi. It can receive
and store up to 150 pages of fax while you are away. Up to 40 numbers can be
stored and recalled as required. The Activity Report feature logs all faxes sent and
received from the MFD—a feature useful for system administrators.

The scanner is a 48-bit flatbed and does its job at 1200 x 2400 dpi, which is
good enough for scanning fine details. The ADF can hold 30 pages. The copier can
be set to make up to 99 copies of a document, either in colour or black. 

Build quality is very good. The MP530 weighs 12.8 kg—a bit on the higher side
for an inkjet MFD. Printing was quite fast—it printed the first page in just seven
seconds, and it printed the test photo in an average time of 180 seconds. The
scanner performance, however, wasn’t spectacular, with average scan times, but
the quality of the prints was quite good.

The Canon PIXMA MP530 is priced at Rs 20,995. 
++ Fast Printing Speed
–– Slow Scanner Speed
Price: Rs. 20,995

Brother DCP-115 C

JULY 2006
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Scoreboard                             Home MFDs
JULY 2006JULY 2006

HP Officejet 
4355 All-in-One
28.91

Thermal Inkjet
100
✔

2

1200 x 1200
48
Sheet-fed
NA
✔

✔

✔

25 - 400%
200

✔

3.91
426 x 451 x 330
Power & Data Cable
Mono LCD
2.5

2
3
3
Handset

22.17

15 / 23
68 / 158
444

3.75
3.25
3
3.25
3.5
3

3.5
3.5
3.25
3.5
3.75

13
129
18

3 / 37
3 / 72
12.31
6,499
63.39

Epson
CX3700
14.97

Piezoelectric
100
✔

4

600 x 1200
48
Flatbed
A4
✖

✖

✔

Fit to Page Only
1

✖

5.8
430 x 345 x 170
Power and Data Cable
None
0

2.5
3.75
3.5
None

21.05

19 / 24
93 / 250
643

3
2.5
2.5
2.5
2.75
2.75

3.5
3.25
3
3
3

10
120
22

3 / 37
3.5 / 97
13.34
5,999
49.36

Lexmark
X3350
19.63

Thermal Inkjet
100
✔

2

2400 x 600
48
Flatbed
A4
✖

✖

✔

25 - 400%
99

✖

4.5
442 x 320 x 173
Power & Data Cable
Mono LCD
2.5

2.5
3.5
3
PictBridge

23.76

8 / 11
38 / 67
293

2.75
2.75
3
2.25
2.75
2.75

2.25
3
2.75
2.75
3

18
138
20

2.75 / 31
2.25 / 45
16.00
4,999
59.39

Brother
MFC-215C
24.70

Piezoelectric
100
✔

4

600 x 2400
48
Flatbed
A4 / Letter
✔

✖

✔

25 - 400%
99

✔

5.5
373 x 345 x 135
Power Cable
Mono LCD
2.5

3
3.5
3.25
Multi-card Reader

24.53

26 / 62
55 / 141
441

3.25
3.25
3.25
2.5
3
3

3.25
3.25
3.5
3.25
3.5

19
173
19

2.75 / 24
2.5 / 42
7.51
7,990
56.73

JULY 2006

Brother
DCP-115C
20.70

Piezoelectric
100
✔

4

600 x 2400
48
Flatbed
A4 / Letter
✔

✖

✔

25 - 400%
99

✖

5.5
373 x 345 x 135
Power Cable
Mono LCD
2.5

3
3.5
3.25
Multi-card Reader

24.87

17 / 26
54 / 140
240

2.5
3.25
3.5
2.75
3
2.75

3.25
3
3.25
3.25
3

18
184
20

2.5 / 30
2.75 / 43
13.36
4,490
58.93

None in 
particular
No display 
interface

Fax with hand-
set; compact
Only sheet-fed 
scanner

Good print speed;
PictBridge
No fax

Value for money
Sub-par scan 
quality

Fax feature
Sub-par scan 
quality

Fast scan speeds
Expensive; only 
sheet-fed scanner

Brother
MFC-3240C
27.35

Piezoelectric
50
✔

4

600 x 1200
36
Sheet-fed
NA
✔

✔

✔

25 - 400%
99

✔

5.5
388 x 525 x 279
Power Cable
Mono LCD
2

2.5
3.75
3.25
None

22.60

24 / 61
50 / 128
644

3.5
3.25
3.25
2.75
2.75
2.75

3.25
3.5
3.5
3
3.5

8
127
18

3.25 / 23
2.5 / 45
11.44
6,990
61.39

BRAND
MODEL
Features (Out of 40)
Printing
Printing Technology
Input Paper Tray Capacity
Cartridges/Toner Included
Number of Cartridges
Scanning
Maximum Optical Resolution (dpi)
Bit Depth
Scanner Type
Scan Area
Scan to E-mail
Automatic Document Feeder
Copying 
Option for B&W or Colour
Enlarge/Reduce 
Multiple Copying In Standalone Mode
Fax
Dialpad Provided
Miscellaneous Features
Weight (kg)
Dimensions (W x D x H) (mm)
Cable(s) Provided
Display Interface Type
Menu Ease of Use (So5)
Build Quality
Ruggedness of Flaps (So5)
Overall Ruggedness (So5)
Moveable Parts in Cartridge Bay (So5)
Extra Features

Performance (Out of 40 (Home) or 45 (Office))
Printing
Text: Draft/Normal (seconds)
Combi-Document: Normal/Colour (seconds)
Photo: (seconds)
Image Quality - Combi Document (Normal)
Text Print
Circles in Concentric Pattern
Yellow Text on Black Background
Quality of Reduced Photo
Highlights on Red Berries
Details on Fruit
Image Quality - Photo (So5)
Natural Colour of Skin
Good Contrast in Dark Areas of Plant
Clear Specular Effect on Bracelet
Overall Image not Overly Bright or Dark
Point Size Document (Normal Mode) (So5)
Scanning
Black Scan at 200 dpi (seconds)
Colour Scan at 600 dpi (seconds)
No. of boxes in Visible in IT8 card (out of 22)
Copying
Black Copy Quality (So5)/Speed (seconds)
Colour Copy Quality (So5)/Speed (seconds)
Price Index (Out of 20 (Home) or 15 (Office))
Price (Rs)
Final Score (Out of 100)
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HP Officejet 6318 All-in-One

The HP Officejet 6318 All-in-One is targeted
at small offices that need good performance

at a price that is not too high.
The printer unit is a thermal inkjet with a

print resolution of 1200 x 1200 dpi. It has a
specified duty cycle of 3,000 pages per month,
which is quite adequate for a small office. The
input tray can hold up to 100 sheets of plain
paper, whereas the ADF can hold up to 35. You
can directly print a photo via the PictBridge
interface with a compliant camera. A variety of
memory cards are supported such as
CompactFlash, Memory Stick (MS), MS Pro, MS
Duo, Secure Digital, MMC and xD-Picture Card.
The maximum card size that you can use here
is 1 GB.

The scanner unit consists of a sheet-fed as
well as a flatbed scanner, with an optical scan
resolution of 2400 x 4800 dpi—which is great
for any purpose
including OCR and
photo scanning.
48-bit scanning
ensures that all the
colours of scanned
photos are captured
perfectly.

The printer and
scanner combine to form the copier unit.
You can make up to 100 copies of an original
document and can also digitally zoom from 25
to 400 per cent. If the original document is
smaller than the A4 size, which is the size of
the scanner glass, there’s an option to copy the
document in such a way that it occupies
maximum space in the A4 size copy.

You can send and receive faxes at speeds
up to 33.6 kbps (this figure can be lower
depending on your telephone/fax line). A 120-
page fax memory ensures that you receive
faxes even when you are away from the unit. It
can also be used as an automatic fax/answering
machine, and 110 speed dial numbers can be
stored in memory so that you can easily dial
the required number at the touch of a button.

There is also a facility to block junk faxes
(faxes from spammers). In order to be able to
use this facility, you need to subscribe to the
caller ID service.

As far as performance goes, this MFD was
quite the average. It printed the text document
in 15 seconds, and the photo was printed in 168
seconds. Only an excellent print quality saved
the day for this MFD.

The build quality was quite rugged. The
MFD is network-capable, which is an added
bonus for small offices. The only gripe is that
the trays seemed flimsy. Another issue was that
there were only two cartridges in this printer:
considering that it costs Rs 12,999, we expected
more cartridges, which would have made it
more suited to printing photos.

++ Excellent Print Quality
–– Average Print Speed
Price: Rs. 12,999

Office MFDs
Canon
PIXMA MP150
16.58

Thermal Inkjet
150
✔

4

1200 x 2400
48
Flatbed
A4
✖

✖

✔

Fit to Page Only
9

✖

5.4
443 x 381 x 181
Power Cable
Mono LCD
1.5

2.5
3
3
PictBridge

29.34

8 / 10
29 / 90
223

3.75
3.5
3.25
2.5
2.5
2.75

3
3.5
3.5
3
3.75

20
75
22

3.5 / 25
3.25 / 57
9.24
6,495
55.16

HP Officejet
5610 All-in-One
28.33

Thermal Inkjet
100
✔

2

1200 x 2400
48
Flatbed AND Sheet-fed
A4
✔

✔

✔

25 - 400%
100

✔

5.9
435 x 418 x 235
Power and Data Cable
Mono LCD
2.5

2
3.5
3.25
None

24.70

16 / 21
61 / 145
376

4
3.25
3.5
3
3.25
3

3
3.25
3.25
3
4

16
116
18

3 / 37
2.5 / 73
6.00
9,999
59.03

JULY 2006

Epson
CX4700
16.22

Piezoelectric
100
✔

4

1200 x 2400
48
Flatbed
A4
✖

✖

✔

Fit to Page Only
9

✖

6.8
430 x 354 x 181
Power and Data Cable
Mono LCD
1.5

2.5
3.75
3.5
Multi-card Reader,
PictBridge
26.17

8 / 22
25 / 90
395

2.75
2.5
3
2.75
2.75
2.75

3.5
3.25
3.25
3.5
2.75

16
154
22

3.5 / 38
3.5 / 53
6.67
8,999
49.06

Lexmark
P6250
22.74

Thermal Inkjet
100
✔

2

1200 x 2400
48
Flatbed
A4
✔

✖

✔

25 - 400%
99

✖

4.8
434 x 333 x 178
Power and Data Cable
Colour LCD
4

3.25
3.5
3.5
Multi-card Reader,
PictBridge
26.97

9 / 11
38 / 97
287

3.25
3
3.25
2.5
3
3

3
3.5
3.25
3.5
3.5

28
158
21

3 / 25
2.5 / 39
7.50
7,999
57.21

Excellent print 
quality
No zoom or mem-
ory card support

None in particular
No zoom or mem-
ory card support

Good performance;
ADF
No memory card 
support

Colour LCD; fast 
printing
No Fax
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taken in a single go is only nine, while the others
offer 99. (The HP 5610 offers 100.) Only the
HP 5610 offers sheet feed for scanning, while all
the others make do with a flatbed. The Epson
CX4700 has only a minimal display, which shows
the number of copies set.

A fax function with a dialpad is provided by
the HP 5610 and the Brother 215C. This is com-
plemented by a dedicated fax button apart from
the copy and scan buttons. The other MFDs have
buttons for scanning and copying (separately for
black and colour). 

The HP 5610 had flimsy paper trays that just
about hold on to the unit: a gentle push and off
comes the tray. The CX4700’s scanner cover can
be simply lifted off its body—we wonder why it
could not be fastened somewhere. As far as the
overall build quality goes, the Epson CX4700 is
compact and also more rugged.

Our Conclusion
If we were to consider performance alone, the
Canon MP150 would have been the clear winner
due to its superb print quality and speed. But
life isn’t that simple for MFDs—there is the price
factor and feature set to consider.  The HP 5610
looks good on the spec sheets and performs just
as well. With good printing quality, the Digit Best
Buy Gold goes to the HP 5610. At Rs 4,490, the
Brother 115C is second on the charts offering
value for money, thus earning the Digit Best Buy
Silver award. 

Coming close to second place are the Lex-
mark P6250 and the Brother MFC-215C. Both are
priced the same, and the P6250 scores in per-
formance while the 215C makes up in the fea-
tures. If there were to be a Bronze award, these
two would tie for it.

FOR PROFESSIONAL USE:
PHOTO MFDS ABOVE RS 10,000 
The target market for this segment is businesses
looking for bulk printing and network printing.
These MFDs are heavy-duty machines with
extensive features. Naturally, price is of the least
importance in this category, and it goes without
saying that the most expensive inkjet MFDs land
up in this category.

Performance 
Opening this segment is the Brother MFC-410CN
and the Canon PIXMA MP450 at Rs 10,490 and
Rs 10,995 respectively. The 410CN, like other
Brother MFDs, shows gaps in monochrome print,
which appear as lines under the Normal setting.
The colour print loses out on detailing, which
can only be regained at the Best quality setting.
The MP450 takes a blistering eight seconds for a
Draft print and nine for a Normal, with the num-
bers for the 410CN being 20 and 29 seconds. 

Copying is certainly not a feature the
Brother 410CN can brag about—at least in black
and white mode; the quality is so bad, it looks
like someone took a bad photograph of your doc-
ument and then took a bad printout of the
photo! In colour mode, the text quality is a lot
better, but the graphics seem to contain less of
every colour—essentially the “washed out”
effect. The MP450’s copy appears almost as good

is acceptable when seen from a distance, and just
about passable when viewed closely. Colour
copying was bad on both the P6250 and the 215C. 

Next up was the Epson CX4700 at Rs 8,999. It
took 22 seconds in Text mode, there were no vis-
ible smudges or gaps in print, but the print looked
dull, as if not enough ink had been deposited on
the paper. Copying took 38 seconds for black and
white and 53 seconds for colour. The photo
printout could have been brighter and more vivid.

The most expensive MFD in this category,
the HP Officejet 5610 All-in-One, is just
a rupee short of the 10,000 mark.
Through priced similarly, there is
some difference in the print quality
of the CX4700 and the 5610, with the
5610 being the better of the two. In
fact, it can boast of some of the best
print qualities in this segment. In the
copy test, however, the 5610 was disap-
pointing, given its good print quality and
also its positioning in this price segment. 

Build Quality And Ease Of Use
The Canon MP150 and the Epson CX4700 do not
have a zoom function except for the “Fit to Page”
feature. This is disappointing: all the other MFDs
provide for a 25 to 400 per cent reduction or
enlargement. The number of copies that can be

Canon PIXMA MP830

The Canon PIXMA MP830 supports print, scan, fax and copy functions. Like the
MP530, this one is capable of printing photos. Its five-cartridge printing aims

at enabling printing photos and images with life-like colours at a resolution of
9600 x 2100 dpi. In addition to PictBridge, the MP830 has an inbuilt card reader
that supports a variety of formats: CompactFlash, Micro Drive, SD, MMC, MS, MS
Pro, MS Duo, MS Pro Duo and XD. A photo can be previewed on the 6.3 cm colour
LCD screen that swivels to suit your viewing angle. The CD/DVD printing feature
lets you label the CDs and DVDs that you burn.

The 33.6 Kbps modem can receive and store up to 250 pages of fax while you
are not near the unit. The fax operates without the necessity to connect to a PC.
You can store up to 100 fax numbers in the memory and eight one-touch-dial
numbers. The automatic document feeder (ADF) can automatically scan both
sides of the page without the need for intervention. Broadcast, delayed, and
scheduled faxes are the other features available.

The scanner unit of the MFD is a 48-bit CCD, and can scan at 2400 x 4800 dpi.
The ADF can hold 35 sheets of paper. The copier unit can scan up to 99 copies of a
document, and can also print the copy with a zoom of 25 to 400 per cent.

As expected, the MP830 printed at blistering speeds. The first black and white
text document printed in five seconds flat! Similarly, the photo printed in just a
little over two minutes. Scanning was also very fast, and the
full colour photo was scanned in a mere 29
seconds. The overall scan quality was good, and
the print quality was amazing even in Draft mode.
Sadly, the Canon PIXMA MP830 is priced very
high: Rs 26,999.

++ Excellent Speed and Quality, Duplex ADF
–– None
Price: Rs. 26,999

Phone WebsiteCompany E-MailBrand

Contact Sheet Inkjet MFD

Brother
Canon
Epson
HP
Lexmark

Godrej & Boyce Mfg Co Ltd
Canon India Pvt Ltd
Epson India Pvt Ltd
Hewlett-Packard India Sales Pvt Ltd
Lexmark International India Pvt Ltd

022-55961609
0124-516 0000
080-30515000
0124-2566111
022-26057744

nad@godrej.com
info@canon.co.in
rajeshp@eid.epson.co.in
ashwini-k.aggarwal@hp.com
sandeepk@lexmark.com

www.brother.com
www.canon.co.in
www.epson.co.in
www.hp.co.in
www.lexmark.co.in

Brother MFC-5840CN
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Scoreboard                             Professional MFDs
JULY 2006JULY 2006

Brother 
MFC-410CN
26.94

Piezoelectric
100
✔

4

600 x 2400
36
Flatbed
A4
✔

✖

✔

25 - 400%
99

✔

5.5
373 x 345 x 135 
Mono LCD
2.5
✔

3
3.5
3.25
Multi-card Reader

27.67

20 / 29
54 / 163
405

3.5
3.25
2.75
2.75
3

3.25
3.25
3
3.5

15
167
20

2.75 / 22
3 / 39
9.06
10,490
63.67

Brother
MFC-5840CN
30.68

Piezoelectric
350
✔

4

1200 x 2400
48
Flatbed AND Sheet-fed
A4
✔

✔

✔

25 - 400%
99

✔

10
432 x 340 x 460
Mono LCD
2.5
✔

2.75
3.5
3.5
Multi-card Reader

27.09

22 / 33
52 / 135
376

3.5
3.25
3
3.25
2.75

3
3
3
3.5

15
129
21

3.5 / 26
3 / 45
6.51
14,590
64.28

Canon
PIXMA MP450
22.24

Thermal Inkjet
100
✔

4

1200 x 2400
48
Flatbed
A4
✔

✖

✔

25 - 400%
99

✖

6.2
417 x 443 x 185
Colour LCD
4
✖

3
3.75
3.5
Multi-card Reader,
PictBridge
31.84

8 / 9
29 / 100
105

3.75
3
3.25
2.5
2.5

3
3.25
3
3.75

20
76
22

3.5 / 25
3.25 / 75
8.64
10,995
62.72

Canon
PIXMA MP500
22.03

Thermal Inkjet
150
✔

5

1200 x 2400
48
Flatbed
A4
✔

✖

✔

25 - 400%
99

✖

9.6
448 x 426 x 205
Colour LCD
4
✖

3
3.75
3.5
Multi-card Reader,
PictBridge
30.05

12 / 15
23 / 27
168

4
3
3.25
2.75
3

3.25
3.5
3.25
4

17
74
22

3 / 120
3 / 123
5.59
16,995
57.67

Brother
MFC-620CN
30.80

Piezoelectric
100
✔

4

600 x 2400
36
Flatbed AND Sheet-fed
A4
✔

✔

✔

25 - 400%
99

✔

6
373 x 345 x 165
Mono LCD
2.5
✔

2.75
3.5
3.5
Multi-card Reader

25.57

42 / 62
53 / 139
406

3.5
3.5
3
3.25
2.75

3.25
3
3.25
3.5

17
121
21

2.75 / 33
2.5 / 41
6.83
13,900
63.21

Inexpensive; 
network-ready
Poor black copy 
quality

Network-ready
Slow text print 
speed

High input tray 
capacity;
network-ready
Bulky

Good print 
quality
No ADF

Excellent print 
quality and speed
No ADF; 
expensive

BRAND
MODEL
Features (Out of 40)
Printing
Printing Technology
Input Paper Tray capacity
Cartridges/Toner Included
Number of Cartridges
Scanning
Maximum Optical Resolution (dpi)
Bit Depth
Scanner Type
Scan Area
Scan to E-mail
Automatic Document Feeder
Copying 
Option for B/W or Colour
Enlarge/Reduce 
Multiple Copying in Standalone Mode
Fax
Dialpad Provided
Miscellaneous Features
Weight (kg)
Dimensions (W x D x H) (mm)
Display Interface Type
Menu Ease of Use (So5)
Ethernet Port
Build Quality
Ruggedness of Flaps (So5)
Overall Ruggedness (So5)
Moveable Parts in Cartridge Bay (So5)
Extra Features

Performance (Out of 50)
Printing
Text: Draft/Normal (seconds)
Combi-Document: Normal/Colour (seconds)
Photo: (seconds)
Image Quality - Combi-Document (So5)
Text Print
Circles in Concentric Pattern
Yellow Text on Black Background
Quality of Reduced Photo
Highlights on Red Berries
Image Quality - Photo (So5)
Natural Colour of Skin
Good Contrast in Dark Areas of Plant
Overall Image not Overly Bright or Dark
Point Size Document (Normal Mode) (So5)
Scanning
Black Scan at 200 dpi (seconds)
Colour Scan at 600 dpi (seconds)
No. of Boxes Visible in IT8 Card (Out of 22)
Copying
Black Copy Quality (So5)/Speed (seconds)
Colour Copy Quality (So5)/Speed (seconds)
Price Index (Out of 10)
Price (Rs)
Final Score (Out of 100)
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as the original, leaving no room for complaint.
It took 25 seconds for a black copy and 75 sec-
onds for colour.

Next in line were the MFC-620CN and 5840CN
from Brother at Rs 13,900 and Rs 14,590 respec-
tively. These were the only two in this category
with a sheet-feed mechanism for scanning—apart
from the standard flatbed. Being up in this price
range, one would have expected better quality
from them, but they didn’t seem any better than
the 410CN with black printouts. The 5840CN is a
pleasant change, with colour prints that are good
for the most part. It also boasts of the
highest paper capacity: 350
sheets. Ink saving takes its toll,
bringing up visible specks in
Normal mode. The copy mode,
while not bad, could have been
better on MFDs in this segment,
especially with the Brother
5840CN, which boasts of a higher
scanning resolution and bit depth
than its… brothers. 

At the top of the line sits the
Canon MP500, which has, by far, the
best print quality on offer here. It uses
five colours rather than the standard
four. In Normal text print, there were no
smudges or gaps to be picked up even by a lens.
Under Normal colour printing, speckles are vis-
ible. This can be gotten rid of by using the Best
quality setting. Colour copying takes 123 sec-
onds, and what you get is the best copy quality
in this segment. Our only gripe is that there’s

no network port, something missing on the
MP450 as well.

Build Quality And Usability
The three Brother MFDs all have a fax dialpad
and networking capability, which makes them
better suited for an office environment. The pos-
itive feeling doesn’t persist when we looked at
their build quality: the plastic flaps were not as
good as what one would expect of MFDs in such
a high price range. The scanner cover does little
to inspire confidence in the longevity of the
device; ditto for the paper feed tray. Only the
5840CN exudes a rugged feel. The Canon MP450
and MP500 seem better built than the Brothers,
but we would have liked them better if they had
not been shaky. All the devices here have dedi-
cated scan and copy buttons, making for ease
of use. The Brother MFDs offer a fax button to
ably support their fax keypads. Display, how-
ever, is a simple monochrome on the Brothers,
while the Canons offer colour LCDs.

Our Conclusion
The Brothers have all the glory in the segment,
with the MFC-5480CN taking the Digit Best Buy
Gold despite being the second-costliest device
here. Its good feature set and performance make
up for the price. The MFC-410CN takes second
place—the Digit Best Buy Silver crown, with
a lower price tag, a good feature set, and value
for money. 

jayesh_limaye@thinkdigit.com
kailas_shastry@thinkdigit.com

Brother MFC-410CN
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Live Chat Or Dead?

Kumbh Design is an Ahmedabad-based design firm
specialising in Web site design, logos, corporate identities
and brochures. Their clients, based in India and abroad, are
a mixed set, ranging from technology companies to fan sites.

About seven months ago, we decided to
incorporate a Live Chat system powered by
Boldchat into our site. It was to give us direct

contact with visitors and prospective customers.

Being an online business that caters to clients
from all over the world, we needed a simple,
convenient system to interact with people. Live chat
is certainly more convenient for us than addressing
queries over the phone, and more so for our
customers. Ever since we implemented the service,
we’ve seen a definite increase in the number of
people approaching us for queries. We’ve even
converted a number of these into clients. 

We are a small team right now, and monitoring
the chat in rotation works for us. However, as we get
bigger and the queries increase, having someone
dedicated to addressing queries will be a good idea.

Would we recommend implementing a Live Chat
service to other companies in the same line of
business? Definitely! It makes us approachable to
customers who aren’t local and/or don’t want to be
inconvenienced by having to call us up, especially for
minor matters. We are more than satisfied with the
effect it has had on the way we do business, and we
have no intention of changing that.

Innovision India, established in 1997, is a Web design and
graphics firm based in Gurgaon. Their services also include
search engine optimisation and Web maintenance. In addi-
tion to their Indian clientele, they cater to clients from the
USA, Canada, Germany and Holland, among others.

We decided to implement a Live Chat service
on our Web site to deal with queries from
prospective customers and generate busi-

ness by converting them to clients. 

We found that the idea was wrong for us from
the get-go. Our business doesn’t depend on location,
and a large number of people who contact us for our
services are from abroad. Due to time zone differ-
ences, their working hours rarely matched with
ours, and they couldn’t take advantage of the Live
Chat system—they prefer to contact us via e-mail or
telephone. When they do need to chat with us,
clients prefer other, more feature-rich chat tools
such as Yahoo! and MSN Messenger. 

Another concern for us was the waste of man-
power. It certainly wasn’t profitable to have someone
to constantly monitor the chat—on slow days, the
operators would end up waiting hours for nothing.

Any business looking to implement such a sys-
tem needs to take a look at their target audience
and their timings. Since the chat can be online only
during working hours, it is important to know
whether prospective clients will visit your site dur-
ing that time. Only then does it justify the time
investment required.

As told to Nimish Chandiramani 
nimish_chandiramani@thinkdigit.com

Vishal Verma
Founder/President, 
Innovision India

“We’d definitely
recommend
implementing a Live Chat
service to other
companies”

“It certainly wasn’t
profitable to have

someone to constantly
monitor the chat”

Ramesh Patel
Founder, Kumbh Design Inc.

How effective is the “Chat with us NOW!” button on your site?

Live chat is more convenient
than addressing queries over
the phone

We found that the idea was
wrong for us from the get-go
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Digital Leisure l Touched by Tech

Jyotsna Rege

Artificial limbs. Cochlear
implants. Pacemakers.
People with disabilities

have benefited tremendously
from these marvels of technol-
ogy. But entire eye transplants
apart, a cure for blindness still
seems far away. So how is society
to help the blind lead lives that
could be considered “normal”?

Most learning happens via
association. As children, we see a
fruit red in colour and round as
an orb, and we hear “apple.” The
next time we see the object, the
mind connects the image to the
word—now etched in our
memory—and we know it is an
apple. Association, however, is
not limited to the sense of sight:
the visually handicapped use
touch and hearing to discern,
make associations, and learn.

Using Their Ears
One way of empowering the
blind is to teach them to use
computers: this not only enrich-
es their lives, it also helps them
gain employment. A piece of
software is bringing light to
thousands of lives: called JAWS,
it is a screen reader, and is used
by most training centres for the

visually handicapped all over
the country.

Upon first thought, it sounds
incredible that the blind can be
taught to use computers. The
concept is simple, however: have
the software read out everything
on the screen. JAWS does just
that: everything that is typed—
word for word, letter for letter—
it reads it all out and helps the
user understand what they've
just done and what actions are
available. 

Effective Empowerment
The MN Banaji Institute at
Mumbai for the Blind is one of
the institutes that teach basic
courses in computers. The visu-
ally handicapped here have long
been trained in various indus-
tries such as weaving and stitch-
ing so they can work to support
themselves financially, but it is
only recently that an institute
for the blind has been opened to
instruct them in the use of com-
puters. “To learn and be a part
of the social world is a
human need. Besides,
the use of computers
is so wide-

Technology Beyond Work
Leisure
Digital

spread that to not know how to
use them is a big impediment to
gaining employment. The insti-
tute therefore hopes that the
ability to use computers with
the help of JAWS will make a dif-
ference in gaining employment
for the students,” says Vikas
Joseph, head of the Institute.

The courses are of a six-
month duration. Tanya Balsara,
who herself learnt computing
with the help of JAWS, teaches
the courses and conducts the
examinations as well. The
students are anywhere between
18 and 45 years old. Balsara says,
“It's a pleasure to teach them.
Because of my own disability, I
personally understand their
confusion in not comprehending
a particular detail, so I can take
added care to explain features
and tasks.” 

Sight And Sound
The visually
impaired
rely on
hearing and
touch to
learn, work,
and play.
Enhancing
their
abilities is
a software
called JAWS

132118 Digit’s Believe
It Or Not!

Pink... For
Posh?115 Game on

Touched By Tech

Im
aging Pradip Ingale

Photograph Sandeep Patil



DIGIT JULY 2006

Digital Leisure l Touched By Tech

employment for the visually
handicapped, since they can
interact with customers and use
JAWS to read information off the
computers.” He, however, adds:
“The software is expensive—Rs
44,000—and this is a possible
deterrent to potential employers.
Besides, there are certain other
things to be taken care of. For
example, the earphones have to
be placed in the right slot; it is
difficult for the blind to find a
slot. We need to be sensitive to
such matters even as we prepare
them to be independent.”

A Boon For The Blind
Ram Agarwal, president of the
IAVH, says, “JAWS is designed to
complement MS Word. But it is
user-friendly when it comes to
Skype as well. Now, even Yahoo!
has configured itself such that
the screen reader can read off
the pages of the site. The soft-
ware is American, and when
JAWS was introduced, users had
to cope with the differences in
pronunciation. But today, the
software is designed with an
Indian voice called “Sangeeta,”
which has greatly eased the
problem.

It is important for the blind
to gain mastery over the
keyboard, and there is another
software the IAVH uses—the Talk-
ing Typing Teacher—which helps
students acquaint themselves
thoroughly with keyboard func-
tions.

Besides helping the visually
handicapped gain employment,
which is the primary aim, there
are other benefits associated
with the use of JAWS. For exam-
ple, Braille books can be cumber-
some; with JAWS, the blind can
easily read e-books and e-jour-
nals.

In The Real-World
While the two institutes men-
tioned above do not charge their
students, there are a few organi-
sations that do. The GTL
Foundation (GTLF) is one such
charitable trust that set up an
advanced computer training
centre for the visually impaired
at Wadala, Mumbai, in mid-
2005. The institute teaches not
just basic computer operation
with the help of JAWS, but also
has a “train-the-trainer” pro-
gram for someone who is
already teaching others how to
operate computers, besides

Balsara was a student of the
Indian Association for the Visu-
ally Handicapped (IAVH), located
at the University Club House
near Churchgate station in
Mumbai. The IAVH has been
involved in imparting basic
computer knowledge to the visu-
ally handicapped since 2000. The
students, like those at the MN
Banaji Institute, are taught MS
Office and the use of the Internet
in a six-month course. The IAVH
allows the students to access the
Internet; the computers there
have JAWS installed. Material in
Braille is also provided.

The Keyboard Is Key
A screen reader cannot accom-
plish everything the blind need,
of course, but it helps. To begin
with, the visually handicapped
cannot use the mouse. All com-
mands and shortcuts are there-
fore taught on the keyboard.
They are also familiarised with
the various parts of a typical
computer. For example, after
being explained what a mother-
board and a CPU do, they actu-
ally hold the components, feel
the grids and bumps on the sur-
face of the devices, and get a
feel for what they are. Once they
have the tactile idea in place,
association with the concept
becomes easy.

After getting up to speed with
the use of the keyboard, typing
to and reading from the
computer screen is easy, because,
as we've mentioned, JAWS reads
aloud the letters, words and
sentences on the screen.

Joseph explains, “We see
BPOs as a possible place of

courses that teach program-
ming, medical transcription
and call centre training—all of
which are gateways to employ-
ment. The courses have a nomi-
nal fee associated, and potential
students have certain criteria to
meet. For example, to enrol for
the advanced computer opera-
tions course, a candidate has to
have a grasp of the basic opera-
tions on a computer, and also
needs to clear an eligibility test.

Wouldn't setting preliminary
requirements deter the visually
impaired from pursuing such
courses? “We do not just plan to
train them, but impart thorough
working knowledge so that they
are prepared for work in the soft-
ware industry,” says Charudatta
Jadhav, project manager for soft-
ware solutions at GTL. Jadhav
also oversees the work at the
Centre. “We plan to prepare indi-
viduals so that they can compete
with other candidates for posi-
tions. The idea of having require-
ments is to prepare the visually
handicapped for the seriousness
of the situation.” 

A Helping Hand
Frank Fernandes, head for CSR
(Corporate Social Responsibility)
at GTL, talks about their plans
to develop a screen reader soft-
ware very much like JAWS. If
there will be a difference, it is in
the price. Fernandes says, “JAWS
is expensive, which is some-
thing that anyone who is visual-
ly impaired or who hires a visu-
ally impaired person does not
miss. They all are put to incon-
venience and strained financial-
ly. Hence, we're planning to cre-
ate software that can be
obtained for just about Rs
5,000.” The GTLF plans to use
this software for purely philan-
thropic reasons, and hence will
not be marketing it.  

Besides training, the CSR
activities of GTL include helping
the blind play computer chess:
the company has developed a
software called Talk 64, which
can read chess software.

With evolving technology
and continuous efforts being
channelled towards developing
software for the handicapped,
the disabled can be aided
towards their goals—goals at the
same level as those lucky enough
to be able to perceive the world
through five senses.

readersletters@jasubhai.com
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Digital Leisure l Game On

Spellforce 2: Shadow Wars
provides great divergence
from both beloved genres

(RTS and RPG). Yet it’s this com-
bination that’s thrillingly and
intriguingly addictive! 

Dark clouds threaten as the
Shadows team up with the dark
elves, and advance steadily
towards the Kingdoms of Light.
It’s up to you—a Shaikan war-
rior—to save the world.

Gameplay
Spellforce 2 blends the RTS and
RPG genres extremely well—
you’ll control your avatar char-

acter in RPG style, and his
entire army in RTS fashion.
Character evolution is deep,
but not as much as a dedicated
RPG. with regular fighter/
archer and mage classes. The
skill tree is highly hierarchical.
There’s a huge variety in equip-
ment available, with a virtually
unlimited inventory system.

Missions are very diverse, at
times typically RTS-esque, other
times very RPG-like—such as
when exploring the countryside
with just your party. The maps
are very non-linear, encourag-
ing you to explore, return to

complete quests and explore
some more, very RPG-ish!

The epic single player sto-
ryline adds a good deal to
the gameplay, while the
actual game experience is
engrossing enough to be a
winner all by itself.

Multiplayer hasn’t been
ignored either, with the full
campaign available for play co-
op style for up to 3 players, mul-
tiplayer battles are also possi-
ble against human opponents.

Sights And Sounds
The world of Eo comes to life
beautifully with the spectacular
Spellforce 2 engine. The graph-
ics rock! Character animation is
top class, (even NPC characters
and units), movements are very
lifelike, while the environ-
ments are simply breathtaking. 

Battles are very well animat-
ed, with just the right touch of
blood, and the spell and special
feat effects look awesome!  The
game has a nice soundtrack with
some voice acting is good, the
sounds during battle are particu-
larly notable, with the clangs of
blade on shield, and the whoosh
of a fire spell incinerating all
those who oppose you.

This Spell Forces You To
Play! 
An epic storyline, Gameplay that
involves you with a near perfect
blend of genres, all this with
swanky graphics and engaging
gameplay make Spellforce 2
Shadow Wars a must play
regardless of whether you’re a
fan of either genres or not.

michael_browne@thinkdigit.com

From The Shadows
Into The Light

Rating: 9/10 
Publisher: JoWood Games
Developer: Aspyr / Phenomic
Genre: RTS/RPG
System Requirements:
Pentium 4 1.6 GHz, 512 MB RAM, 128 MB
Direct X 9.0 compliant video card
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If you’re sick of all the World
War II games but are still
fascinated by being in a war-

zone, Full Spectrum Warrior:
Ten Hammers (FSW: TH), the
sequel to Full Spectrum
Warrior, is probably for you.
Set in the fictitious country
Zekistan, FSW: TH tells the
story of UN peacekeeping
troops fighting for control of
the only pass through the Tien-
Hamir (the Ten Hammers)—the
unforgiving mountain range
that cuts through the country.
After overthrowing its dictator,
the forces must now fight the
disgruntled citizens of the land
to maintain peace in the region
(hmm…sound familiar?). 

You will be controlling up to
four teams of four soldiers
each—the Team Leader, a
Rifleman, an Automatic-
Rifleman and a Grenadier. The
intention is quite Commandos-
ish, with strong emphasis on tac-
tics rather than all-out shooting.
In fact, it’s all tactical—you’ll
never directly be shooting at

anyone! Instead, you’ll be giving
soldiers a rough “fire zone” with-
in which they will eliminate the
enemies. An addition over its
predecessor is the ability to
“Precision Fire” from behind
your team member’s shoulder—a
decidedly fun feature, and quite
deadly for your foes. The trade-
off is that it makes your soldier
more vulnerable to enemy fire,
and when your men can be
downed by just two or three
shots, this is one feature you
need to use with caution. 

Visually, FSW: TH looks
good, but there’s really nothing
special here that we didn’t
expect already. Every now and
then you’ll see seams in the 3D
models—something that didn’t
go down too well with us. 

With its team-strategy-meets-
third-person-shooter approach,
FSW: TH could have been a really
great game, if it weren’t let down
by its clunky interface. Getting
used to the controls is no mean
task, and even then, moving your
troops long distances, RTS-style,

is quite a pain. You will be com-
manding a maximum of four
teams, and thankfully you don’t
need to keep switching teams to
call them to a location—if you
have one team selected, you can
command the rest to your loca-
tion in no time. However, there’s
no guarantee they won’t be shot
before they get there. The nature
of the controls hampers any
quick reactions you may think of
having—so even if an enemy
saunters into your line of fire,
you’ll still be fumbling while he
leisurely decides on where to
take cover. The lack of control
over your soldiers’ firing causes
mounting frustration and bore-
dom, more so when you can’t
have them track a moving
enemy. 

Try this if you’re bored of
the same old war-based FPS or
strategy games and want to try
something new, but casual
gamers are bound to tire of this
quite swiftly. 

nimish_chandiramani@thinkdigit.com

Rating: 6/10
Minimum System Requirements:
1.5 GHz processor, 256 MB RAM,
DirectX 9.0b compatible
GeForce 3 (or better) Graphics
Card
Developer: Pandemic
Publisher: THQ
Distributor: E-Xpress
Interactive
Contact: 022 - 2885 0245
Price: Rs. 699

The Woes Of Urban Warfare



Digital Leisure l Game On

Based on the insanely popular CSI TV series (the original one, based in Las Vegas), CSI: 3
Dimensions of Murder has you as the new CSI (Crime Scene Investigator) on the team,
solving some of the most difficult crimes in Las Vegas with some forensic science, detective

work, common sense and a little help from your friends. 
The game has you solving five different cases, our favourite one being the one with the murder

of a big game company boss at the game s fictitious version of E3 (the Electronic Entertainment
Expo)  heated opinions on the morality of violence in games, even broaching the subject of Why
can t we all just play happy-fuzzy games?  

In each case, you need to build an Evidence Trinity   a tool used by real-life CSIs  to form a
triangular link between the victim, the crime scene and the suspect. Accompanying you on your sojourns
will be one of the original CSI team, asking the questions that you may or may not think of, but are
crucial to the progression of the plot  like revealing the shady past of a suspect. 

The point-and-click interface of this game  after dozens of recent shooter, strategy and
adventure releases  is oddly refreshing. There is undoubted appeal in using your brain more than
your hands, and use your brain you must. You will be going through the standard CSI procedure 
examining and searching the crime scene, analyzing evidence in the lab, and finally scoring warrants
from the Brass to question, search or arrest suspects. While getting your criminal doesn t require
you to be Sherlock Holmes, you can t sail through cases without paying close attention and
exercising those gray cells a bit. When we played it with dulled senses in the dying hours of the day,
missions took an average of an hour and a half, so don t expect to be stuck to this one for long. 

For such a recent release, CSI: 3DoM looks appalling. The 3D counterparts of the real actors
should have looked much better. However, when you consider its light system requirements, you see
the sense in it all  this game was made to be enjoyed by anyone with a half-decent PC  hardcore
gamer or not. It s saving grace is the voice acting, which is brilliant for the suspects you question,
though a little bland for the original CSI cast. Overall, this isn t a title you should crave, but if you re
looking for a break from the other genres, pluck this one off the shelves. 

nimish_chandiramani@ thinkdigit.com

Rating: 8/10; Developer: Telltale Games; Publisher: Ubisoft
Distributor: E-Xpress Interactive; Contact: (022) 2885 0245; Price: Rs 699

Minimum System Requirements:
1 GHz Processor, 64 MB DirectX 8.1 Compatible Graphics Card, 256 MB RAM

The Game’s Afoot,
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Digital Leisure l Weird Products

Barbie Gets A Head Of Herself

In the summer of 2005,
Ska King Cody of the b3ta
forums mortally assaulted
and gutted his Barbie doll
(yes, he had one). He then
declared to no one in
particular: “Gentlemen, we
can rebuild her. We have
the technology,” and
promptly stuffed a USB
drive into her head-bereft
body. You can brush my hair;
behead me everywhere, imagination—life is your creation…
Batteries not needed.
www.b3ta.com/board/4577623

Water Time You Got?

The first implement that Earth’s pioneer
time travellers brought back from the
future was this clock, seemingly powered
by two parts hydrogen and one part

oxygen. Gasp. A wiser man than us once
said, “Any sufficiently advanced technology is

indistinguishable from magic,” a phenomenon
this clock aptly displays: fill the liquid reser-
voirs located at its back with water, and an
internal converter (a flux capacitor?) strips the
liquid of its electrons and powers this devil’s
own machine. Like Black Voodoo Magic. Also
works with beer!
www.thinkgeek.com/homeoffice/lights/757e/

Bad Carma

Because people are liable to start thinking for when
their television sets are switched off, someone
decided to cover a Mercedes SL with diamonds. Keep
the TV on!
www.leftlanenews.com/2006/05/15/diamond-covered-
mercedes-sl-sure-to-turn-heads/

No Time For This Shirt

Altogether Andrews got tired of
spilling hot beverages on self, every
time someone asked him the time.
With fire in his soul and a song in
his heart, he set out to build this
incredible machine—an invention to
serve one’s needs, if there ever was

one. This “Digital Clock T-Shirt” utilises an elec-
tro-luminescent panel in front to display the
current time. The four AAA batteries that power
the unit are cleverly hidden within a companion
compartment and are rumoured to last between
12 and 36 hours depending on the flashing
mode selected.
www.latestbuy.com.au/digital_clock_tshirt.html

Finding Nemo

In some morbid way, this
invention is sure to balance
the karma of flushing your
pet goldfish down the
bowls—the Fish ‘n’ Flush is a
fish aquarium embedded
into the flush tank of your
toilet. Pesky guests are sure
to freak out and flee scream-
ing; children might be
tempted to go investigate
further. PETA is advised that
the fish are safe from being
sucked down into the sewer
system as they reside in a
separate compartment that surrounds the actual
toilet tank. We would like an option that will show-
case desert scorpions within the flush tank; or
puppies apparently drowning.
http://www.fishnflush.com/

Illustrations Pradip Ingale and Pravin Warhokar

Digit’s Believe It Or Not!
Innovation is alive and kicking…

Sure there’s a lot of crazy people out there, but
just how crazy? Take a look at these inven-
tions, products and random stuff they’ve

come up with, and you’ll know just how much…
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Quantum Rock

Dustin Carr, grad student
in physics, and Harold
Craighead, professor of
applied and engineering
physics, got together to
create one of the
world’s smallest
mechanical devices—a
six-string guitar. The
nano-guitar is about 10
micrometers long, or
about the size of a single
human cell. Each of the
six strings measures 50
nanometres—as wide as 100 atoms placed together.
When plucked by an atomic force microscope, the
strings would resonate at inaudible frequencies.
The device was constructed using electron-beam
lithography which consists of scanning a beam of
electrons across a surface covered with a thin film,
called a resist. The electrons produce a chemical
change in this resist, which allows the surface to be
patterned. But who will play it?
www.news.cornell.edu/Chronicle/97/8.14.97/nanoguitar.html

Jenny Phone Home

Jenny L Chowdhury, a B.S. in Electrical
Engineering and a member of the IEEE, has
created what we consider the present-day version
of the pocket-less pants: The Cell Atlantic
CellBooth. It’s a wearable phone booth you can
carry on your back. The concept goes as follows:
when you receive a call, you unzip and literally
wear the booth to create an illusion of private
space. Why, you ask? We’ll let Jenny explain: “We
talk on cell phones everywhere we go,
disregarding issues of privacy (and also those of
courtesy). People often don’t care if others hear
their end of the conversation… What would
happen if we were forced to stand still while we
spoke on the phone? As I grappled with these
issues of privacy, personal space and nostalgia for a
‘simpler time,’ the idea for portable phone booth was born… What
emerged was a wearable/portable phone booth and subsequently a
piece of performance art that calls the attention of New Yorkers to
the changes in human behaviour due to the ubiquitous use of cell
phones.” Preach it sister!
http://jennylc.com/cellbooth/

“Do These Make 
Me Look Stupid,
Number One?”

In our efforts to look as stupid-
cool as Geordi La Forge of Star
Trek: The Next Generation, we
have often resigned ourselves
to wearing a hair-band across
our eyes—if only we’d learned
of this wondrous machine
earlier, oh, the shame it would
have spared!

This implement wraps
around your eyes, and if you
survive the heckling crowds, it
allows you to watch DVDs as
you walk (or run, if the crowd
is particularly nasty). 

The movie is delivered
through a tiny 320 x
480 LCD monitor
embedded in the right
eyepiece. The glasses
also feature an inbuilt
pair of ear-bud
headphones. The video
display is placed on the
upper right of the
glasses, giving you the
ability to view the
immediate
surroundings while
watching a DVD. Not
recommended for one-
eyed pirates!
www.livedigitally.com/
?p=663

BByy  AAhhmmeedd  SShhaaiikkhh

A Salt And Battery

Amos Latteier, called the “Best Fake Professor
in Portland,” and a self-confessed lover of
pigeons, woke up one day to build a battery
out of 500 pounds of potatoes. Each potato
generates about 0.5 volts and 0.2
milliamperes, he explains. Amos connected groups
of potatoes in series to increase voltage, and then connected
these groups together in parallel to increase amperage. The
entire 500-pound battery generated around 5 volts and 4
milliamperes. He then hauled the battery onto a truck and drove it
around town, powering a sound system off it. “Don’t eat potatoes
after using them for a battery,” Amos advises.
http://latteier.com/potato/

Cubicle Missile Crisis

Mortals! The USB slot’s true purpose on our planet has
been revealed—and a bloody purpose it is too! The USB
Missile Launcher, straight from the desk of George
Bush lets you bomb your neighbouring colleague if he
refuses to pass the pen. With the aid of the mouse,
the launcher pans 180 degrees and tilts up to 45
degrees; a click and you will launch a harmless foam
projectile... Complete with sound effects.
www.latestbuy.com.au/usb_missile_ launcher.html
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Here’s news you can
use. Really. You can,
with an 83 per cent

chance of winning, bet that
Brazil will beat Italy to win
the World Cup. Of course,
there’s a disclaimer: if you
lose, don’t come
complaining to us—approach
Imran Fanaswala and Yashar
Fasihnia of the American
University at Sharjah.
Fanaswala, by the way,
is Indian.

What Fanaswala and
Fasihnia have done is build
an AI program that can
predict the outcome of the
FIFA World Cup. The
program is called FIFI—
standing for FIFA
Intelligence. FIFI was
developed by the two
computer science students
under the guidance of Prof
Joachim Diederich, their
project overseer. Apparently,
this program was developed
as a student project. They
got an irrevocable A for their

efforts, whether or not their
predictions come true.

The basis of the
prediction is a statistical
model: the two students
went back 20 years and
collected such information
as past team performance,
past scores, and so on.

The predictions are
pretty detailed: one semi-
final will feature the
Netherlands and Italy, and
the other will see England
and Brazil. England will get
there by beating old rivals
Argentina. Germany will
lose to The Netherlands in
the quarter-finals.

There have been
statistical tests, too,
though we don’t know
what that involved; but
according to the tests, the
FIFI program has an
accuracy of 83 per cent.

It seems to have been a
rushed project: according to
Fasihnia, if they had more
time and manpower, “we

would have liked to research
things like pitch condition,
temperature, age of players,
experience and many other
variables. Then we could
have been even more
accurate.”

FIFI, Fanaswala and
Fasihnia have certainly made
the news, partly because
everyone is so eager to know
who will win. If the
predictions come true, the
duo will almost certainly be
in the news for quite a
while. They will be called
upon to predict all sorts of
things, including the
outcome of the forthcoming
cricket world cup, whether
or not George W Bush will
get a third chance to ruin
the environment, and the
weather. They will be heroes.
But it seems too good to be
true: if AI really could
predict such things, we’d
have seen a lot more AI
projects based on statistical
analysis to predict a lot of

Avinasha S took it this month with his desktop
living room! Here’s how he did it:
StarDock Object Desktop—DesktopX, plus widgets
by StarDock
FoodObject By an Unkown source
Shutdown, Dustbin, Mailbox objects all made by
himself
System Tray, Taskbar with object slider also made
by himself
Ditto the background, created using Google
SketchUp and modified in Macromedia Fireworks

There’s TV At Home
A US company called Blue Coat is selling a service to
businesses who are afraid employees will keep
downloading football World Cup matches. Customers with
Blue Coat SG appliances can “prevent the network impact
of employees viewing FIFA World Cup Soccer.”

WE KNOW WHO’LL WIN…

Brazil Vs Italy

My Desktop

The Tablet PC

Whatever 
Happened To…

When Microsoft
advertised Windows

XP Tablet PC edition in
2002, we all thought that
Tablets were the cat’s
meow. Pen-driven input
had just started to become
popular, so the idea of a
full-powered PC that you
could operate with a pen
just had to work. 

And to a respectable
extent, it did—Tablet PCs
have found remarkable
popularity in healthcare
and education, but
analysts doom them to be
stuck in such niches for a
goodish bit now.

One of the main
reasons behind this is the
fact that Tablet PCs
command a heftier price
than their keyboarded
counterparts. Then there’s
the possibility of
mechanical failure,
because touchscreen
technology isn’t as
reliable as we’d all want it
to be. Naturally, people
wanted some security—
something they’ve found
in “convertibles” like
Acer’s TravelMate series,
which plays the double
role of a laptop and tablet
PC. So even if the pen
goes poof, there’s the
good old keyboard to fall
back on. 

Nobody’s conceded
defeat yet, so don’t
expect the tablet to fade
away. Windows Vista will
come with tablet support
integrated, say Microsoft;
perhaps that will help this
wonderful idea get back
on its feet.

MacIntelTosh Gets A New Meaning
A start-up called Parallels has introduced software
that lets Macs run Windows and Mac OS X
simultaneously. This is rather unlike Apple’s Boot
Camp software, which lets users boot their Intel-
based Mac hardware in either Windows or Mac mode

Send your desktop with description of how you made
it to mmyyddeesskkttoopp@@tthhiinnkkddiiggiitt..ccoomm with the subject 
‘‘MMyy  DDeesskkttoopp’’ and tell us your postal address, too.

Participate in this contest and win 

Wireless and Mobile 
All-IP Networks

by Yi-Bing Lin, Ai-Chun Pang
Published by
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things. It would have been a
billion-dollar industry!

On the other hand, if
nothing of what they’ve
predicted happens, there
will be a little booing, and
FIFI forgotten. It’ll have been
just another student project.
But then, they made the
grade, and the news—what
more could one ask for?

WHY WOMEN DON’T GAME

They Want
An Emotional
Experience…
Aarghh!

Women make up less
than 10 per cent of
the gaming

population. Why? In San
Francisco, at the Sex in
Video Games conference in
early June, keynote speaker
Sheri Ray said that it’s not
that women don’t
understand video games,

it’s that video games don’t
understand women.

Ray has the credentials:
she’s been a game designer
for the past 16 years, is a
veteran of Sony Online
Entertainment and the
Cartoon Network, author of
the book Gender Inclusive
Game Design: Expanding the
Market, and a long-time
spokeswoman for women
gamers. 

Women or girl gamers
need more than just action
to stay involved, Ray said.
She narrated an incident
where a 13-year-old girl was
good at a popular game,
and instead of wanting to
advance to higher levels,
she got bored and quit the
game. When Ray asked why,
the girl said, “I pulled his
heart out once, why do I
need to do it again?”

Also part of the reason,
Ray essentially says, is that
women are portrayed as sex
objects in games.  The typical
game heroine, as we know,
has the word “sex” written
all over her. She’s something

like 38DD, and she doesn’t
wear much. But what about
male characters, who are
similarly exaggerated? Well,
it’s a fact that male and
female characters in games
are both portrayed as young,
strong, and sexy, only female
characters display the
physical traits humans
actually display “when
they’re ready for sex:
partially open mouths, with
large red lips, and heavy
eyelids.” And Ray says it’s
these “sex object” images
that don’t appeal to the
average female gamer.

So to bring more women
into games, then, how
about “sexualising” the
male characters as well?
That won’t cut it, according
to Ray. She said, in effect,
that women gamers aren’t
that excited about what the
game looks like.

So what do women
gamers look for in games?
Tough question. As tough as
“What do women want?”

Males reading the
following are going to say,
“Oh, please!”—Ray said the
importance of the
emotional experience can’t
be trivialised. And that
games need to provide a
way for women to have a
deeper experience with the
game characters.

Video game companies
that want to get into the
women-gaming market
full-time will have to
provide a way for players to
become acquainted with
their characters, Ray said.
This includes allowing for
an emotional attachment
to develop.

Yes, we told you you’d go
“Oh, please!” Emotional
attachments in games?
What’s wrong with plain,
good old action?

Jonathan Postel is
remembered as one of the
powerhouses behind the
early Internet. He edited or
co-edited more than 2,500

RFCs (Request
For Comment).
These RFCs
were the
foundation for
the technical
standards
that govern
the operation

of the Internet.
Postel’s contributions

began way back when the
Internet “was the ARPANET.”
In 1969, Postel would
manage the ARPANET’s
protocol numbers using
scraps of paper. His
contributions to the fields
of computer
communication protocols
such as IP, TCP, UDP, Telnet,
SMTP, and ICMP are
monumental.

The man’s love for
computing began when he
was studying towards his
graduation at the University
of California at Los Angeles.
Postel was one of the
members of the project that
created UCLA’s first (and
then the only) Web site.

The Internet, quite
simply, could not have been
what it is without Jon
Postel. For instance, it was
he who suggested the dot
notation for Internet
addresses. 

Postel was an easy-going,
casual man: he was once
ordered to put on his shoes
before boarding a plane
when he was to help the
US Air Force with its
computers. Amongst his
interests were hiking and
British whodunits. 

In 1998, Postel received
the International
Telecommunication Union’s
prestigious Silver Medal in
recognition of his
contributions to the
development of the global
information infrastructure.
He died the same year at 55.

People Who
Changed

Computing

Jon Postel

Jon “Protocol” Postel

This month’s 
winner is 
Rohit Kumar Singh
e-mail:
rohit3787@gmail.com

WIN!
Send in your entry and you could win an exciting gift just by sharing
an amusing picture with a tech angle to it. The picture should have
been shot by you, and should not have been published anywhere
earlier. E-mail your picture with the subject ‘DigiPick’ and your
postal address oonn  oorr  bbeeffoorree  tthhee  2200tthh  ooff  tthhiiss  mmoonntthh  to
digipick@thinkdigit.com. One prize-winning picture will be
published each month.

He wins 
Web Development with
Microsoft Visual Studio 2005

by John Paul Mueller
Published by



Anyway, will de-sexing
games, including emotions
and attachments and
possibly even relationships,
and including less action
and more human
interaction do it for women?
Say a game like Bob and Alice:
The Untold Story or something
along those lines?

Perhaps. But no-one
knows what women want,
including women!

ROBOPHILES AT LARGE?

Keeping The
Bots Under
Control

Especially in Japan—but
in other countries as
well—robots are

increasingly coming into
homes and workplaces.
Robotics experts are now
getting more and more
concerned about safety
implications, and have come
together to try to find ways
to prevent robots from
harming people. Reminds us
of Asimov and the Three
Laws of Robotics. Apparently,
apart from safety, sex is one
of the big concerns in regard
to robots becoming more
popular: for example, should
robotic sex dolls resembling
teenagers be legally allowed?
Sit back a minute and think

about the technology
landscape today: people are
actually getting concerned
about robo-sex and robo-
paedophilia!

The issues may seem far
out now, but in the next few
years they will become
increasingly relevant,
according to experts. It’s
apparently high time we
think of things such as the
robots turning against us,
and about robo-sex.

Regulating the
behaviour of robots is
going to become even more
difficult in the future,
since they will increasingly
have self-learning
mechanisms inbuilt. Their
behaviour could become
impossible to predict.

Probably the area likely
to prove most controversial
is the development of
robotic sex toys, says Dr
Henrik Christensen,
chairman of the European
Robotics Network at the
Swedish Royal Institute of
Technology. “People are
going to be having sex with
robots in the next five
years,” he says. (And dead
serious he sounds, too.)
These robots will initially be
pretty basic, but that is
unlikely to put people off, he
says. “People are willing to
have sex with inflatable
dolls, so initially anything
that moves will be an
improvement.”

One thing we aren’t clear
about is, why the emphasis
on sex? Who cares if a few
perverts decide to indulge in
robo-sex? It might even be of
therapeutic value, and at
least they won’t be out on
the streets looking for kids!
As regards robot safety,
wouldn’t the emergency
switch-off button work fine
enough? Even if the
behaviour of the robots can’t
be predicted, why should we
assume that they will
function in a destructive
manner? After all, they’re
supposed to be programmed
to be smart—so why not
expect them earn their keep
in a decent manner?

All this reeks of sci-fi-
inspired paranoia—or
probably another case of
research for the sake of it.

CHEATIN’ STUDENTS

Wales: Don’t
Blame Me!

Asurvey conducted by
CBSNews has found
that one in five

American teenagers uses the
Internet to cheat on school
assignments. As expected,
there’s a difference between
the sexes: 24 per cent of boys
and 14 per cent of girls have
plagiarised material online
at least once.
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Protocols
Spouting TLAs ending with a P
is a great way to mark yourself
up as a network guru when
you’re amongst folks who don’t
know their TCP from their IP.
And if your water cooler crowd
is doing it all the time, you’re
going to feel left out. In either
case, you’d do well to mug up
the following protocol names!

UDP
One of the protocols that
allows two programs on a
network to send out short
messages called datagrams.
This is an “unreliable”
protocol; data may arrive out
of order or go missing.
Something like your boss’ SMS
never reaching you.

TCP
A “reliable” protocol, TCP
allows applications in
networked systems to
exchange data. TCP ensures
data is received in the order
in which it was sent—like how
your girlfriend very effectively
communicates what she wants
you to buy for her!

ICMP
Used by networked computers’
OSes to send error messages,
such as a router not being
reachable. Straightforward
enough...

RTP 
Real-time Transport Protocol
is used to send streaming
audio and video packets over
the Internet. Like when your
mother-in-law is incessantly
screaming and gesticulating
at the same time.

ARP
Address Resolution Protocol is
used to find the hardware
address if the IP address of
the destination is known. Like
a postman finding a town
from the PIN code.

SMTP
Simple Mail Transfer Protocol
is a text-based protocol that
e-mail clients use. It works on
top of TCP, and is the best
thing to have happened to us
since pigeon post.

Our cover story this month was quite
the talk of the office. Sex is still

controversial enough to cause a stir—even
in an office of geeks who have reportedly
seen all there is to see in technology!
When Agent 001 walked in after a week’s
absence, clutching his “Sex” story, he
seemed pale and... drained. “Viral fever,”
he explained. No-one believed him! 

Then there were the problems of
explaining it all to the graphic designers
and layout artists. They had to come up
with visuals and ideas of how to depict
what kids face online, without hurting
too many sentiments. What you see are
blurred / censored images, but our
designers were “exposed” to the
originals. Some were only
too happy, but
others, like
Sivalal S, were too
embarrassed to

work on the images. When Pillai-ji
(Shivasankaran Pillai) was laying out the
story, a lot of people gathered around,
hoping for a free show—much to Deepak
Ajwani’s consternation! Too bad for them
that all the images had already been
censored!

Then there were the fights between
the liberals and conservatives: The “that
image just has to go” vs. the “why, what’s
wrong with it” kind! This was promptly
followed by an “I-have-more-porn-on-my-
hard-disk-at-home-than-you” competition
by some of our more liberal colleagues!
At the end of it all we think we’ve done a
decent job of tastefully portraying the
truth that’s out there.

We can now finally get back
to the more familiar

territory of gadgets and
gizmos, and leave all

that porn behind us!

We’re Not Grown-ups!
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The survey results are
surprising. Why isn’t the
number higher than that 20
per cent average? After all,
who goes to libraries any
more? They all have access to
the Internet, and then, of
course, there’s Wikipedia.
You can’t blame the kids,
really. It’s all there, and why
do serious research when
you can lift stuff off a page?

The answer is online
research. Kids can actually
do research on the Internet,
while validating the
information they garner.
They can then perform a
critical analysis of what
they’ve found, and use that
for their assignments—
just as if they’d been
to a library.

Talking about plagiarism,
Wikipedia is in the news
again: founder Jimmy Wales
has asked that college
students refrain from citing
Wikipedia as a source of
research. Some students are
complaining to him when
teachers fail them for citing
the user-edited
encyclopaedia! Wales
reportedly receives 10
complaint mails a week from

college students, saying they
flunked because of his site!

Wikipedia is considering
putting up a fact sheet on
the site. It would explain
why it’s not a definitive
source of information, and
teachers could hand it out,
Wales said. Actually, it
should be obvious: how can
something that’s edited by
users be cited?

But still, with Wikipedia
and other online sources
providing so much well-
formatted information for
free, we think plagiarism—or
at least online “research”—
can only increase. There’s
something wrong going on
here. Consider this: (a) The
information and analysis is
out there; (b) Assignments
demand that students collate
and analyse the same
information; and (c) There’s
no stopping the growth of
info on the Web.

Why, therefore, don’t
schools and universities
accept that the times they
are a-changin’, and revise
their grading methods? It’s a
problem of an old system
caught up in an age it wasn’t
prepared for. 

When we came across thebeerbelly.com, it took us several
minutes to shake our heads and finally acknowledge that

the site did sell, on order, a strap-on body sac within which a
beverage pouch could be hidden. Its not the ludicricity of the
object on sale that stunned us—the Internet is a notorious hub
for sales of all kinds—what amazed us is that there have been

people who have actually
already bought the thing and
think its cool! If the claims of the
site are to be believed, beer
bellies are in fashion. 

There are accessories for the
beer belly on offer as well.
There’s the ice pack “pleasure
extender,” to keep your drink
hot or cold depending on what
the beverage is—and a cleanser
and brushes to clean out the

pouch. Talk about a full deal! And then we have the ever-
gracious buyers and visitors, who have kept up the spirit of
the whole thing with plenty of community blog posts. The site
even offers instructions with their very own Tips & Tricks
on how to use the Beer Belly. What were the parties on both
sides thinking? 

We all agree that the site is humorous, but the site forgets
to mention an important detail: what would people who
already posses a beer belly do with a contraption that will
make them look doubly rotund? The blessing in disguise that
we spot in the whole idea is that the desire for a such a thing
might actually convince some of the pot-bellied to try and get
rid of the original—so they can sport one of these!

whatweretheythinking.com

Guest Columnist
http://snipurl.com/blogjul1
(www.thoughtmechanics.com/2006/06/20/retiremen
t-of-bill-gates-from-microsoft-is-no-big-deal/)
Retirement of Gates from MS Is No Big Deal
People seem to be making a big deal about the
announcement that Bill Gates will be retiring from
active involvement in Microsoft... 

His retirement may be delayed by CEOs of other
companies trying to retire. They may complain that
Gates has an unfair monopoly on retirement. At this
point the Justice Department may have to get involved
to analyze the impact of his retirement on the CEOs of
other companies...

Robert Accettura
http://snipurl.com/blogjul3
(http://robert.accettura.com/archives/2006/06/09/wi
ndows-vista/)
Windows Vista
Am I the only one who is not very impressed with
Windows Vista? Several things so far have just shown
to be a complete turnoff.

It warns me about everything. Warnings stink,
people just ignore them if they happen to often...

Learning Curves are evil. The new Save dialog isn’t
totally evil, but it’s quasi evil. It took me a few seconds
to figure out how it works, and still feels really really
awkward no matter what method I use to navigate...

Despite my best effort, I’m still not sure why I’m
denied permission to my Application Data directory...

Joel Walsh
http://snipurl.com/blogjul4
(www.sourcearticles.net/computer-articles/googles-
good-writing-content-filter.html)
Google’s Good Writing Content Filter
The web pages actually at the top of Google have only
one thing clearly in common: good writing. Don’t let the
usual SEO sacred cows and bugbears, such as
PageRank, frames, and JavaScript, distract you from the
importance of good content.

I was recently struck by the fact that the top-ranking
web pages on Google are consistently much better
written than the vast majority of what one reads on the
web. Yet traditional SEO wisdom has little to say about
good writing. Does Google really only display web pages
that meet arcane technical criteria? Apparently not.
Google is doing a good job of identifying websites with
good content and rewarding them with high rankings...

sophistry
http://sophistry.org/blog/?p=13
The nonexistent Google-Microsoft rivalry
Google’s newest products seem to be challenging the
Office suite. This makes it easy to write articles about a
Microsoft-Google rivalry. But it’s also wrong... Google’s
business is ads. Microsoft’s is software. If Google’s apps
make a dent in Microsoft, it will be incidental to their
real goal, which is improving your search results. The
key to Google’s plan is getting as much of your data
online as possible, search it and have their technology
determine what ads best match your growing profile...

Everyone’s talking
about Vista, Google,
and Microsoft. (As
always.) Here’s
something about the
Gates-stepping-down
thing. Also, a
negative rant about
Vista, and two
Google-related posts.
Lots of links and
comments at these
blogs!

www.thebeerbelly.com 

A pouch to augment your paunch!
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Several states in the US have
tech plans for convicted sex

offenders. They will...
a) Be allowed to play sex video

games before being electrocuted 
b) Be constantly tracked via GPS
c) Be constantly tracked via RFID

tags
d) Receive implants that will warn

when they approach a woman 

What is the latest about
Nicholas Negroponte's $100

laptop?
a) It will not be launched after all
b) The launch will be delayed by

two and a half years
c) It will probably cost around $140
d) Bill Gates will help pay for the

final development stage

Google has launched a new
search engine that will search

what?
a) US Government sites
b) Porn sites

c) Entertainment sites
d) Warez sites

What will Bill Gates be
primarily focusing on when

he quits everyday work at
Microsoft?
a) His golf skills
b) Philanthropy
c) His affiliation with PETA
d Anti-smoking and anti-drug

campaigns

What does S.M.A.R.T. stand
for?

a)Self-Monitoring, Analysis, and
Reporting Technology
b) SATA, MAID and RAID

Technologies
c) Smart Motherboard Analysis and

Reporting Tool
d) Small Matrix Analysis in Real
Time

An old portal is soon going to
get a new look. Which?

a) OneName
b) Yahoo! Small Business
c) Netscape
d) MyMSN

In which programming lan-
guage can you actually

change the value of 2 to 3?
a) LISP c) FORTRAN
b) Eiffel d) Ada

What company will soon
launch a payment system to

rival PayPal and others?
a) Adobe c) Google
b) eBay d) PayMate

What has Microsoft identified
as the most significant threat

to Windows PCs?
a) Malicious bot software, turning

the PCs into "zombies"
b) Rootkits
c) Viruses
d) Worms that spread via Outlook
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ACROSS
1. Comes in A4 OR A3 sizes-is used in printing(5)
4. _____Valley - Californian region famous for
its high-tech industries(7)
8. Play_____video game console(7)
9. Network Operations Center (abbr)(3)
10. Asynchronous Transfer Mode (abbr)(3)
11._____Code reader or price scanner(3)
12. Standards Electronic Automatic Computer(abbr)(4)
16. _____Or storage card(6)
17. Collection of pixels describing an image(6)
20. Popular warning ‘Your computer is at —’ or danger(4)
22. Disk Operating System (3)
23. Short for ‘Clear’(3)
27. Interactive Connectivity Establishment(abbr) (3)
28. Mumbai based back-office and software
development company(7)
29. Novell’s widely installed server(7)
30. Wireless(3)

DOWN
1. _____word or codeword(5)
2. A ghost dial-up connection(7)
3. Redundant Array of Independent Disks (abbr)(4)
4. _____Checker-programme to check natural languages(6)
5. Leased or telephone_____used for dial-up 
connections(4)
6.High-speed storage device(5)
7. Commercial browser-part of AOL(8)
13. ‘A’ in AWG-US standard set of wire conductor sizes(8)

14. Uniform Resource Locator(abbr)(3)
15. Recycle_____(3)
18. Virus distributed as an e-mail attachment(7)
19. Application that magnifies or reduces an image(4)
21. Keyboard key that converts letters into Capital or small
case(5)
24.’M’ in MB(4)
25. Photo or Paint_____software(4)
26._____ID(4)

Crossword 

Got an
interesting
question? 
Send it in with
the answer to
TQ@thinkdigit.com
Mark “TQ” in the
subject area.

2=3? Really?
Toshiba recently pushed
laptop storage all the way to

an impressive amount. The disk is
Toshiba's first to use perpendicular
recording. How large is it?

a) 160 GB       c) 300 GB
b) 200 GB      d) 512 GB

1

May 2006 Solution  

The Eudora e-mail
program was named

after the American writer
Eudora Welty—because she had
written a short story called
“Why I Live at the P.O.”

Did You
Know?

Winners:
April 2006: Chitra Bharti
May 2006: A.G. Francis 

Send in your entries with
complete contact details to
TQ@thinkdigit.com on or
before July 15. 
One lucky participant will win 
Web Work In Action
by Patrick Lightbody & Jason Carreira

Published by

Answers

6.a) Self-Monitoring,
Analysis, and
Reporting
Technology

7.c) Netscape 
8.c) FORTRAN
9.c) Google
10. a) Malicious bot
software, turning the
PCs into "zombies"

1.b) 200 GB
2.b) Be constantly

tracked via GPS
3.c) It will probably

cost more like
$140

4.a) US Government
sites

5. b) Philanthropy

Crossword by Nitta Jaggi

Win!



Piracy
Dear Digit, 
Piracy is considered a crime all over the
world, but let’s face it, India is still a
developing country and 90 per cent of the
populous are middle class or live below
the poverty line. The price of a basic
computer is not more than Rs 20,000, but
not everyone can afford to buy legitimate
software. Pirated CDs cost between Rs 30
and Rs 200. Unless the Americans realise
that they need to price their products
more affordably in Indian rupees, piracy
should be made legal! Piracy is playing a
major role in promoting the use of
computers in India, which is not a bad
thing. You may not agree with my views
and not even publish this letter but
please do look into this piracy issue
because if this stops—we middle class
Indians will be technologically
handicapped.

Razil (Kuku) 
Akhtar

Piracy Creates Customers
Today’s pirates are tomorrow’s potential
customers. Though pirated software is
cheap or free, they have their own
disadvantages. They cannot be updated
online and there is no customer care
service for them. Be it an OS like
Windows XP or antivirus software like
Norton or Quick Heal, they all need to be
updated. Some people may be happy
with older versions, but all are not.
There is a section of pirated software
users who use it because of ignorance
and financial problems.

54 per cent of the people in our
country are below 25 years of age, so 90

per cent of them do not earn their own
living. When they do, should they buy a
home, a car or legal software? People
don’t buy software because they cannot! 

What if suddenly some technology
like hardware integration is done which
bars you from installing a pirated OS on
your system like in the case of 900 series
chipset motherboards from Intel, which
does not install Windows 98? People are
forced to use Windows XP (may be pirated)
and not all can suddenly switch over to
Linux - human nature resists change. 

If you analyze the problem of piracy
from a different point of view you will find
that piracy may have created a huge army
of potential customers who are training
themselves to give a big boost to the
software industry. Patience is the virtue. 

Lokesh Bazaj, Raniganj, 
West Bengal

Dear Razil and Lokesh,
I share some of your opinions, but not all of
them. In an article in the April 2006 issue of
Digit, I wrote about how piracy may even be
good for software vendors. Of course, this does
not make it right! I have to disagree with some of
your suggestions, like making piracy legal—it’s
almost as ridiculous as saying that we should not
punish murderers, because they are helping us
control the population explosion!

The economic situation of our country is our
problem, not a software vendors’. Yes products
could be priced more in tune with our earnings
in India, but then maybe our earnings should be
more in tune with the rest of the world! But if we
earned as much as “Americans”, we would have
to shut down one of our fastest growing sectors—
the BPO industry. So as you can see, things
aren’t as simple as they seem.

As Lokesh rightly points out, piracy is
(hopefully) creating potential customers—so if
you use pirated software right now and can
afford to go legal, please do so now! Moreover,
encourage your friends to do so too. Finally,
there’s a lot more open source software out
there, many of which offer you nearly all the
capability of paid software. If money is your
problem, go Open Source!

— Agent001

Teaching The Teachers!
This is my second letter to Digit. The first
one was a complaint letter due to a
faulty copy of SKOAR!, but thanks to your
customer service I received a brand new
copy within two days. I just can’t forget
the first day I picked up Digit. It was 21st
December 2004 and from that day my

life changed! Today I am considered a
‘Tech Encyclopaedia’ by friends. Your
May issue was really awesome. Fast Track
to Photoshop was spectacular. In its initial
pages you rightly wrote that most people
don’t use Photoshop because they think
it’s very sophisticated. I was wondering
how you guys gauge the thinking of a
common man so perfectly. Having read
your Fast Track I indeed realised that it
was not very tough and now I am
teaching it to computer teachers at my
school. I would like to thank you for
introducing such a great magazine.

Regards
Rahul Gupta

Dear Rahul, 
It is heartening to know that our Fast Track to
Photoshop was a delight for you and also helped
you learn a few tricks of the software. It has
always been our endeavour to scale up the
learning of our readers and increase their
knowledge quotient in technology.

—Associate Editor

Wasting Money On Digit?
Congratulations for Digit’s 5th anniversary
and best wishes for the years ahead. Your
fourth anniversary issue was the first
issue I bought, and since then I have never
been disheartened till now. Your June
issue cost Rs 200 and I had expected much
more than what you have given on CD’s
and the so called dual-layered DVD,
although the content of the magazine and
fast track was superb. CD, DVD content
was not up to the mark. Frankly the free
game CD (Monster Truck Madness 2) was not
useful and a waste of money. On DVD you
had nothing more than some very old
movies. But the articles like five decades
of technology were interesting. My
complaints are before you. I know, you
would not publish this first ever letter of
mine. Still if you would do something
regarding my complaints it will be worth
writing this letter.

Neeraj Singh
Dear Neeraj, 
Thanks for your appreciation and an honest
feedback. It’s always a challenge to strike a
balance for our readers: Will they like the issue?
Will they flame us? While we have received e-
mails that echo your sentiments, we’ve also had
people who liked the game and some more who
were really interested in the Business Plan
contest. Even the movies have received mixed
reviews, and many have appreciated the timeless
classics that you can’t even see on TV today! I
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guess you win some, you lose some. We hope to
give you content that will make you write letters
of praise to us in the near future; keep writing.

— Associate Editor

Subscribing Is Easiest
I was a subscriber of Digit for the past four
years, but unfortunately I was not able to
renew this year. So, for the first time I had
to buy Digit from a shop. Usually the
courier boy used to bring it to my
doorstep at the first week of the month.
But this time, I think I checked about six
times before I finally got a copy of your
5th anniversary issue on 7th June. As
usual, loads of surprises, the best being
the content of the Dual layer DVD that
you guys packed. The magazine content
was superb as usual. But I understood the
difference between a subscriber and a
news stand buyer. No tensions, no
struggles and no price hikes. Thus my
advice to all Digit readers—”Subscribe at
the earliest and plug in to the tech world
and enjoy unlimited offers!”—as I myself
will do now. Hearty congratulations to
team Digit for bringing out yet another
monster of an issue.

Kelvin Ralph
Ernakulam

Dear Kelvin, 
Thanks for your wishes and glad to know that
you value our subscription schemes and
acknowledge the benefits of subscribing.
Indeed, the comfort of sitting happily at home
and being delivered your favourite magazine
right at your doorstep is a great experience. 

— Associate Editor

Get Your Own Copy!
Whoooooola! I never expected such a
great anniversary issue from you. It was
a swashbuckling act from your team and
of course alarming for other so-called
tech magazines. Apart from all this
praise I want to inform you a very
interesting fact. I have a group of 6-7
common friends, and all have their own
computers, but they never buy Digit,
although they borrow it from me. But
this month they all rushed to nearby
bookshop and bought a copy each for
themselves. And now all are planning to
be full time subscribers. Your
anniversary issue was missing the Q&A
segment. Where has that gone?

Manish Kumar
Via E-mail

Inbox

Write to the Editor
E-mail: editor@thinkdigit.com

Snail Mail: The Editor, Digit, D-222/2, Om Sagar Building, MIDC, TTC Industrial
Estate, Nerul, 
Navi Mumbai 400 706

Digit will publish the best letters on these pages. Letters may be edited for clarity.
YYoouu  mmuusstt  iinncclluuddee  yyoouurr  ccoommpplleettee  aaddddrreessss  iinn  aallll  ccoommmmuunniiccaattiioonn..  

For subscription queries, call the help desk at 
022-27629191/9200, fax 022-27629224, or 
send an e-mail to help@jasubhai.com

Dear Manish, 
Many thanks for your mail, and the news that
even more people are contributing to Digit’s
disappearance from the stands. Q&A was
removed only for June, due to space
constraints. It’s back now.

— Associate Editor

Hooked
I am currently in the 10th grade and
Digit has made me addicted to
technology since I was in 5th! Then I
bought it only for the Maal in the CDs
you gave. But the language and the
hilarious illustrations made me read
the magazine carefully and I haven’t
missed an issue since then. In my class
8th I asked my Mom to subscribe the
magazine for one year. At the end of it,
a nice letter came to me with thanks
from the Digit team. It really changed
my mind and I re-subscribed the
magazine for three years! All your
reviews, the prank language, tips, funny
illustrations, the offers (subscription
and Digit Patron esp), Fast Track series
and many more kooool features of your
mag have made me absolutely techno-
geek. The problem is that as a
subscriber I usually get your mag late.
Make sure that your issue reaches as
early as possible. Your mag rocks! One
more thing—could you please put a
“Playstation 2 Emulator” on  your
upcoming Digit CDs or DVDs, that’ll
work on XP. 

Haroon, 
Jammu

Dear Haroon, 
We are overwhelmed by your affection and we
glad that you extended our relationship by
subscribing to us once again. As for your
concern for early delivery of subscriber copies,
well we are indeed trying our best to reach the
copies earlier but many a times postal delays
are unavoidable due to natural causes like
rains or truck/ rail delays. But we are still
continuously trying to improve our delivery
mechanism. I know this might sound yet
another tall claim, but we even change courier
service when we get complaints from our
subscribers. We always attempt at improving
our delivery services and hence try to find out
which courier service is best in every area,
and engage them to reach our magazines. 

As for your request for a Playstation 2
Emulator, their use is illegal and hence we
won’t be providing them on our CD or DVD.

— Associate Editor

Just Can’t Wait
Congratulations on
completion of yet
another year of
excellence and best of
what a technology
magazine can give.

This is my first letter to
you. I’ve been a Digit patron since
April 2001, and a subscriber from
April 2001 to July 2005. There is a
strong reason behind discontinuing
the subscription. I now buy directly
from the shop. Reason being, the
anticipation, the excitement I get
when your magazine hits the news
stands every month, that tickling
feeling as if I’ve got butterflies flying
in my stomach cannot be defined.

I can’t wait even for a day more,
and have to grab it fast. The
anniversary issue was very special. I
bought it and sat with the soft board
binding in my hand (which only
comes in the non-subscriber issues),
going through it and as I read along
the whole binding, as to what’s
stored in this special issue’s CDs and
DVD...........my stomach started
drooling exactly like it does when I
am really hungry n sitting in a
restaurant. 

Finally I started getting goose
bumps (wish you guys were here to
see the scene).

Kudos to you people for creating
such an asset for us who wouldn’t
have known a lot about technology
without you being there for us, now
and always.

Gaurav Maheshwari

Dear Gaurav, 
Thanks a ton for the appreciation and
praise. It is people like you and letters like
yours that motivate us month after month
to create a special Digit every issue.

It’s sad that you have discontinued our
subscription, but as long as you continue
to buy Digit every month from the news
stand/bookseller, I’m assured that this
relation will last for a very long time.

Keep Reading and most important—
writing to us.

— Associate Editor

Letter 

of the

Month



People And Events That Grabbed Headlines—For Better Or For Worse

David Beckham is a gay icon. He’s been voted as a gay
marriage favourite. He topped a gay radio poll of the
best-looking football stars. All of which make us prick up

our ears when we hear he bought a pink cell phone in early June.
It happened this way: a certain mobile phone maker, who

wants to remain anonymous, was smiling from
ear to ear when they heard Becks was interested
in one of their models, the StarTrk. The StarTrk
comes in black and pink, for men and women
respectively—or so we would believe. Surprise:
Beckham’s henchmen went on to order the pink
version.

The dealer was understandably surprised.
“He can’t be seen using one,” was his reaction—
“because of the new deal he has with Motorola.”
As though he could be
seen using one if he didn’t have a deal
with Motorola.

(By the way, some Googling revealed that
the StarTrk is probably manufactured by a
firm called HTC. So much for not wanting to
be named.)

Ostensibly, then, the phone is for Victoria
“Posh” Beckham. A gift. However, it can’t be for her birthday,
which falls on the 17th of April. Their wedding anniversary,
however, is on the 4th of July—
so could Becks have wanted to procure the phone a full month in
advance? Or was it a just-like-that gift? The words are whirling
round in our heads. Beckham... Pink... Gay...
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For any queries regarding the Digit Patron programme, e-mail us at digitpatron@jasubhai.com

We’re a bit late on this one, but at the JavaOne
conference in San Francisco last month, former Sun
CEO Scott McNealy engaged in a bit of rare humour.

(He’s the one who said infamously, “You
already have zero privacy... get over it,” in
regards to consumer privacy issues and
shopping online.) McNealy drew up a list
of top ten great things about not being
CEO any more, having handed over the
baton to Jonathan Schwartz. Here are
some:
#10: “I don’t have to apologize for the
stuff I say to Wall Street, Jonathan does.”
(This is a little confusing: how can
Schwartz apologise for what McNealy
says?)
#9: “I’m no longer on the most overpaid
CEO list.” (Why doesn’t he want to be?)
#8: “I just say, ‘See Jonathan on that.’” (Of
course.)
#6: “I shave even less often.” (He seemed
pretty clean-shaven to us most of the time...)
#4: “I have someone to blame now.” (We’d all love this.)
#3: “I can sell my last business suit.” (On eBay?)
#2: “Jonathan doesn’t golf, so I guess I gotta do it.” (Good one.)
#1: “My new office is very close to the men’s room.”
(No comment.)

She was born in Namibia, and
is called Shiloh Nouvel Jolie-
Pitt. Her mother is, of course,
Angeline Jolie, and her father,
is, of course, Brad Pitt. Now
here’s one baby who’ll never
have to lock horns with a
typosquatter: Jolie (rather, her
lawyer) registered at least
three domain names for her:
ShilohNouvelJolie-Pitt.com,
ShilohPitt.com, ShilohNouvel.
com, and more. Clumsy, but
they’ll do the job. (Actually,

we think her name is clumsy
in the first place.) Jolie seems
to have learn her lesson:
angelinajolie.com isn’t hers.
There’s even a gag Shiloh
Nouvel Jolie-Pitt MySpace
page been found, which
says: “Shiloh’s interests:
Africa, eating.”

With all the unofficial fan
sites out there anyway, what’s
this newfangled thing about
celebrities and domain
names?

Domained At Birth

When You Gotta Go...

Pink... For Posh?




